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Maa- ja pohjarakenteet on suunniteltava ja toteutettava siten, että niillä säilyy riittävä 

lujuus ja vakavuus murtumista vastaan koko suunnitellun käyttöiän ajan. Rakenteiden 

painumien, siirtymien, kiertymien ja muodonmuutosten on pysyttävä niin pieninä, 

etteivät rakenteet rikkoonnu haitallisesti, eivätkä aiheuta vaaraa käyttäjilleen tai 

ympäristölle. Suunnittelussa on huomioitava rakennuspaikalla ja sen ympärillä vallitsevat 

olosuhteet ja rakenteet. Pohjarakenteita suunniteltaessa tämä tarkoittaa rakennuspaikan 

pohjaolosuhteiden tunnistamista ja pohjarakenteiden mitoittamista ko. pohjaolosuhteet 

huomioiden yleisesti hyväksytyillä laskentamenetelmillä.  

 

Mitoituksessa käytettävät geotekniset laskentamenetelmät ovat käsin laskettuina usein 

raskaita ja aikaa vieviä, joten laskelmat suoritetaan yleensä laskentaohjelmistojen avulla. 

Tampereen ammattikorkeakoululla on käytössään GeoCalc 3.1-ohjelmisto. Kuitenkin 

ohjelmiston opetuskäyttöön tehdyt laskentaesimerkit ovat ohjelman uudistumisen myötä 

osin vanhentuneita ja vaativat päivittämistä. Tässä työssä tehdään laskentaesimerkkejä 

ko. ohjelmaa käyttäen. Työn tavoitteena on, että opinnäytetyötä tai sen osia voidaan 

käyttää opetellessa ohjelman käyttöä. 

 

Opinnäytetyössä selvitetään ensin vakavuus-, painuma- ja stabilointilaskennan 

teoreettisia taustoja ja laskentamenetelmiä siinä laajuudessa, että GeoCalc-ohjelmistossa 

tehdyt valinnat ja vaihtoehdot tulevat helpommin ymmärrettäviksi.   

 

Opinnäytetyön liiteosaan on koottu yksityiskohtaiset ohjeet vakavuus-, painuma- ja 

stabilointilaskennan suorittamiseen. Pääpaino on vakavuus- ja painumalaskennan 

käsittelyllä. Stabilointia käsitellään työssä vakavuus- ja painumalaskentaa vähemmän. 

Laskentaesimerkkien mitoittamisessa noudatetaan eurokoodia, sen kansallista liitettä ja 

ohjeita, joita on annettu käsiteltyjen mitoitustilanteiden laskentaan.  

 

GeoCalc on vakavuus- ja painumalaskennan suorittamiseen selkeä ja johdonmukainen 

ohjelma. Luonnollisesti ohjelman käyttö vaatii tiettyjen käsitteiden ja geotekniikan 

perusteiden hallintaa laskennan suorittamiseen ja laskentatulosten oikeellisuuden 

arviointiin. Syvästabiloinnin mitoitus ohjelmistolla on suhteellisen yksinkertaista, mutta 

on jäänyt käytettävyydeltään kuitenkin vielä kankeaksi ja keskeneräiseksi.  
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All constructions must be designed and built with sufficient safety against the fraction. 

The stability, settlements and other deformations must be so minimal that the built 

construction doesn’t crack and cause any danger to inhabitants or to the environment.  

 

The strength against the fraction of soil and constructions must be high enough in order 

to last at least it’s designed service time. The circumstances at building site must be 

conciderated in designing of construction. This means the design of foundations the 

geotechnical features of the soil at the building area must be recognized. Also the used 

calculation method must be widely accepted.  

 

The calculations are often difficult and time-consuming when using calculators and 

therefore generally they are done by using different calculation applications. The 

University of Applied Sciences of Tampere has the program called GeoCalc, which is 

used in different geotechnical calculations and taught to students. However, the 

renovation of GeoCalc – application formerly used calculation examples are outdated. 

This thesis applies geotechnical calculations by using GeoCalc – application. The purpose 

of this study was to produce new calculation examples in educational purpose to help 

studying the use of GeoCalc – application.  

 

The theoretical section concerns the theory of the calculation of stability, settlement and 

deep stabilization to clarify functions of the GeoCalc – application. The appendixes of 

the thesis include detailed instructions to calculate stability, settlements and deep 

stabilization. All calculation examples follow Eurocode and Finnish National Annexes. 

 

As a conclusion when using the GeoCalc – application, it is explicit to use in calculations 

of stability and settlements.  Nevertheless, the deep stabilization - calculation module 

isn’t yet completed and the usability of the applications is not as well as it could be.  

Key words: stability, settlement, deep stabilization, calculation, GeoCalc 
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ERITYISSANASTO tai LYHENTEET JA TERMIT (valitse jompikumpi) 

 

A’  tehokkaan pohjan ala [m2] 

B perustuksen leveys [m] 

Cd Kuormien vaikutusta rajoittava mitoitusarvo 

bc, bq, bγ perustuksen pohjan kaltevuuden vaikutuskertoimia 

c  koheesio [kN/m2] 

ckrit pilarien kriittinen leikkausjännitys) 

D perustamissyvyys [m] 

Ed Kuormien vaikutuksen mitoitusarvo 

Epil pilarien muodonmuutosmoduuli 

i c, i q, i γ kuormitusresultantin kaltevuuden vaikutuskertoimia 

kh horisontaalijännityksen kerroin (= 1) 

m   moduuliluku 

Ma aktiivimomentti 

Mp passiivimomentti 

N Normaalivoima 

Nc, Nq, N γ kantavuuskertoimia 

R kestävyys [kN], tai säde [m] 

Rd Kestävyyden mitoitusarvo 

RIL Suomen Rakennusinsinöörien Liitto ry.   

S Kokonaispainuma 

Si Alkupainuma 

Sk Konsolidaatiopainuma 

Sτ Sivusiirtymien aiheuttama painuma 

Ss Jälkipainuma, ts. sekundääripainuma 

su suljettu leikkauslujuus [kN/m2] 

s c, s q, s γ perustuksen muodon vaikutuskertoimia 

spil pilarille siirtyvän kuormaosuuden aiheuttama painuma 

q                    kuormitus 

qliik tasainen muuttuva kuorma 

qpil pilareille tuleva osa kokonaiskuormasta  
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τf  leikkauslujuus [kN/m2] 

τpil pilarin leikkauslujuus 

σ’  tehokas jännitys, raepaine murtopinnalla [kN/m2] 

φ  maan sisäinen kitkakulma [˚] 

 

γ                    maan tilavuuspaino [kN/m3] 

β   moduulieksponentti tai jännityseksponentti 

σ   pystyjännitys 

σv  vertailujännitys 100 kN/m2 (vakio) 

σh pilareihin vaikuttava maan tehokas horisontaalijännitys 

σpil pilarille tuleva puristusjännitys  

σmurto pilarin puristuskapasiteetti 

μ redusointikerroin  
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1 JOHDANTO  

 

 

Pohjarakenteiden suunnittelussa geotekniset laskelmat ovat usein raskaita ja aikaa vieviä 

käsin laskettuina, miksi tarkastelut tehdään yleensä laskentaohjelmistojen avulla. 

Tampereen ammattikorkeakoululla on käytössään GeoCalc – ohjelmisto, jonka käyttöä 

opetellaan esimerkiksi infran ja talonrakentamisen pohjarakenteiden kursseilla. 

Kuitenkin opetuskäyttöön soveltuvat laskentaesimerkit ja ohjeet ovat ohjelman 

uudistuessa vanhentuneita ja vaativat päivittämistä. Ohjelmassa on myös mahdollisuus 

3D – laskentaan, jonka soveltamista ei opetuskäyttöön ole testattu.  

 

Tämän työn tarkoitus on tuottaa selkeät, päivitetyt laskentaesimerkit GeoCalc – 

ohjelmiston käytöstä painuma-, vakavuus- ja stabilointilaskentaan. Esimerkit toimivat 

apuna ohjelmiston eri laskentamoduulien opettelussa ja perehdyttävät samalla ohjelman 

käytön perustoimintoihin.  

 

Työn tavoitteena on helpottaa ohjelmiston käytön opettelua ja tehdä ohjelmistossa 

tehtävät valinnat helpommin ymmärrettävämmiksi.  

 

Työssä käsitellään laskentaohjelmiston taustan lisäksi vakavuus-, painuma- ja 

stabilointilaskennan teoreettisia taustoja ja laskentamenetelmiä niin, että GeoCalc – 

ohjelmistossa tehdyt valinnat ja vaihtoehdot tulevat ymmärrettävämmiksi.  

 

Aihe on rajattu koskemaan stabiliteetti- ja painumalaskelmien lisäksi stabilointeja. 

Työssä ei siis käsitellä tuettujen kaivantojen tai paaluperustuksien mitoitusta GeoCalc – 

ohjelmistolla.   
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2 GEOCALC 

 

 

GeoCalc on suunnittelijoiden päivittäinen työkalu geoteknisten laskelmien 

suorittamiseen. Ohjelmalla pystytään tekemään stabiliteetti- ja painumalaskentaa sekä 

mitoittamaan tukiseiniä, paaluja ja syvästabilointia.  

 

 

2.1 Yleistä 

 

GeoCalc on geoteknisiin laskelmiin tarkoitettu suunnitteluohjelmisto ja tulosta vuonna 

2002 käynnistyneestä GeoSuite – projektista, missä geoalan eri toimijat ja asiantuntijat 

halusivat kehittää yhden nykyaikaisen laskentaohjelman. Aiemmin ongelmana oli, että 

geotekniset laskelmat oli tehtävä hajautettuna usealla eri laskentaohjelmistolla, jotka 

olivat osittain vanhentuneita ja vaikeakäyttöisiä. (Vianova Systems Finland Oy: Geoala 

yhdisti osaamisensa...).  

 

GeoCalcin tuli korvata siis aiemmat useat eri ohjelmat ja täyttää keskeiset geotekniset 

vaatimukset, jotta sitä voidaan pitää yleisesti hyväksyttynä laskentamenetelmänä. 

Projektin koordinoinnista ja käytännön ohjelmistokehityksestä vastasi Vianova Systems 

Oy, joka huolehtii ohjelmiston nykyisestä myynnistä, tuotekehityksestä ja 

koulutuspalvelusta. (Vianova Systems Finland Oy: Geoala yhdisti osaamisensa...).  

 

 

2.2 Viasys VDC Oy 

 

Kerrotaan hieman GeoCalc – ohjelmistoa jakavasta yrityksestä. Vianova Systems Finland 

Oy on perustettu vuonna 1989 rakennusalan ohjelmistotaloksi. Yritys palvelee rakennus- 

ja yhdyskuntatekniikan alan toimijoita Suomessa tarjoamalla asiakkailleen tukipalveluja 

ja koulutusta erilaisten kurssien muodossa. (Vianova Systems Finland Oy, 2016). 

 

Vianova Systems Finland Oy jakautui kuitenkin 1.1.2016 kahdeksi yhtiöksi. Vianova 

Systems Finland Oy on erikoistunut infrastruktuurisuunnittelu ja –ohjelmisto – 

toimintaan. Uutena yrityksenä muodostui Viasys VDC Oy, joka on jatkossa kiinteistö- ja 

rakennusalan elinkaarenaikaiseen malli- ja tiedonhallinta – liiketoimintaan erikoistunut 
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yritys.  Jakaantumisella yhtiö pyrkii vastaamaan paremmin sen nykyisten ja tulevien 

asiakkaiden tarpeisiin ja vastaamaan alan nopeaan kehitykseen (Vianova Systems Finland 

Oy, 2016).  

 

Yhtiön jakaantumisesta ilmoittavassa tiedotteessa kerrotaan GeoCalc - ohjelmiston 

kuuluvan nykyisin Viasys VDC Oy:n tuotteisiin. Tällöin myös ohjelmiston tukipalvelut 

tarjoavat Viasys VDC Oy. Novapoint – tuoteperheestä vastaa taas Vianova Systems 

Finland Oy. (Vianova Systems Finland Oy jakautui...2016).  

 

Kuitenkin tietoa GeoCalc – ohjelmasta löytyy vielä vain Vianova Systems Finland Oy:n 

verkkosivuilta.  

 

 

2.3 GeoCalc 3.1 

 

Ohjelmistossa eri laskentamenetelmät ovat erillisissä laskentamoduuleissa, jotka toimivat 

yhteisen piirtoalustan päällä. Tämä mahdollistaa sen, että eri tarkasteluille voidaan 

käyttää samaa piirtoalustalla olevaa laskentamallia. (Vianova Systems Finland Oy 2010, 

3).  

 

Laskentamoduulit toimivat pääasiassa eri yliopistojen kehittämien ja ohjelmoimien 

laskentamallien avulla, joista Vianova Systems Oy on kehittänyt laskentamoottorit. 

Esimerkiksi tukiseinälaskentamoottorin laskentamalli on kehitetty Tampereen 

Teknillisessä yliopistossa. (Vianova Systems Finland Oy, 2010,3).  

 

Tämän opinnäytetyön kirjoittamishetkellä uusin versio on GeoCalc 3.1, mille ohjelman 

tuottaja on ilmoittanut uudeksi ominaisuudeksi esimerkiksi sen, että 

pilaristabilointilaskennasta voidaan tuottaa lähtötiedot stabiliteettilaskentaa varten, jonka 

jälkeen vakavuustarkastelu tehdään stabiliteettimoduulilla (Vianova Finland Oy: 

GeoCalc 3.1 uudet ominaisuudet,.2016).  
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3 MAAPOHJAN VAKAVUUSLASKENNAN TEORIA 

 

 

Pohjarakenteille geotekninen kantavuus on määriteltävä yleensä kantokyky- ja 

painumalaskelmiin perustuen. Maapohjalle rakennettaessa on sille määriteltävä 

geotekniset maakerrokset ja niiden geotekniset mitoitusarvot ennen suunnittelua ja 

rakentamista. Maapohjaksi luetaan luonnonmaapohja, täyttömaapohja, vaihdettu 

maapohja sekä vahvistettu maapohja. (RIL 121-2004,67,68).   

 

 

3.1 Maapohjan kantavuuden ja vakavuuden laskenta 

 

Maarakenteet, perustukset ja jännitykset maaperässä aiheuttavat siihen 

leikkausjännityksiä. Jos maapohjaa kuormitetaan niin raskaalla rakenteella, että 

kuormituksesta aiheutuvat leikkausvoimat ylittävät maan leikkauslujuuden, maapohja 

murtuu ja rakenne joko painuu maan sisään tai liukuu sivulle määrättyä liukupintaa pitkin. 

Maakerrostuman leikkauslujuus määrää siis mm. maapohjan kantavuuden, maaluiskien 

vakavuuden ja maanpaineen suuruuden. Tämän vuoksi leikkauslujuus on ehkä keskeisin 

maaperän lujuusominaisuuksista. (Rantamäki, Jääskeläinen & Tammirinne 1986, 122; 

Helenelund 1974, 88).  

 

KUVA 1. Maakerroksen leikkauslujuus määrää mm. maapohjan kantavuuden, 

maaluiskien vakavuuden ja maanpaineen suuruuden 

 

Leikkauslujuuden katsotaan koostuvan kahdesta päätekijästä:  

 

1. Sisäisestä kitkasta, joka aiheutuu maarakeiden hankauksesta toisiaan vastaan. 

Karkearakeisissa maissa (esim. hiekka, sora, murske) leikkauslujuus aiheutuu 

pääasiassa kitkasta, jolloin koheesio otaksutaan nollaksi.   

2. Koheesiosta, joka aiheutuu maahiukkasten välisistä kiinnevoimista, sekä 

mineraalihiukkasia ympäröivien vesivaippojen välisistä sähköstaattisista 
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voimista. Saven leikkauslujuus muodostuu pääasiassa vain koheesiosta, jolloin 

kitka otaksutaan nollaksi.  

 

Lisäksi on välimuotomaalajeja, esim. siltti ja moreeni, joiden leikkauslujuus muodostuu 

sekä kitkasta, että koheesiosta. Yleisesti leikkauslujuus voidaan ilmaista myös kaavalla: 

 

𝜏𝑓  =  𝑐 +  𝜎’ ·  𝑡𝑎𝑛 𝜑   (1) 

 

missä, 

τf  leikkauslujuus [kN/m2] 

c  koheesio [kN/m2] 

σ’  tehokas jännitys, raepaine murtopinnalla [kN/m2] 

φ  maan sisäinen kitkakulma [˚] 

 

 (Helenelund 1974,88; Jääskeläinen 2014, 100; Rantamäki, Jääskeläinen & Tammirinne 

1986, 123).   

 

Kantavuuskaavat 

Tarkasteltaessa esimerkiksi kaavaa, mitä käytetään Liikenneviraston kohteissa 

maavaraisia siltaperustuksia laskiessa, on siitäkin eroteltavissa koheesion (c), 

murtopinnalla vallitsevan raepaineen (σ, kaavassa q) ja maan sisäisen kitkan huomioivat 

osat (Kaava 2). Kitka, ts. kitkakulma (φ) huomioidaan kaavassa yksiköttömissä 

kertoimissa (b, N, i): 

 

𝑅´

𝐴
 =  𝑐’ · 𝑁𝑐 · 𝑏𝑐 ·  𝑠𝑐  · 𝑖𝑐 + 𝑞’ · 𝑏𝑞 · 𝑠𝑞 · 𝑖𝑞 + 0,5 · 𝛾’ · 𝐵’ · 𝑁𝛾 · 𝑏 𝛾 · 𝑠 𝛾 · 𝑖 𝛾                   (2) 

 

missä,  

R  kestävyys [kN] 

A’   tehokkaan pohjan ala [m2] 

c’   tehokas koheesio [kN/m2] 

q’ perustamistasossa vallitseva jännitys [kN/m2], mikä 

puolestaan voidaan laskea kuten kaavassa 3: 

 

 

𝑞’ =  𝐷 ·  𝛾     (3) 
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missä, 

  D perustamissyvyys [m] 

γ maan tilavuuspaino perustamistason yläpuolella 

[kN/m3] 

B’  perustuksen tehokas leveys [m]  

bc, bq, bγ  perustuksen pohjan kaltevuuden vaikutuskertoimia 

Nc, Nq, N γ  kantavuuskertoimia 

s c, s q, s γ  perustuksen muodon vaikutuskertoimia 

i c, i q, i γ  kuormitusresultantin kaltevuuden vaikutuskertoimia 

γ´ maan tehokas tilavuuspaino perustamistason alapuolella 

[kN/m3] 

 

Kantavuuden laskentaa kaavan 2 mukaisesti ei ole tarkoitus käsitellä tässä työssä 

syvemmin. Ohjeet maavaraisen perustamisen kantokestävyyden laskentaan löytyvät 

esimerkiksi Liikenneviraston ohjejulkaisusta: Eurokoodien soveltamisohje Geotekninen 

suunnittelu NCCI7. Vastaavasti talokohteissa käytetään RIL:n julkaisua RIL 207-2009 

Geotekninen suunnittelu. Eurokoodi yhdessä RIL:n julkaisun ”RIL 201-2008 

Suunnitteluperusteet ja rakenteiden kuormat. Eurokoodi” kanssa. (Liikennevirasto 

35/2013, 47; RIL ry 2016).  

 

Rakenteiden kantokyky voidaan laskea kantavuuskaavan avulla silloin, kun 

kantavuuskaavan edellyttämä murtokuvio ts. leikkauspinta, voi muodostua 

homogeenisessä maapohjassa. Muissa tapauksissa pohjarakenteen kantokyky määritetään 

liukupintojen avulla tai koekuormituksien perusteella. Laskentamallin ollessa 

monimutkainen, tai geoteknisen käyttäytymisen ollessa laskennallisesti vaikeaa, voidaan 

mitoitusta myös täydentää työnaikaisilla seurantamittauksilla. (RIL 121-2004, 73; 

Liikennevirasto 35/2013, 17).   

 

Liukupinta-analyysi  

Liukupinta-analyysi on Suomessa yleisesti käytössä oleva kantavuus- ja 

vakavuuslaskennan menetelmä. Sitä pidetään yleismenetelmänä, jolla voidaan laskea 

kantavuus- ja vakavuuslaskelmat monimutkaisissakin tilanteissa. Menetelmässä 

sortuman oletetaan tapahtuvan maassa pitkin tiettyä liukupintaa, jonka sijainti ja muoto 

tunnetaan. Tyypillisesti lamellimenetelmällä tehtävässä liukupintatarkastelussa 
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liukupinnan yläpuolinen osa jaetaan pystysuoriin lamelleihin, joiden tasapainoa tutkitaan 

(Kuva 2). Menetelmässä haetaan kriittisintä liukupintaa ja sen löytämiseksi suoritetaan 

lukuisia tarkasteluja erilaisilla liukupinnoilla. (Jääskeläinen 2014, 213).  

 

Laskennassa tulee huomioida kerrokset, joiden leikkauslujuus on merkittävästi muita 

kerroksia heikompi. Tämä johtuu siitä, että vaarallisin liukupinta pyrkii leikkaamaan 

lujimmat kerrokset ohuimmilta kohdin lyhyesti ja pehmeimmissä kerroksissa 

mahdollisimman pitkästi. Liukupinnan muoto voi olla periaatteessa täysin vapaa, mutta 

laskelmissa se oletetaan yleensä ympyräksi. (Mansikkamäki 2009, 14; Liikennevirasto 

35/2010, 67,68).   

 

Käsinlaskennassa tyypillisin etenemisjärjestys olisi:  

1) Määrittää maaperän kerrosrajat, penkereen tai leikkauksen sijainti 

2) Määrittää maalajit, niiden tilavuuspainot, kitkakulma, koheesio ja suljettu 

leikkauslujuus 

3) Määrittää:  

a) pohjaveden pinta 

b) kallion pinta 

c) kuormat 

4) Määrittää ensimmäinen liukupinta arvioimalla suurinta epätasapainoa ja 

maakerroksien heikkoutta.  

5) Jakaa liukuympyrän yläpuolinen osa pystylamelleihin 

6) Laskea paikallaan pitävä eli passiivimomentti lamelli kerrallaan (Kaava 4): 

  

KUVA 2. Liukupinta-analyysin periaate koheesiomaassa 
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𝑀𝑝 = 𝑅 ∙ ∆𝑙 ∙ 𝑠  (4)  

 

missä,  

Mp passiivimomentti 

R liukuympyrän säde 

Δl liukupinnan pituus tarkasteltavan lamellin leveydeltä (Kuva 2) 

s leikkauslujuus [kN/m2] 

  

7) Laskea kaatava eli aktiivimomentti (Kaava 5):  

 

𝑀𝑎 = 𝑄 ∙ 𝑎 + 𝑊 ∙ 𝑥  (5) 

 

missä, 

Ma aktiivimomentti 

Q ulkoisesta kuormasta aiheutuva momentti (esim. penger) 

a ulkoisen kuorman momenttivarsi liukuympyrän keskipisteeseen (Kuva 2) 

W tarkasteltavan lamellin tilavuuspainosta aiheutuva pistekuormitus 

x tarkasteltavan lamellin painopisteen momenttivarsi liukuympyrän 

keskipisteeseen (Kuva 2) 

 

8) Laskea varmuuskerroin murtoa vastaan yhtälön (6) mukaisesti:  

 

F= Mp / Ma   (6) 

 

Lasku uusitaan niin monella liukupinnalla, että pienin varmuuskerroin saadaan 

haarukoitua suurempien varmuuksien sisälle. Tämä tulee huomioida myös, kun 

tarkastellaan laskentaohjelmilla saatuja tuloksia (Jääskeläinen 2014, 213).  

 

Koheesio- ja kitkamaan liukupintojen laskenta eroaa leikkauslujuuden määrityksessä. 

Koheesiomaalla leikkauslujuus on vakio, kun taas kitkamaalla se riippuu tarkasteltavan 

kohdan liukupintaa vastaan kohdistuvasta normaalijännityksestä. (Jääskeläinen 2014, 

212,213,216; Rantamäki, Jääskeläinen & Tammirinne 1986, 195,196).  
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Näin ollen leikkauslujuus tulisi laskea jokaiselle lamellille erikseen kaavan 7 mukaisesti:  

 

𝑠𝜑 = 𝜎 ∙ 𝑡𝑎𝑛𝜑 = 𝑁 ∙ 𝑡𝑎𝑛𝜑   (7) 

 

missä,  

σ raepaine murtopinnalla 

φ kitkakulma 

N liukupintaan kohtisuoraan vaikuttava normaalivoima 

 

Pitkäaikaisen vakavuuden laskentaan käytetään yleensä liukupinta-analyysin c – φ – 

menetelmää, joka huomioi leikkauspinnalla vaikuttavan kitkan ja koheesion lisäksi 

vallitsevan huokosvedenpaineen (u). Menetelmää tarvitaan erityisesti mitoitettavan 

pohjamaan ollessa esimerkiksi silttiä tai hienoa moreenia (ts. välimuotomaalajia), koska 

maa-aineksen leikkauslujuus ei muodostu selkeästi kitkavoimasta tai koheesiosta. 

(Rantamäki, Jääskeläinen & Tammirinne 1986, 200).  

 

Laskenta on käsinlaskettuna työläs ja viisainta tehdä taulukoituna. Laskentaohjelmista 

esimerkiksi GeoCalc käyttää tätä ko. menetelmää. Laskentaohjelmissa menetelmää 

voidaan soveltaa kitkamaille merkitsemällä koheesio nollaksi (c = 0) ja vastaavasti 

koheesiomaille merkitsemällä kitkakulma nollaksi (φ = 0). (R. Jääskeläinen 2014, 218).  

KUVA 3. Kitkamaan liukupinta-analyysin periaate ja 

parametreja 
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Laskentateoria 

Liukupinta-analyysin laskennalle on olemassa useita laskentateorioita, joista 

ympyräliukupintoihin perustuva Bishopin yksinkertaistettu menetelmä on yksi 

käytetyimmistä varmatoimisuutensa ja nopeutensa ansiosta. Menetelmällä saatavat 

tulokset katsotaan olevan riittävän tarkkoja.  Sen käyttöä olisi kuitenkin harkittava 

tilanteessa, missä malliin vaikuttaa suuria vaakasuuntaisia voimia. Samoin, jos 

maapohjassa on ohut, pehmeä savikerros, jota pitkin liukuminen tapahtuu, on sopivampi 

käyttää liukupintoja, jotka eivät ole ympyränmuotoisia, esim. kiilamenetelmää tai Janbun 

menetelmää. Alla olevassa taulukossa (1) on Liikenneviraston ohjeen 9/2010 

Tiepenkereiden ja leikkausten suunnittelu mukainen esitys eri tilanteisiin soveltuvista 

laskentamenetelmistä. (Liikennevirasto 9/2010, 25; Mansikkamäki 2009, 14).   

 

 

 

TAULUKKO 1: Eri tapauksissa käytettäviä 

laskentamenetelmiä (Liikenneviraston ohje 9/2010, 

Tiepenkereiden ja -leikkausten suunnittelu, 25). 
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3.2 Kantavuus- ja vakavuuslaskennan lähtötiedot 

 

Vakavuuslaskennassa tarvittavia lähtötietoja ovat:  

 

- Olemassa olevat rakenteet, jotka vaikuttavat paitsi passiivisena tai aktiivisena 

kuormana, myös käytettävien varmuuskertoimien suuruuteen. 

- Ojat, painanteet, koska liukupinta pyrkii leikkaamaan maanpinnan ojien yms. 

painanteiden pohjien läpi.  

- Maalajikerrokset, joissa kiinnitetään huomiota varsinkin todella pehmeisiin, 

herkkiin kerroksiin. Liukupinta pyrkii leikkaamaan nämä mahdollisimman 

pitkältä matkalta.  

- Penkereet, jotka aiheuttavat maapohjalle lisäkuormitusta ja voivat aiheuttaa 

maapohjan murtumisen.  

- Kaivannot, joiden luiskan kaltevuus määritellään vakavuus- eli 

stabiliteettilaskennan perusteella.  

- Pohjaveden esiintyminen  

- Maakerrosten tilavuuspainot, γ [kN/m2], määrittää leikkauspinnalle tulevan 

kuormituksen. 

- Koheesio, c [kN/m2] ts. suljettu leikkauslujuus, su [kN/m2], mikä määrittää 

erityisesti koheesiomaan kestävyyden leikkausmurtumaa vastaan. 

- Kitkakulma, φ [˚], mikä määrittää erityisesti kitkamaan kestävyyden 

leikkausmurtumaa vastaan.  

 

3.3 Kokonaisvarmuusmenetelmä 

 

Kokonaisvarmuusmenetelmä on ollut Suomessa käytössä pohjarakenteiden 

suunnittelussa ennen eurokoodin käyttöönottoa. Menetelmässä laskenta suoritetaan 

käyttämällä sekä kuormien että rakenteen lujuusominaisuuksien ominaisarvoja. 

(Jaakkonen 2013,37).  

 

Kokonaisvarmuusmenetelmässä mitoitettavan rakenteen lujuus on oltava riittävän suuri 

verrattuna murtavien voimien suuruuteen, ts. rakenteen ominaislujuuden on oltava 

suurempi kuin yksi. Kokonaisvarmuuskerroin (Fkok) saadaan, kun rakenteen lujuus 

jaetaan sitä rasittavilla kuormilla alla olevan kaavan mukaisesti.   
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𝐹𝑘𝑜𝑘 =
𝑅𝑎𝑘𝑒𝑛𝑡𝑒𝑒𝑛 𝑙𝑢𝑗𝑢𝑢𝑠

𝑅𝑎𝑠𝑖𝑡𝑡𝑎𝑣𝑎𝑡 𝑣𝑜𝑖𝑚𝑎𝑡
   (8) 

 

Keskeistä kokonaisvarmuusmenetelmässä on kokonaisvarmuuskertoimen 

määrittäminen. Pohjarakenteiden mitoituksessa vaatimus on yleensä ollut Fkok ≥ 1,5 ja 

vaativissa kohteissa suurempi. Esimerkiksi Suomen Rakennusinsinööriliiton julkaisun 

RIL 121-2004: Pohjarakennusohjeet mukaan varmuusluvun arvo on 1,8 

rakennusaikaisen kaivannon liukusortumaa vastaan, kun sen vaikutusalueella on muita 

kuin työnaikaisia rakenteita (Jaakkonen 2013, 37; RIL 2014, 137).  

 

 

3.4 Eurokoodien mukainen mitoitus osavarmuusmenetelmällä 

 

Geotekniset mitoitukset suoritetaan eurokoodien osan 7, eli standardin EN 1997 

Eurokoodi 7: Geotekninen suunnittelu ja sen kansallisen liitteen mukaisesti. Laskelmien 

tekemiseen käytetään kohteesta riippuen joko Liikenneviraston tai RIL:n julkaisemia 

soveltamisohjeita. Eurokoodit sisältävät periaatteet sekä kokonaisvarmuuden 

määrittämiselle, että osavarmuuksien määrittämisen eri kuormituksille ja 

lujuusominaisuuksille. 

 

Osavarmuusmenetelmä ominaiskuormista ja –lujuuksista saadaan mitoitusarvoja 

huomioimalla ne eurokoodin mukaisilla osavarmuusluvuilla. Eurokoodien mukainen 

mitoitus perustuu rajatiloihin, jotka voidaan jakaa murto- ja käyttörajatiloihin. 

Käytettävät osavarmuusluvut riippuvat tarkasteltavasta rajatilasta ja laskentaan 

käytettävästä mitoitusmenetelmästä (Bond & Schuppener 2013, 10,11)  

 

 

3.4.1 Murtorajatila 

 

Murtorajatiloiksi luokitellaan esimerkiksi ihmisten turvallisuuteen liittyvät ja rakenteen 

sortumista edeltävät tilat (SFS 1990, 16/46). Murtorajatilassa osoitetaan, että kuormien 

vaikutusten mitoitusarvo (Ed) on enintään yhtä suuri, kuin kestävyyden mitoitusarvo (Rd) 

(Kaava 8). Kun vakavuus lasketaan tavanomaisella lamellimenetelmällä, tarkoittaa tämä, 

että Ed on kaatavan aktiivimomentin arvo ja Rd taas passiivimomentin (Liikennevirasto 

2013,68).  
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𝐸𝑑 ≤ 𝑅𝑑    (9) 

missä,  

Ed Kuormien vaikutuksen mitoitusarvo 

Rd Kestävyyden mitoitusarvo 

 

Murtorajatilamitoituksen tuloksena saadaan kaavan (10) mukaan laskettuna 

ylimitoituskerroin (ODF). Vaatimuksena on, että ODF ≥ 1,0 (Liikennevirasto 35/2013, 

68).  

 

𝑂𝐷𝐹 =  
𝑅𝑑

𝐸𝑑 
≥ 1,0   (10) 

 

Murtorajatilatarkastelu voidaan tehdä Suomessa joko DA2 tai DA3 – menetelmällä. 

Menetelmät huomioivat osavarmuusluvut eri vaiheissa laskentaa. On olemassa myös 

menetelmä DA 1, mutta sitä ei käytetä Suomessa (Jääskeläinen 2011, 346).  

 

DA 2 – menetelmää käytetään antura- ja laattaperustusten, ankkurien ja tukirakenteiden 

mitoituksessa ja siitä on olemassa vaihtoehtoinen DA 2* - menetelmä (Jääskeläinen 2011, 

346).  

 

Vakavuutta eli stabiliteettia laskiessa käytetään Suomessa menetelmää DA3, missä 

osavarmuusluvut kohdistetaan heti alussa kuormiin ja maaparametreihin (Jääskeläinen 

2011, 346). Taulukoissa 2 ja 3 on esitetty osavarmuusluvut, joita käytetään menetelmällä 

DA3 laskiessa (Liikennevirasto 35/2013, Liite 1).  
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TAULUKKO 3. Kuormien ja kuorman vaikutusten osavarmuusluvut laskettaessa DA3 - 

menetelmällä (Liikenneviraston ohjeita 35/2013: Eurokoodien soveltamisohje, 

Geotekninen suunnittelu -  NCCI7, Liite 1) 

TAULUKKO 2. Maaparametrien osavarmuusluvut maanvaraisia 

penkereitä ja leikkauksia laskiessa käytetään M2 – sarjan arvoja 

(Liikennevirasto 35/2013, Liite 1) 
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4 VAKAVUUSLASKENNAN LASKENTAESIMERKIT 

 

 

Laskentaesimerkeissä tarkastellaan pehmeikölle rakennetun penkereen ja savikolla 

olevan putkijohtokaivannon vakavuutta. Tehdessä eurokoodien mukaista mitoitusta, tulee 

vakavuustarkastelu tehdä sekä murto- että käyttörajatilassa.  

 

Laskentaesimerkeissä tarkastellaan ensin alapuolisen kuvan mukaista tilannetta. 

Mitoitettavana tilanteena on pehmeikölle perustettava n. 2,5 metriä korkea penger.  

 

Toisena laskentaesimerkkinä vakavuuslaskennasta toimii luiskattu putkikaivanto. 

Kaivanto on noin 2 metriä syvä ja tehdään tasalaatuiselle savikolle, kuten alla olevassa 

kuvassa on esitetty.  

 

 

 

KUVA 4. Laskentaesimerkissä tarkasteltava tilanne 

KUVA 5. Laskentaesimerkissä tarkasteltava putkikaivanto 
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4.1 Penkereen vakavuus pehmeiköllä 

 

Laskentaesimerkissä tarkastellaan pehmeikölle perustettua penkerettä (Kuva 4) ja sille 

tehdään tarkastelut sekä murto- että käyttörajatilassa. Maanvaraista penkerettä tai luiskaa 

mitoittaessa käytetään laskentatapaa DA3, jolloin osavarmuusluvut kohdistetaan heti 

laskennan alusta maaparametreihin ja muuttuviin kuormiin aiemmin esitettyjen 

taulukoiden 2 ja 3 mukaisesti. Maaparametrien osavarmuusluvut tulevat sarakkeesta M2 

(Liikennevirasto 35/2013,67). Lisäksi tässä laskentaesimerkissä tarkastellaan penkereen 

vakavuutta kokonaisvarmuuslukumenetelmällä.  

 

4.1.1 Laskentamalli 

 

Laskentamallin geometriaan ei kohdisteta varmuuksia, vaan laskentamallissa käytetään 

tunnettujen tietojen nimellisarvoja. Olemassa olevien rakenteiden osalta siis 

mittaustietoihin, uusien rakenteiden osalta suunnitelmiin ynnä pohjatutkimuksiin 

perustuen. (Liikennevirasto 35/2013, 24).  

 

Pohjaveden- ja vapaanvedenpinnan taso valitaan laskentamallissa niin, että ne edustavat 

mitoitustilanteessa epäedullisimpia mahdollisia tasoja rakenteen käyttöaikana. Lisäksi 

laskentamallissa tulee huomioida erityisesti kerrokset, joiden leikkauslujuus on 

huomattavasti muita kerroksia heikommat. (Liikennevirasto 35/2013,67).  

 

4.1.2 Laskentateoria 

 

Penkereen poikkileikkaus suunnitellaan ja mitoitetaan pehmeikköalueilla 

vakavuuslaskelmien avulla. Koheesiomaan varaan rakennettavan penkereen 

lyhytaikainen vakavuus lasketaan φ = 0 –menetelmällä ja pitkäaikainen c – φ - 

menetelmällä. Laskennassa käytettävät leikkaukset valitaan siten, että vakavuus 

vaarallisimmassa suunnassa tulee selvitetyksi. Lisäksi liukupintoja lasketaan sellainen 

määrä, että heikoin liukupinta rajautuu kahden vahvemman väliin. (Tielaitos 2003, 20).  

 

4.1.3 Raja-arvot 

 

Osavarmuuslukumenetelmällä laskettaessa on pienimmän varmuuskertoimen oltava 

arvoltaan ≥ 1,0.  
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Rakentamismääräyskokoelman osan B3 Pohjarakenteet (2004,14) mukaan 

kokonaisvarmuuslukumenetelmällä laskettuna on pienimmän varmuuskertoimen oltava 

arvoltaan ≥ 1,8. 

 

Penkereen vakavuutta voidaan parantaa esimerkiksi: 

- Vähentämällä maapohjaan kohdistuvaa kuormitusta esim. madaltamalla pengertä 

tai kevennerakenteilla 

- Käyttämällä vastapengertä 

- Vahvistamalla maapohjaa esim. massanvaihdolla tai käyttämällä syvästabilointia 

- Siirtämällä kuormat kantavaan pohjaan paaluilla 

 

Penkereen vakavuuden laskentaa Novapoint GeoCalc- ohjelmistolla käsitellään 

tarkemmin Liitteessä 2.  

 

 

4.2 Luiskattu kaivanto 

 

Laskentaesimerkissä tarkastellaan homogeeniselle savikolle luiskaamalla tehtävää 

kaivantoa. Laskennassa huomioidaan vieressä työskentelevän työkoneen aiheuttama 

kuormitus. Tarkastelut tehdään sekä osavarmuuslukumenetelmällä että 

kokonaisvarmuusmenetelmällä.  

 

Kaivantotyöt määritellään Suomen lainsäädännössä vaarallisiksi töiksi ja niiden 

sortuminen aiheuttaakin vuosittain lukuisien loukkaantumisien ja tapaturmien lisäksi 1 – 

3 kuolemaa. Rakennustyön turvallisuutta koskevassa Valtioneuvoston asetuksessa 

205/2009 on useita kaivantojen turvallisuuteen liittyviä säädöksiä. Asetus velvoittaa 

ottamaan selvää maan ja kallioperän geoteknisistä ominaisuuksista ennen maa- ja 

vesirakennustyön aloittamista. Kaivanto voidaan tehdä luiskattuna tai porrastamalla sen 

perustuessa luotettaviin suunnitelmiin (VNA 205/2009 §34). Kaivantoja suunniteltaessa 

on siis arvioitava niiden sortumavaaraa ja maamassojen kantavuutta (Liikennevirasto: 

Vaara vaanii kaivannossa, 6,14).   
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4.2.1 Laskentamalli 

 

Kaivannon luiskan kaltevuus (ja näin ollen kaivannon tilantarve) määritellään 

vakavuuslaskujen perusteella. Luiskan minimikaltevuus on kuitenkin 2:1 erityisesti 

työturvallisuuden vuoksi. 

 

 Kaivantopoikkileikkauksen valinnassa on huomioitava:  

- riittävä varmuus kaivannon luiskien sortumista vastaan  

- riittävä varmuus pohjamaan heikkojen kerrosten kautta tapahtuvaa laaja-alaista 

sortumaa vastaan 

- työturvallisuus 

- kaivannon pohjan vakavuus  

- pohjaveden hallinta (hydraulisen murtuman vaara) 

(RIL263-2014, 133). 

 

 

 

 

KUVA 6. Kaivannon murtumismekanismeja 
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4.2.2 Laskentateoria 

 

Hienorakeisessa ja eloperäisessä maassa luiskatun kaivannon vakavuutta tarkastellaan 

sekä lyhytaikaisessa että pitkäaikaisessa tilanteessa. Lyhytaikaisella vakavuudella 

tarkoitetaan tilannetta, missä maassa vallitseva huokosvedenpaine on alkanut muuttua 

rakennustöiden aikana tai välittömästi niiden jälkeen (RIL 263-2014, 133).  

 

Koheesiomaalajeilla lyhyen ajan vakavuus tarkastetaan φ = 0 – menetelmällä (eli 

kitkakulma merkitään nollaksi). Pitkän ajan vakavuus on tehtävä c – φ – menetelmällä. 

Karkearakeisilla maalajeilla vakavuus tarkistetaan aina c – φ – menetelmällä, jolloin on 

huomioitava myös pohjaveden virtaustila. Menetelmässä käytettäviä lujuusparametreja 

voidaan arvioida kairausvastuksen perusteella alla olevasta taulukosta (4) (RIL 263-2014, 

133). 

 

TAULUKKO 4: Maalajien lujuus- ja muodonmuutosominaisuusparametrien arviointi 

kairausvastuksen perusteella (RIL 263-2014, Taulukko 7.3, 134). 

 

 

 

 

 

 

 

Ylä-

puolella

Ala-

puolella

Moduuliluku 

m

Jännitys-

eksponentti    

β

Puristin-

kairaus    

q
c
 (Mpa)

Paino-

kairaus   

Pk / 0,2 m

Heijari-

kairaus      

L / 0,2 m

Löyhä 14…16 9… 28 30…100 0,3 < 7 < 40 < 8

Keskitiivis 30 70…150 0,3 7…15 40…100 8…25

Tiivis 16…18 11 32 100…300 0,3 > 15 > 100 > 25

Löyhä 15…17 9… 30 50…150 0,5 < 10 20…50 5…15

Keskitiivis 33 100…200 0,5 10…20 50…100 15…30

Tiivis 16…18 11 36 150…300 0,5 >20 > 100 > 30

Löyhä 16…18 10… 32 150…300 0,5 < 6 10…30 5…12

Keskitiivis 35 200…400 0,5 6…14 30…60 12…25

Tiivis 18…20 12 38 300…600 0,5 > 14 > 60 > 25

Löyhä 17…19 10… 34 300…600 0,5 < 5,5 10…25 5…10

Keskitiivis 37 400…800 0,5 5,5 … 12 25…50 10…20

Tiivis 18…20 12 40 600…1200 0,5 > 12 > 50 > 20

Hyvin löyhä
16…19 10…12 …34

(≤100)* 

300…600
0,5 < 10 < 40 < 20

Löyhä
17…20 10…12 …36

(100 … 250)* 

600…
0,5 > 10 40…100 20…60

Keskitiivis 18…21 11…13 …38 800… 0,5 x > 100 60…140

Tiivis 19…23 11…14 …40 1200… 0,5 x lyömällä > 140

Karkea siltti

Hieno hiekka       

d10 < 0,06

Hiekka                  

d10 > 0,06

Sora

Moreeni

Tilavuuspaino                      

(kN/m
3
) 

pohjavedenpinnan

Janbun yhtälön 

muodonmuutos-parametri

Kitkakulm

a                    

φ                                     

(˚)

Kairausvastus

Maalaji
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4.2.3 Raja-arvot 

 

Kaivannon vakavuuden pienimmän varmuusluvun on murtorajatilassa mitoittaessa oltava 

arvoltaan ≥ 1,0.  

 

Kokonaisvarmuusmenetelmällä tarkasteltaessa on kaivannon kokonaisvarmuuden oltava 

arvoltaan ≥ 1,5, kun vaikutusalueella ei ole pysyviä rakenteita (RIL 263-2014, 137).  

 

Kaivannon vakavuutta voidaan parantaa esimerkiksi:  

- loiventamalla kaivannon luiskaa 

- tekemällä kevennysleikkaus luiskan yläosaan 

- tekemällä massanvaihto luiskan juuren tai kaivannon pohjalle 

- alentamalla pohjavettä  

- stabiloimalla maa kaivannon ympäristössä, luiskassa, kaivannon pohjalla 

- käyttämällä erilaisia lujiterakenteita, kuten esim. maan naulausta 

 

Mikäli em. ratkaisuille ei ole tilaa, tai niillä ei voida parantaa luiskan stabiliteettia 

tarpeeksi suunnitellaan kaivanto tuettuna. Esimerkiksi Suomen Rakennusinsinöörien 

Liitto RIL ry:n julkaisussa Kaivanto-ohje RIL 263-2014, on käsitelty tuetun kaivannon 

mitoittamista. (RIL 263-2014, 134,138). 

 

Putkikaivannon vakavuuden laskentaa Novapoint GeoCalc – ohjelmistolla käsitellään 

tarkemmin liitteessä 3.  
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5 PAINUMALASKENNAN TEORIA 

 

Jokainen rakenne jota ei ole perustettu kallion varaan, painuu ajan mittaan. Painuman 

suuruus ja nopeus riippuvat kuormituksesta ja maapohjan laadusta. Kitkamaalle 

perustettu rakenne painuu usein jo rakennusaikana ja kokonaispainuma voi olla joitain 

senttejä. Savimaalle perustettaessa taas painuman muodostuminen voi viedä vuosia ja olla 

lopulta jopa kymmeniä senttimetrejä. Suurta painumaa haitallisempaa on kuitenkin 

painuman epätasaisuus, mikä voi aiheuttaa esimerkiksi rakenteeseen haitallisia 

halkeamia. (Helenelund 1974, 245,246).  

 

 

5.1 Painumalajit 

 

Maaperän painuminen liittyy maa-aineen kokoonpuristuvuus-ominaisuuteen, mistä 

voidaan erottaa kolme päälajia: 

 

Kimmoinen painuminen (Kuva 5), missä tilanne palaa ennalleen rasituksen poistuessa 

ja on maa-aineksilla hyvin pientä.  

 

Plastinen painuminen (Kuva 6), missä maa-aineen leikkausvoimat ovat jo lähellä 

murtumisrajaa, mikä aiheuttaa maan sisällä liikkeitä, jotka voivat näkyä jo maan 

kohoamisena rasitetun kohdan ympärillä. Tilanne jää samaksi kuormituksen poistuessa. 

Plastisen painuman esiintyminen estetään yleensä käyttämällä riittävän suurta varmuutta 

kantavuusmitoituksessa maapohjan murtumista vastaan.  

KUVA 7. Kimmoinen painuma 
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Konsolidaatiosta (ts. tiivistymisestä) aiheutuva painuminen (Kuva 7), missä 

kuormituksen alapuolella oleva maamassa puristuu kokoon niin, että maarakeet siirtyvät 

lähemmäs toisiaan ja maanpinta painuu ilman, että muita muodonmuutoksia ympärillä 

tapahtuisi. Toisin sanoen maapohja tiivistyy kuormituksen alla. Painuvan maakerroksen 

laatu, siihen kohdistuvan kuormituksen suuruus sekä maakerroksen paksuus kuormitetun 

alueen laajuuteen verrattuna vaikuttavat kokoonpuristuvuuden tyyppiin ja suuruuteen 

(Rantamäki, Jääskeläinen & Tammirinne, 1985,145).  

 

 

Maavaraista rakennetta mitoitettaessa selvitetään painumien ja painumaerojen suuruus.  

Kokonaispainuman katsotaan koostuvan alkupainumasta, konsolidaatiopainumasta, 

sivusiirtymien aiheuttamasta painumasta sekä jälkipainumasta. Kokonaispainuma 

voidaan ilmaista myös kaavalla (11):  

 

𝑆 =  𝑆𝑖 +  𝑆𝑘 +  𝑆𝜏 +  𝑆𝑠  (11) 

 

missä, 

S Kokonaispainuma 

Si Alkupainuma 

Sk Konsolidaatiopainuma 

Sτ Sivusiirtymien aiheuttama painuma 

Ss Jälkipainuma, ts. sekundääripainuma 

KUVA 8. Plastinen painuma 

KUVA 9. Konsolidaatiopainuma 
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Näistä alkupainuma, konsolidaatiopainuma ja jälkipainuma ovat mitoituksessa yleisesti 

eriteltäviä painumalajeja. (Rantamäki, Jääskeläinen & Tammirinne 1986, 207; 

Liikennevirasto 10/2012,26).  

 

Alkupainuma käsittää kimmoisen muodonmuutoksen, mutta siihen sekoittuu myös 

muita painumisen lajeja. Alkupainuma tapahtuu yleensä nopeasti maapohjan tullessa 

kuormitetuksi ja ehtii muodostua jo rakennusaikana. Konsolidaatiopainuma, kuten 

edellä on kerrottu, johtuu maa-aineksen tiivistymisestä ja muodostaa suurimman osan 

maapohjan kokonaispainumasta. Karkearakeisessa maassa rakeet puristuvat toisiaan 

vasten jolloin huokostilan pienentyessä maasta poistuu ilmaa ja vettä. Hienorakeisessa 

maassa, kuten savessa, konsolidaatio tapahtuu hyvinkin hitaasti, mikä johtuu maa-

aineksen huonosta vedenläpäisevyydestä. Koska hienorakeisessa maaperässä huokoisuus 

ja vesipitoisuus ovat suhteellisen suuria, muodostuvat painumat hitaasti ja ovat sitä 

suurempia mitä vesipitoisempi maakerros on.  Jälkipainuma on konsolidaatiopainuman 

päätyttyä tapahtuvaa pientä vuodesta toiseen jatkuvaa painumaa. Tiepenkereiden 

painumamitoituksessa sivusiirtymien aiheuttaman painuman suuruus selvitetään, jos 

niillä on merkitystä tiepenkereen painumalle, päällysrakenteen kestävyydelle tai tien 

ympäristölle. Tavanomaisessa tapauksessa sivusiirtymien mahdollisuutta voidaan 

arvioida vakavuuslaskelmien yhteydessä. Tarkempi sivusiirtymien suuruus saadaan 

käyttämällä numeerisia FEM – laskentaohjelmia. (Rantamäki, Jääskeläinen & 

Tammirinne 1986, 145, 209, 210; Jääskeläinen 2011, 121,122; Liikennevirasto 10/2012, 

26,31).  

 

Maakerroksen konsolidoitumisaste saadaan selville painumakokeiden avulla, joista 

ödometrikoe on yleisin. Maanäytteistä selvitetään tarvittavia parametreja, jotka kuvaavat 

maakerroksen kokoonpuristuvuusominaisuuksia. Ödometri antaa näytteestä jännitys-

muodonmuutoskäyrän. Yleensä käyrästä on havaittavissa taitekohta, mitä ennen painuma 

on ollut pientä. Taitekohta paljastaa konsolidaatiojännityksen (σc), eli suurimman 

jännityksen missä maakerros on ollut, ts. konsolidoitunut.  Varsinainen 

konsolidaatiokokoonpuristuminen, eli painuminen alkaa, kun jännitys ylittää 

konsolidaatiojännityksen.  (Jääskeläinen 2011,126. Rantamäki, Jääskeläinen & 

Tammirinne 1986, 148).  
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Kun verrataan toisiinsa painovoiman maakerrokseen aiheuttamaa esikuormitusta (σvo) ja 

maanäytteen tutkimuksessa saatua konsolidaatiokuormitusta, voidaan määrittää 

maakerroksen konsolidoitumistila (Kuva 10): 

 

σc = σvo → maakerros on normaalikonsolidoitunut 

σc > σvo → maakerros on ylikonsolidoitunut 

σc < σvo → maakerros on alikonsolidoitunut 

 

Suomalaiset savet ovat yleensä normaalikonsolidoituneita, tai lievästi 

ylikonsolidoituneita. Normaalikonsolidoitunut maa on yleisintä. Ylikonsolidoitunutta 

maata voisi olla esim. jääkauden aikana kilometrejä paksun jääkerroksen puristama 

pohjamoreeni, jossa tarkisteluhetkellä vallitseva laskettu jännitys on pienempi. Maa on 

käytännössä harvoin alikonsolidoitunutta, mutta sitä voisi esiintyä esimerkiksi 

tilanteessa, missä täytemaakerroksen alla oleva maakerros ei ole ehtinyt painua 

painumaansa loppuun. 

(Rantamäki, Jääskeläinen & Tammirinne 1986, 156; Tielaitos 44/2000, 9).   

 

Painuman suuruus saadaan siis selville tulkitsemalla ödometrikokeesta saatua 

kokoonpuristuvuuskäyrää. Painuminen alkaa, kun maakerrokseen kohdistuva kuormitus 

ylittää konsolidaatiojännityksen. Sitä seuraa melko säännöllisesti käyrä kuvaajaosa, 

minkä tulkinta toimii pohjana painuman laskennalle. Eri laskentamenetelmät eroavatkin 

tämän käyrän tulkitsemisessa (Rantamäki, Jääskeläinen & Tammirinne 1986, 155,156).  

 

KUVA 10. Eri konsolidoitumistilat jännitys – muodonmuutos - käyrillä  
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Tangenttimoduulimenetelmää (ts. Ohde-Janbun menetelmää) käytetään Suomessa 

yleisesti painuman laskentaan. Menetelmä on tarkka, koska siinä laskenta seuraa 

kokoonpuristumakäyrän kaarevaa muotoa (Kuva 11).  

 

 

Kokoonpuristuvuusmoduuli (M) määritellään konsolidaatiojännityksen ja sen ylittäneen 

lisäjännityksen (Δσ) välisenä suorana riippuvuutena. Tangenttimoduuli (Mt) määritellään 

taas kokoonpuristuvuuskäyrän kaltevuuden jännityksen σ määräämässä pisteessä (Kuva 

11). Kaavana tangenttimoduuli voidaan ilmaista: 

 

𝑀𝑡 =
∆𝜎

∆𝜀
= 𝑚 ∙ 𝜎𝑣 ∙ ⌊

𝜎𝑐+∆𝜎

𝜎𝑣
⌋

1−𝛽

  (12) 

missä, 

m  moduuliluku 

β  moduulieksponentti tai jännityseksponentti 

σ  pystyjännitys 

σv  vertailujännitys 100 kN/m2 (vakio) 

 

Tangenttimoduuli voidaan siis korvata kokoonpuristuvuusparametreilla. Laskentaan 

tarvitaan siis moduuliluku (m) ja jännityseksponentti (β). Nämä määritellään myös 

ödometrikokeessa. Jännityksen kasvaessa alkuarvosta (σc) lisäjännityksen (Δσ) verran, 

saadaan muodonmuutokselle yhtälöt seuraaville tapauksille:  

 

KUVA 11. Tangenttimoduuli ja kokoonpuristuvuusmoduuli 
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Kun β ≠ 0, eli maapohja on normaalisti konsolidoitunut ja kaikki uudet kuormat ovat 

maapohjalle lisäkuormaa:  

 

𝜀 =
∆ℎ

ℎ
=  

1

𝑚𝛽
∙ [(

𝜎𝑐+∆𝜎

𝜎𝑣
)

𝛽

− (
𝜎𝑐

𝜎𝑣
)

𝛽

]  (13) 

 

Jos β = 0,5, voidaan kaavaa muuttaa yksinkertaisempaan muotoon:  

∆ℎ

ℎ
=  𝜀 =  

2

𝑚
∙ (√

𝜎𝑐+∆𝜎

𝜎𝑣
 − √(

𝜎𝑐

𝜎𝑣
))  (14) 

 

Jos β = 0, kuten yleensä savilla, saa kaava muodon:  

 

∆ℎ

ℎ
=  𝜀 =  

1

𝑚
∙ 𝑙𝑛

𝜎𝑐+∆𝜎

𝜎𝑐
   (15) 

 

 (Jääskeläinen 2011, 126,127,130; Liikennevirasto 44/200;10,11).  

 

Tangenttimoduulimenetelmän virheellinen käyttö antaa usein epärealistisen suuria 

laskettuja painumia. Usein laskentamenetelmän käytössä tehty virhe on, että 

moduulilukua ja jännityseksponenttia käytetään yleisinä parametreina huomioimatta 

miltä jännitysväliltä ne on määritetty. Laskennassa on tärkeää, että näitä parametreja 

käytetään yhdessä saatujen koetulosten perusteella. (Tielaitos 44/2000, 12).  

 

 

5.2 Konsolidaatiopuristumisen riippuvuus ajasta 

 

Johtuen mm. pehmeikköjen hitaasta konsolidoitumisesta, lasketaan teiden 

painumamitoituksessa rakenteen kokonaispainumien lisäksi rakenteen painuminen ajan 

funktiona. Mitoituksessa painuman vaikutus lasketaan tien pituus- ja poikkisuunnassa 

tien käyttöaikana. Tavanomaisissa tapauksissa tarkastelu tehdään ainakin viiden, 10 ja 50 

vuoden kohdalla tien käyttöönotosta (Liikennevirasto 10/2012, 23).  

 

Aika – painuma – kuvaajan saamiseksi tarvitaan muiden painumalaskennan lähtötietojen 

lisäksi konsolidaatiokerroin (cv), mikä saadaan ödometrikokeesta mittaamalla painuman 

etenemistä ajan funktiona lisäkuormituksen lisäyksen jälkeen.  
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5.3 Painumalaskennan lähtötiedot 

 

Painumalaskennassa tarvittavia lähtötietoja ovat:  

 

- Painuva rakenne, joka määrittelee sille sallittavat painumat ja kiertymiskulmat.  

- Ympäröivät rakenteet, jotka vaikuttavat esimerkiksi sallittaviin painumiin 

(tekniset järjestelmät ym. kiinteät rakenteet) 

- Maalajikerrokset, joissa kiinnitetään huomiota varsinkin paksuihin 

savikerroksiin, joilla painumat tapahtuvat hitaasti, mutta muodostuvat lopulta 

suhteellisen suuriksi.  

- Penkereet, rakenteiden perustusrakenteet sekä maapohjalle tehtävät täytöt, jotka 

aiheuttavat maapohjalle lisäkuormitusta ja aiheuttavat painumista.  

- Maanleikkaukset ja pintamaan poistot jotka on huomioitava laskettavissa 

kuormituksissa rasitusta vähentävinä tekijöinä (maapohja on konsolidoitunut 

leikkaussyvyydeltä lujemmaksi, kuin maan pinnalta).  

- Pohjaveden esiintyminen 

- Maakerrosten tilavuuspainot, γ [kN/m2], mitkä vaikuttavat konsolidaatioasteen 

arviointiin eri syvyyksillä. 

- Maakerrosten paksuudet, [m], mitkä vaikuttavat eri tilavuuspainoilla laskettaviin 

konsolidaatioasteiden arviointiin  

- Moduuliluku, m, määritetään ödometrikokeen tuloksesta ja kuvaa laskennassa 

tangenttimoduulia yhdessä jännityseksponentin kanssa. 

- Jännityseksponentti, β, määritetään ödometrikokeen tuloksesta ja käytetään 

yhdessä moduuliluvun kanssa.  

- Konsolidaatiokerroin, cv, mikä kuvaa maaperän painumista ajan funktiona ja 

tarvitaan aika – painuma – kuvaajaa laskiessa.  
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5.4 Eurokoodien mukainen mitoitus osavarmuusmenetelmällä 

 

Eurokoodien mukaista mitoittamista käytiin yleisesti jo läpi kappaleessa 3.4 Eurokoodien 

mukainen mitoitus osavarmuusmenetelmällä. Painumien varmuustarkastelu tehdään vain 

käyttörajatilassa. Itse painumien suuruuden määrittämiseen ei anneta erityisiä ohjeita, 

millä laskentateorioilla ne tulisi suorittaa vaan laskentaan tulisi käyttää yleisesti 

hyväksyttyjä menetelmiä.  

 

 

5.4.1 Käyttörajatila 

 

Käyttörajatilat liittyvät ihmisten mukavuuteen ja rakennuksen ulkonäköön tai 

rakennusosan toimintaan normaalissa käytössä. Geoteknisissä laskelmien kannalta 

merkittävämpiä käyttörajatilassa mitoitettavia asioita ovat kokonaisstabiliteetti ja 

painumat (SFS-EN 1990, 48).  

 

Käyttörajatilassa käytetään kuormien ja ominaisuuksien ominaisarvoja, ts. 

osavarmuuskertoimena käytetään arvoa 1,0. Laskentaan sisällytetään sekä pysyvät että 

muuttuvat kuormat, jos niiden vaikutusaika on riittävän pitkä muodonmuutosten 

syntymisen kannalta. Esimerkiksi penkereen tai anturan maapohjaan aiheuttama 

pohjapaine huomioidaan, muttei esimerkiksi liikennekuormaa (Liikennevirasto 35/2010, 

24).  

 

Käyttörajatilatarkastelussa tulee osoittaa, että kuormien vaikutusten mitoitusarvo (Ed) on 

enintään yhtä suuri kuin kestävyyden mitoitusarvo (Cd), kuten alla olevassa kaavassa (11) 

on esitetty.  

 

𝐶𝑑 ≥ 𝐸𝑑   (10) 

missä, 

Ed Kuormien vaikutusten mitoitusarvo 

Cd Kuormien vaikutusta rajoittava mitoitusarvo 

 

Esimerkiksi penkereiden tapauksessa merkittävä muodonmuutoksen raja-arvo on 

penkereen painuma (Jaakkonen 2013, 42).  
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Kuten aiemmin on todettu, painumaan vaikuttaa oleellisesti rakenteen alapuolisten 

maakerrosten ominaisuudet. Standardin SFS-EN 1997 – 1 mukaan pehmeille saville ja 

silteille perustettaessa tehdään aina painumalaskelmat. Painumalaskelmat sisältävät 

välittömän ja hitaasti tapahtuvan painuman (SFS-EN 1997-1, 60; RIL 207-2009, 111).  

 

Kokonaan tai osittain vedellä kyllästyneessä maassa kokonaispainuma (s) muodostuu 

kolmesta eri painumaosasta, mikä kirjataan standardin mukaan kuten alla olevassa 

kaavassa (16):  

 

𝑠 =  𝑠0 + 𝑠1 + 𝑠2  (16) 

 

missä,  

s kokonaispainuma 

s0 alkupainuma 

s1 viruman aiheuttama painuma 

 

(SFS-EN 1997-1,60)  

 

Painumien suuruus määritetään jollakin yleisesti hyväksytyllä laskentamenetelmällä, 

kuten tangenttimoduulilla.  

 

Painumien raja-arvot ts. sallittujen painumien suuruus määritellään kohteen kriteerien 

mukaisesti käyttäen esimerkiksi rakentamisen yleisiä laatuvaatimuksia, kuten InfraRYL 

2010 – julkaisua infrakohteissa, tai RIL:n julkaisuja.  
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6 PAINUMALASKENNAN LASKENTAESIMERKIT 

 

 

Laskentaesimerkeissä tarkastellaan penkereen painumaa pehmeiköllä sekä anturan 

painumaa hiekkamaalla. Painumien tarkastelut tehdään eurokoodien mukaisesti 

käyttörajatilassa. Penkere, jonka painumaa laskentaesimerkissä tarkastellaan on sama, 

mille tehtiin aiemmassa esimerkissä vakavuustarkastelu (Kuva 4).  

 

Alla olevassa kuvassa (12) on esitetty anturalle tehtävän painumamitoituksen 

lähtötilanne: 

 

 

 

 

 

 

KUVA 12. Tarkasteltava antura 
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6.1 Penkereen painuma pehmeiköllä  

 

Tiepenkereen vakavuus on tarkistettava ennen painumalaskelmien aloittamista. Jollei 

vakavuuslaskennoista saatava varmuus ole riittävä eurokoodin, sen kansallisen liitteen ja 

annettujen ohjeiden mukaan, ei ole tarkoituksenmukaista tarkastaa painumaa 

alkuperäisessä tilanteessa, kun perustamistoimenpiteitä tarvitaan joka tapauksessa. 

(Liikennevirasto 2/2014, 36).  

 

Painumalaskennassa selvitetään tyypillisesti ensin kokonaispainuma ja painumanopeus 

pohjaolosuhteiltaan heikoimmalta kohdalta. Tarvittaessa tarkastellaan erikseen 

sekundääri- eli jälkipainuman suuruus. Lasketun kokonaispainuman perusteella 

arvioidaan, ovatko painumat sallittujen arvojen rajoissa, vai joudutaanko miettimään 

esimerkiksi kevennerakenteita vähentämään painumien suuruutta. (Liikennevirasto 

2/2014, 36).  

 

Mitoituksessa lasketaan myös painuman kehittyminen penkereen käyttöaikana, ts. aika – 

painuma – kuvaaja. Tavanomaisissa kohteissa tarkastelu tehdään 5, 10 ja 50 vuoden 

kohdalla tien käyttöönotosta. (Liikennevirasto 10/2012, 23).  

 

 

6.1.1 Laskentamalli 

 

Laskentamalli muodostetaan, kuten vakavuuslaskentaa tehdessä, eli olemassa olevaan 

geometriaan ei kohdisteta varmuuksia, vaan laskentamallissa käytetään tunnettujen 

tietojen nimellisarvoja. Olemassa olevien rakenteiden osalta käytetään siis mittaustietoja 

ja uusien rakenteiden osalta suunnitelmiin ja pohjatutkimuksiin perustuvia mittoja. 

(Liikennevirasto, 35/2013, 24).  

 

 

6.1.2 Laskentateoria  

 

Eurokoodit eivät määrittele tarkemmin painumien suuruuden määrittämiseen käytettävää 

laskentamenetelmää. Laskentaan on kuitenkin käytettävä RIL:n julkaisujen ja 

Liikenneviraston ohjeiden mukaan yleisesti hyväksyttyä laskentamenetelmää. Tällaisia 
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TAULUKKO 5. Pohjanvahvistustarpeen arvioinnissa ja mitoituksessa 

käytettävät tienpinnan sallitut painumat, painumaerot ja sivukaltevuuden 

muutokset käyttötilassa (Liikennevirasto 10/2012, 24) 

ovat esimerkiksi aiemmin painumalaskennan teoriaosassa läpikäyty 

tangenttimoduulimenetelmä, ts. Ohde Janbun tangenttimoduulimenetelmä.  

 

6.1.3 Mitoituskriteerit 

 

Kokonaispainuman raja-arvot katsotaan toteutuvan Liikenneviraston ohjeen 10/2012 

mukaan, kun konsolidaatiosta riittävän suuri osa muodostuu rakennusaikana. 

Käyttöaikana tulisi ensimmäisten 10 vuoden aikana muodostuvien painumien olla alle 40 

%:a 50 vuoden kokonaispainumasta. (Liikennevirasto 10/2012, 24).  

 

Painumien suositellut raja-arvot on esitetty taulukossa 5. Tiepenkereen painuman raja-

arvoja määrittäessä, riippuu sallittavan kokonaispainuman suuruus tien vaatimusluokasta, 

joka määritetään tien toiminnallisen luokan ja keskimääräisen vuorokausiliikenteen 

(KVL) mukaan.  

 

Sallitun painuman suuruutta voidaan kasvattaa, jos rakennetaan paksulle, yli 20 metrisen 

savikerroksen päälle. Arvot koskevat kaikkia maanvaraisia rakenteita ja 

pohjanvahvistusmenetelmiä, kun toteutetaan Liikenneviraston kohteita. (Liikennevirasto 

10/2012, 26).  
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Penkereen aiheuttamaan painumaan voidaan vaikuttaa esim.  

 

- Vähentämällä maapohjaan kohdistuvaa kuormitusta esim. tiepenkereen 

tasausviivaa madaltamalla tai kevennerakenteilla 

- Vahvistamalla maapohjaa esim. syvästabiloinnilla 

- Nopeuttamalla painuman muodostumista esim. pystysalaojilla 

- Muodostaa painumat ennen varsinaista rakentamista ja käyttöä 

alkukuormituksella 

- Siirtämällä kuormitukset suoraan kovaan pohjaan esim. paaluilla 

 

 

6.2 Anturan painuma 

 

Painuma on huomattava mitoituskriteeri ja määrittelee usein kohteen perustamistavan. 

Maanvaraisia perustuksia tarkasteltaessa, määritetään niiden kelpoisuus 

kokonaispainuman, painumaerojen sekä kulmakiertymän avulla.  

 

 

6.2.1 Laskentamalli 

 

Laskentamalli muodostetaan tunnettujen mittojen nimellisarvojen ts. pohjatutkimuksien 

ja suunnitelmien mukaisesti ilman mitään osavarmuuksia. Laskentamallin 

muodostamisessa on kiinnitettävä huomiota erityisesti maakerroksien paksuuksiin ja 

suurimman kuormituksen vaikutuspisteeseen.   

 

 

6.2.2 Laskentateoria 

 

Painumien suuruus määritellään käyttäen kuormituksien ja tunnettujen maaparametrien 

ominaisarvoja. Laskentateoriana käytetään jotain yleisesti hyväksyttyä menetelmää, 

kuten Ohde-Janbun tangenttimoduulia.  
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6.2.3 Mitoituskriteerit 

 

Anturan sallittu kokonaispainuma, painumaero ja kulmakiertymä määritetään RIL:n 

julkaisun RIL 207-2009 mukaisesti.  Alla olevassa taulukossa (6) näkyy erilaisille 

rakenteille sallittuja arvoja. Taulukosta huomataan esimerkiksi, että puurakenteille 

sallitaan 100 mm kokonaispainuma muurattujen rakenteiden kokonaispainuman 

rajoittuessa 40 millimetriin (RIL 207-2009, 56).  

 

 

Anturan painumaa voidaan pienentää esim. 

 

- Pienentämällä kuormitusta esim. kevyemmällä rakenneratkaisulla (vrt. 

puurunkoa ja betonielementtiä) 

- Pienentämällä pohjapainetta esim. leventämällä anturaa 

- Vahvistamalla maapohjaa esim. massanvaihdolla 

- Siirtämällä kuormitukset suoraan kovaan pohjaan esim. paaluilla 

TAULUKKO 6. Perustusrakenteen sallitut painumat talonrakennuskohteessa 

(RIL 207-2009, 56) 
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7 SYVÄSTABILOINNIN LASKENTATEORIA 

 

 

Maapohjan vahvistamisella tarkoitetaan sen geoteknisten ominaisuuksien parantamista, 

joilla pyritään:  

- pienempiin painumiin 

- parempaan kantavuuteen 

- pienempään vedenläpäisevyyteen 

- tärinän pienentämiseen 

- juoksettumisvaaran pienentämiseen 

 

Maapohja koostuu maa-aineksesta, vedestä ja ilmasta (Kuva 13). Koska maarakeet 

itsessään ovat lujaa kiviainesta, vaikutetaan maan lujuuteen tehokkaimmin pienentämällä 

ilman ja veden tilavuusosuutta maa-aineksessa. Stabiloinnissa maahan sekoitetaan 

stabilointiainetta esim. kalkkia, minkä reaktio maa-aineksessa aiheuttaa leikkauslujuuden 

parantumista, kokoonpuristuvuuden pienentymistä ja vedenläpäisevyyden lisääntymistä. 

(RIL 157-2, 229).  

 

Syvästabilointi on siis menetelmä, missä maapohjaa lujitetaan sekoittamalla siihen 

sideainetta joko massastabilointia ja/tai pilaristabilointia käyttäen. Sideaineina käytetään 

mm. kalkkia, sementtiä, kipsiä, jauhettua masuunikuonaa lentotuhkaa ja muita 

teollisuuden sivutuotteita. Näistä eniten käytetään kalkin ja sementin yhdistelmää, jotka 

parantavat toistensa huonoja ominaisuuksia. Kalkki parantaa stabiloinnin 

sitkeysominaisuuksia, jatkaa lujittumista vielä käyttöaikana ja kompensoi hieman 

KUVA 13. Pohjanvahvistuksen vaikutus maa-

ainekseen 
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epätasaista sekoitustyötä hyvän diffundoituvuutensa, eli hajaantuvuutensa ansiota. 

Sementti parantaa taas stabiloinnin puristuslujuutta ja lujittuu hyvin myös 

humuspitoisissa savikerroksissa. Suomessa sideaineen syöttö tehdään lähes täysin 

kuivamenettelynä, jossa sideainetta puhalletaan sekoitinlaitteeseen paineilman avulla 

(Liikennevirasto 11/2010, 11, 12).  

 

Stabilointi auttaa maapohjan painumissa ja vakavuudessa ja sen käyttösovelluksia ovat 

esim. 

- maapohjan stabilointi penkererakenteelle 

- putkipohjan vahvistus nauhamaisena stabilointina 

- leikkauspohjan vahvistus työnaikaisesti 

- tärinähaittojen lieventäminen (tiet, rautatiet)  

(Forsman, Jyrävä, Lahtinen, Niemelin & Hyvönen 2014, 16).  

 

 

7.1 Pilarisyvästabiloinnin suunnittelu 

 

Pilaristabiloinnissa pilarointikoneen sekoitinkärki upotetaan suunniteltuun pilarin 

upotussyvyyteen ja vedettäessä kärkeä ylös aloitetaan sideaineen syöttäminen, että 

sekoittaminen maa-ainekseen (Kuva 14).  Pilarin halkaisija on usein väliltä 600 – 800 mm 

ja tehtävä maksimisyvyys 18 – 20 m (jopa 24 m). Suurilla syvyyksillä stabiloinnin käyttö 

on jo harvemmin taloudellista (Liikennevirasto 2/2014; 31).  

KUVA 14. Pilarisyvästabiloinnin periaate 



44 

 

Pilarit voidaan mitoittaa kimmoisina, myötäävinä tai määrämittaisina. Kimmoisan 

pilaroinnin käytössä optimoidaan pilareiden ja pohjamaan yhteistoimintaa. Pilareille 

tuleva kuormitus jää myötörajan alapuolelle (Kuva 17) ja pilarilujuudet jäävät 

maltillisiksi. Painumat jäävät pieniksi ja muodostuvat penkereen rakentamisen aikana. 

Kimmoista pilarointia käytetään eniten stabilointimenetelmistä penkereiden 

perustamiseen pehmeikölle. (Liikennevirasto 11/2010, 14).  

 

Myötäävässä pilarissa pilarin myötökuorma ylittyy, jolloin ylijäävän kuormituksen 

oletetaan siirtyvän maan kannettavaksi ja pilareiden kantavan jatkuvasti myötökuorman 

suuruisen jännityksen. Pilarit toimivat pystyojien tapaan nopeuttaen painuvan 

maakerroksen konsolidaatiota, jolloin painumat muodostuvat kuukausissa. Myötääviä 

pilareita käytetään vain hankekohtaisella päätöksellä. (Liikennevirasto 11/2010, 14).  

 

Määrämittainen pilari tehdään määräsyvyyteen asti ja alapuolelle jätetään painuvia 

kerroksia. Kovan pohjan sijainnin vaihtelu muodostaa riskin painumien epätasaiselle 

muodostumiselle. Käyttö rajoittuu lähinnä siltojen siirtymärakenteisiin pehmeikölle 

rakennettaessa. (Liikennevirasto 11/2010, 14,15).  

KUVA 16. Määrämittainen pilarointi 

KUVA 15. Kimmoinen ja myötäävä pilarointi tehdään kovaan pohjaan 
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Käsitellään yleisimmin käytetyn, kimmoisen pilaristabiloinnin mitoittamista 

Liikenneviraston julkaiseman ohjeen: Syvästabiloinnin suunnitteluohje 11/2010 mukaan. 

Novapoint GeoCalc:ssa on myös valittavissa ko. ohjeen mukainen laskenta. Läpikäytäviä 

vaiheita ovat:  

 

- Stabiloidun maan vakavuus 

- Stabiloidun maan painumamitoitus 

- Pilaritiheyden tarkistaminen 

- Pilarien keskinäinen sijoitus 

 

Jokaisessa stabiloinnille mitoitettavassa kohteessa tarkistetaan ensin maarakenteen 

vakavuus ennen stabilointia normaalisti liukupintatarkastelun avulla. Tarkastelu 

vaikuttaa siihen, kuinka pilareiden ja maan voidaan olettaa toimivan yhdessä. 

Laskennassa huomioidaan mahdolliset vastapenkereet, kevennysleikkaukset, 

pengerkevennykset ja massanvaihdot, pois lukien geovahvisteet (Liikennevirasto 

11/2010, 24).  

 

Pilarin leikkauslujuus on enintään 200 kPa ja pilarin ja maan tavoitteellinen lujuussuhde 

on korkeintaan 15. Sideaineena käytetään ominaisuuksiltaan tunnettua seosta, esim. 

kalkkisementtiä. Pilarin kantavuus varmistetaan määrittämällä pilarille tulevan 

ominaiskuorman suuruus myötökuorman suuruiseksi, kuitenkin enintään 70 % 

murtokuormasta. Murto- ja myötökuorman määrittämisessä huomioidaan ympäröivän 

maan antama sivutuki. Kimmoisan pilarin mitoitus perustuu siihen, ettei kuormituksen 

aiheuttama jännitys ylitä myötörajaa. Myötörajaolettamus perustuu materiaalikohtaiseen 

kuormitus-muodonmuutos-käyrään (Kuva 17), mikä saadaan kohteessa tehdyistä 

koepilaroinneista ja niihin tehdyistä kokeista (Liikennevirasto 11/2010, 29,30).  

KUVA 17. Kuormitus - muodonmuutos - 

käyrä 
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Vakavuus tarkistetaan normaaleilla liukupintalaskelmilla. Stabiloidun rakenteen 

vakavuustarkasteluissa huomioidaan pilareiden sijainti liukuympyrän keskipisteeseen 

nähden ja passiivipuolella olevat pilarit jätetään huomioimatta. Yksinkertaisin tarkastelu 

saadaan, ns. keskimääräiseen leikkauslujuuteen perustuvalla menetelmällä ja jättämällä 

liukuympyrän passiivipuolella olevien pilareiden vaikutus huomioimatta (Kuva 18).  

 

Maan keskimääräinen leikkauslujuus liukuympyrän aktiivipuolella (Kuva 18) 

keskipisteeseen nähden kaavalla (17) esitettynä: 

 

𝑠𝑢𝑎 = 𝑎 ∙ 𝜏𝑝𝑖𝑙 + (1 − 𝑎) ∙ 𝜇 ∙ 𝑠𝑢      (17) 

 

missä, 

sua  pilaroidun maan keskimääräinen leikkauslujuus aktiivipuolella 

a pilarisuhde (Kaava 18) 

τpil pilarin leikkauslujuus 

su pohjamaan leikkauslujuus 

μ redusointikerroin (Kuva 19) 

KUVA 18. Vakavuustarkastelun periaate pilaristabiloidussa 

maapohjassa 
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Pilarien suhteellinen pinta-ala (Kaava 18):  

 

𝑎 =  
𝐴𝑝

𝐴𝑝+𝐴𝑚
                        (18) 

 

missä, 

a pilarien suhteellinen pinta-ala 

Ap pilarin pinta-ala 

Am maan pinta-ala (Kuva 20) 

 

KUVA 20. Pilarien ja maan pinta-alan määräytyminen 

sekä keskeltä-keskelle-mitta 

KUVA 19. Redusointikertoimen riippuvuus pilarin ja pohjamaan 

leikkauslujuuksien suhteesta 
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Maan leikkauslujuus pilaroimattomalla alueella ja vyöhykkeen passiivipuolella kaavana 

(19):  

 

𝑠𝑢𝑝 = 𝜇 ∙ 𝑠𝑢                        (19) 

 

missä, 

sup maan leikkauslujuus pilaroimattomalla alueella ja passiivipuolella 

su pohjamaan suljettu leikkauslujuus 

μ redusointikerroin (Kuva 19) 

 

Painumamitoitus tulee pilaristabiloinnin mitoituksessa pääsääntöisesti määrääviksi. 

Painumamitoituksessa maan ja pilarin oletetaan painuvan yhtä paljon (ns. yhtä suuren 

painuman periaate). Hyvänä lähtökohtana voidaan olettaa kokonaiskuormista 90 % 

menevän pilareille ja 10 % maa-aineelle.  

 

 

Pilarien painuma voidaan laskea kaavalla (20):  

 

𝑠𝑝𝑖𝑙 =
∆ℎ∙𝑞𝑝𝑖𝑙

𝑎∙𝐸𝑝𝑖𝑙
    (20) 

 

missä, 

Δh pilarin pituus 

spil pilarille siirtyvän kuormaosuuden aiheuttama painuma 

qpil pilareille tuleva osa kokonaiskuormasta q0 (ei liikennekuormaa) 

a pilarien suhteellinen pinta-ala (Kaava 18) 

Epil pilarien muodonmuutosmoduuli 

 

Pilarien muodonmuutosmoduuli kaavana (21): 

 

𝐸𝑝𝑖𝑙 = 20 ∙ 𝑐𝑘𝑟𝑖𝑡
1,6

  (21) 
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missä, 

Epil pilarien muodonmuutosmoduuli 

ckrit pilarien kriittinen leikkausjännitys, eli myötörajaa vastaava 

leikkausjännitys (70 % pilarin leikkauslujuudesta) 

 

Pilarin muodonmuutosmoduulina voidaan käyttää kalkkisementtipilareilla 100 – 200 - 

kertaista ja kalkkipilareilla 50 – 150 – kertaista arvoa pilarin leikkauslujuuteen nähden 

(Viljanen 2010, 18). 

 

Maan painuma tehtäisiin erikseen laskettuna normaalisti tangenttimoduulia tms. yleisesti 

hyväksyttyä laskentamenetelmää käyttäen. Koska maan ja pilarin oletetaan painuvan yhtä 

paljon, voidaan maalle siirtyvä kuormitus laskea kaavalla (22):  

 

𝑞𝑚𝑎𝑎 = (
(1−𝑎)∙𝑀

𝑎∙𝐸𝑝𝑖𝑙+(1−𝑎)∙𝑀
) ∙ 𝑞0      (22) 

 

Tarkistetaan pilarijännityksen suhde pilarin myötörajaan. Kaavalla 23 lasketaan pilarille 

tuleva kuormitus tällä kertaa myös muuttuva kuorma huomioiden: 

 

𝜎𝑝𝑖𝑙 =
𝑞0−𝑞𝑚𝑎𝑎

𝑎
+

𝑞𝑙𝑖𝑖𝑘

𝑎
       (23) 

 

 

missä, 

σpil pilarille tuleva puristusjännitys (tarkastelusyvyys penkereen ja maanpinnan 

rajapinta) 

qliik tasainen muuttuva kuorma (liikennekuorma 10 kN) 

 

Edellä laskettu pilarin puristusjännitys (σpil) edustaa maksimiarvoa. Jos penkereen 

alapuolella on kuivakuori, siirtyy kuormitus maanpinnassa pääosin maapohjalle, ja 

pilarijännityksen voidaan olettaa olevan maksimissaan kuivakuoren alapinnassa, jota 

käytetään tarkastelusyvyytenä.  

 

Jos pilareiden ja penkereen välissä käytetään jotain lujitusta, on tarkastelusyvyys valittava 

kussakin tapauksessa erillisen tarkastelun perusteella, koska lujitteet tehostavat 

kuormituksen keskittymistä pilareille.  
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Lasketaan kaavalla 24 pilarin puristuskapasiteetti: 

 

𝜎𝑚𝑢𝑟𝑡𝑜 = 2 ∙ 𝜏𝑝𝑖𝑙 + 𝑘ℎ ∙ 𝜎ℎ  (24) 

 

missä, 

σmurto pilarin puristuskapasiteetti 

τpil pilarin leikkauslujuus 

kh horisontaalijännityksen kerroin (= 1) 

σh pilareihin vaikuttava maan tehokas horisontaalijännitys 

 

Huomataan, että pilarin puristuskapasiteetti muodostuu sen omasta leikkauslujuudesta ja 

maaperän antamasta sivutuesta (σh). Sivutuen suuruus riippuu luonnollisesti 

tarkastelusyvyydestä, joka määritellään penkereen alapuolisen rakenteen mukaan. Jos 

penkereen alapuolella on kuivakuori, pyrkii kuormitus keskittymään maalle ja 

tarkastelusyvyys valitaan kuivakuoren alapinnan tasolle. Jos taas penkereen ja pilareiden 

välillä käytetään lujitteita, esim. geovahvisteita, pyrkii kuormitus keskittymään pilareille. 

Tällöin tarkastelusyvyys valitaan erillisen tarkastelun perusteella.  

 

Lasketaan kaavalla 25 pilareille maalta tuleva tuki: 

 

𝜎′ℎ = 𝜎′𝑣 +
∆𝜎′

2
       (25) 

 

missä, 

σ’v maassa vallitseva konsolidaatiojännitys tarkastelusyvyydellä  

Δσ’ kuormituslisäys (ilman muuttuvaa kuormaa) 

 

Verrataan pilarille tulevaa puristusjännitystä (σpil) pilarin myötörajaan: 

 

𝜎𝑝𝑖𝑙 ≤ 𝜎𝑚𝑦ö𝑡ö ≤ 0,7 ∙ 𝜎𝑚𝑢𝑟𝑡𝑜      (26) 

 

Pilarien k/k-väli (Kuva 20) on yleensä vähintään pilarin halkaisija + 0,2 m.  

 

Pilaritiheyden riittävyyden tarkastelua tarvitaan, jos k/k-mitta on enemmän kuin 

pilarinhalkaisija + 0,7 metriä tai suurempi kuin pengerkorkeus. Jos penkereen alla on 
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kuivakuorikerros (su ≥ 30 kN/m2), voidaan k/k-mittaa kasvattaa 0,1 metriä jokaista 

kuivakuorikerroksen 0,5 metrin paksuutta kohti (kuitenkin enintään 0,3 m). Liian suuri 

pilariväli aiheuttaa sen, ettei pilarin ja maan tasaisen painumisen periaate toteudu, vaan 

maa voi painua pilareita enemmän, mikä heijastuu penkereen pintaan (Liikennevirasto 

11/2010, 34).  

 

Pilareiden sijoittelu voidaan yleensä tehdä yksinkertaiseen neliöverkkoon. Pieni parannus 

erityisen harvoilla pilariväleillä saadaan aloittamalla joka toinen rivi ns. 

puolivälipisteestä. Pilarit voidaan sijoitella myös kolmioverkkoon, mikä on em. 

verrattuna tehokkain, mutta harvoin tarpeen (Kuva 21).  

 

KUVA 21. Pilareiden keskinäisiä sijoittelutapoja 

 

 

7.2 Massasyvästabiloinnin suunnittelu 

 

Massastabilointi tehdään kaivinkoneella, johon on liitetty sekoitinyksikkö ja painesyötin. 

Painesyötin syöttää kuivaa sideainetta, joka sekoitetaan stabiloitavaan maamassaan 

sekoitinyksikön kärjellä. Sekoitus tapahtuu kärjessä pyörivien rumpujen avulla 

samanaikaisesti liikuttamalla sekoitinkärkeä käsiteltävässä kerroksessa pysty- ja 

vaakasuunnassa (Kuva 22). Tavoitteena on muodostaa yhtenäinen, mahdollisimman 

tasaisesti stabiloitu ”blokki”. Koneen ulottuvuus määrää pitkälti stabiloinnin 

maksimisyvyyden. Optimina pidetään 3 – 5 metriä, mutta hyvissä olosuhteissa voidaan 

ulottua 7 - 8 metriin. Syvempää massastabilointia voidaan tehdä pilaristabiloinnilla 

leikkaamalla pilareita toisillaan (Forsman, Jyrävä, Lahtinen, Niemelin, Hyvönen 2014, 

8,9).  
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Massasyvästabilointi on pehmeiden maa-aineiden lujitusmenetelmä ja käytetään usein 

maalajeissa, joiden stabiloitavuus on liian huono pilaristabiloinnille, esim. turpeessa. 

Menetelmää voidaan käyttää myös yhdessä pilaristabiloinnin kanssa (Kuva 23).  

 

Massasyvästabiloidun rakenteen vakavuus voidaan määrittää ympyräliukupintojen avulla. 

Jos stabiloitavan kerroksen alapuolelle jää heikko tai vino stabiloimaton kerros, 

suositellaan vapaamuotoisten liukupintojen käyttöä. Jos stabilointi rajoitetaan 

kitkamaahan, on arvioitava, saadaanko stabilointi ulotettua riittävästi kitkamaahan, vai 

jääkö välille heikkousvyöhyke. (Liikennevirasto 11/2010, 48).  

 

Massasyvästabiloidun kerroksen painuma muodostuu alku- ja lopputiivistyksestä. 

Alkutiivistys tehdään kuormittamalla pengertä n. 0,5 - 1 m korkealla esitiivistyspenkereellä 

KUVA 22. Massasyvästabiloinnin periaate 

KUVA 23. Massa- ja pilarisyvästabiloinnin yhteiskäyttöperiaate 
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tai joissain tapauksissa tela-alustaisella kaivinkoneella yliajaen. Massasyvästabiloinnin 

lujittuessa riittävästi rakennetaan varsinainen penger tiivistyspenkereen päälle. 

Stabiloinnin painuma määritetään pilaristabiloinnin painumaa vastaavalla tavalla, mutta 

sen tarkempi läpikäyminen ei ole tarkoituksenmukaista tässä opinnäytetyössä vaan 

keskitytään yleisimpään kimmoisen pilaristabiloinnin käsittelyyn. (Liikennevirasto 

11/2010, 49). 

 

7.3 Syvästabiloinnin laskennan lähtötiedot 

 

- Maalajikerrokset, jotka määrittelevät esimerkiksi stabiloitavan syvyyden. 

Kiinnitetään huomiota erityisesti mahdolliseen kuivakuoreen, joka jakaa 

kuormituksia tehokkaasti maapohjaan. 

- Penkereet ym. rakenteet jotka aiheuttavat maapohjaan kuormituksia  

- Pohjaveden esiintyminen 

- Maakerrosten tilavuuspainot, γ [kN/m2], mitkä vaikuttavat konsolidaatioasteen 

arviointiin eri syvyyksillä. 

- Maakerrosten leikkauslujuudet, su [kN/m2] 

- Stabiloidun maa-aineksen leikkauslujuus τpil 

- Stabiloidun maa-aineksen kimmokerroin, Epil 

- Eri maakerroksissa vallitsevat konsolidaatioasteet  

- Moduuliluku, m, määritetään ödometrikokeen tuloksesta ja kuvaa laskennassa 

tangenttimoduulia yhdessä jännityseksponentin kanssa. 

- Jännityseksponentti, β, määritetään ödometrikokeen tuloksesta ja käytetään 

yhdessä moduuliluvun kanssa.  

- Konsolidaatiokerroin, cv, mikä kuvaa maaperän painumista ajan funktiona ja 

tarvitaan aika – painuma – kuvaajaa laskiessa.  

 

 

7.4 Eurokoodin mukainen mitoitus 

 

Pilarin oletetaan toimivan pohjanvahvistuksena yhteistoiminnassa maan kanssa, jos 

suunniteltaessa:  

- Pilarin leikkauslujuuden ominaisarvo on enintään 200 kN/m2 

- Maan ja pilarin leikkauslujuuksien suhde on enintään 15 

ja valmiina 
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- Pilarin leikkauslujuuden ominaisarvo on enintään 300 kN/m2 

- Maan ja pilarin leikkauslujuuksien suhde on enintään 20 

(Liikennevirasto 35/2013, 73).  

 

Jolleivat em. ehdot toteudu, tarkastellaan pilaria itsenäisenä rakenteena ja arvioidaan 

yksittäisen pilarin kestävyyttä murtorajatilassa DA2 – menetelmän mukaisesti. Kuorman 

mitoitusarvo määräytyy tällöin samoin kuin paaluille ja pilareille. (Liikennevirasto 

35/2010, 73).  

 

 

7.4.1 Murtorajatila 

 

Syvästabiloinnin vakavuutta tarkastellaan kuten stabiloimattoman maapohjan vakavuutta 

murtorajatilassa DA3 – menetelmällä, jolloin osavarmuuskertoimet kohdistetaan heti 

laskennan alussa muuttuviin kuormiin ja maaparametreihin. (Liikennevirasto 35/2013, 

68).  

 

 

7.4.2 Käyttörajatila 

 

Syvästabiloinnin painumatarkastelu tehdään käyttörajatilassa kuten stabiloimattoman 

maapohjan painumia tarkasteltaessa. Näin ollen kuormituksien ja maaparametrien 

osavarmuuskertoimena käytetään arvoa 1,0. Painumamitoituksessa huomioidaan vain 

pysyvät kuormat, kuten esimerkiksi penkereen aiheuttama pohjapaine.  Mitoitus etenee, 

kuten aiemmin kappaleessa 7.1 Syvästabiloinnin suunnittelu on esitetty. (Viljanen 2010, 

18). 

 

Stabilointia käytetään yleensä pohjanvahvistuksena, kun maapohjan luontainen vakavuus 

ei riitä tai painumat muodostuvat sallittuja suuremmaksi. Jollei stabilointi riitä, tai sen 

kustannukset muodostuvat liian suuriksi, voidaan vaihtoehtoisina menetelminä käyttää 

esim.  

 

- Maapohjalle muodostuvan kuormituksen pienentämistä esim. kevennerakenteilla 

- Maapohjan vahvistamista esim. massanvaihdolla 

- Siirtämällä kuormitukset kovaan pohjaan esim. paaluilla 
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8 SYVÄSTABILOINNIN LASKENTAESIMERKKI 

 

 

Laskentaesimerkissä tarkastellaan homogeeniselle savikolle perustettua pengertä, jonka 

pohjamaata joudutaan vahvistamaan pilaristabiloimalla. Tarkasteltava tilanne on esitetty 

alla olevassa kuvassa (24):  

 

 

8.1 Pilarisyvästabilointi 

 

Laskentaesimerkissä pilaristabilointi toteutetaan kimmoisina pilareina, jolloin mitoitus 

alkaa painumamitoituksella. Kimmoisen pilaroinnin mitoitusta käsin laskettuna on 

käsitelty tässä opinnäytetyössä aiemmin (Kappale 7.1). (Viljanen 2010, 18).  

 

 

8.1.1 Laskentamalli 

 

Laskentamallin geometria muodostetaan olemassa olevien mittatietojen ja 

pohjatutkimuksien perusteella kohdistamatta niihin mitään varmuuskertoimia. Tärkeää 

on esimerkiksi kovan pohjan syvyyden tai kuivakuorikerroksen määrittäminen, jotta 

pilarointisyvyys voidaan määrittää. Lisäksi kuivakuorikerros jakaa kuormia tehokkaasti 

pilareiden välillä, minkä takia pilariväliä voidaan kasvattaa. (Liikennevirasto 11/2010, 

34). 

 

KUVA 24. Laskentaesimerkissä tarkasteltava tilanne pilaristabiloinnista 
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8.1.2 Laskentateoria  

 

Pilarisyvästabiloinnin laskentateoriaa on käyty aiemmin läpi syvästabiloinnin teorian 

yhteydessä Liikenneviraston syvästabiloinnin suunnitteluohjeiden mukaisesti (kappale 

7.1 Pilarisyvästabiloinnin suunnittelu). GeoCalc – ohjelmassa syvästabilointi voidaan 

suorittaa käyttäen joko Liikenneviraston tai KPO 2000 – ohjetta. KPO 2000 eli 

Kalkkipilariohje on Espoon kaupungin syvästabiloinnin mitoitusohjelma ja poikkeaa 

joissain määrin Liikenneviraston ohjeistuksesta. (SCC Viatek Oy, Espoon kaupungin 

koulutusesitys, 2002). 

 

 

8.1.3 Mitoituskriteerit 

 

Pilaristabiloidun maapohjan kokonaisvarmuuden ODF on oltava murtorajatilassa 

mitoitettuna vähintään arvoltaan 1,0.  

 

Vastaavasti sallitut painumat määritetään kuten stabiloimattomalle maapohjalle 

perustetun penkereen painumat rakennuskohteesta riippuen esimerkiksi Liikenneviraston 

tai Ratahallinnon ohjeiden mukaisesti. Liikenneviraston ohjeistamia tien sallittuja 

painuma-arvoja löytyy esimerkiksi taulukosta 5. (Liikennevirasto 35/2013, 73).  
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9 POHDINTA 

 

 

Vakavuus- ja painumalaskenta ovat kaikissa pohjarakenteissa vastaan tulevia 

perusominaisuuksia, jotka vaikuttavat keskeisesti rakennetun lopputuotteen säilyvyyteen 

ja käytettävyyteen. Siksi niiden hallinta on keskeistä maa- ja pohjarakenteita 

suunnittelevalle.  

 

GeoCalc – ohjelmiston vakavuus- ja painumalaskentamoduulit ovat selkeitä ja 

johdonmukaisia käyttää. Suurimman haasteen ohjelman käyttöä opettelevalle tuottaakin 

todennäköisesti täytettävien parametrien ymmärtäminen ja laskentateorian 

valintaperusteet. Syvästabiloinnin laskentamoduuli on jäänyt käytettävyydeltään vielä 

kankeaksi, mutta paranee toivottavasti ohjelman jälleen kehittyessä. 

 

Tämän opinnäytetyön tavoitteena oli helpottaa ohjelmaan tutustumista kertomalla 

teoriaosassa vakavuus-, painuma- ja syvästabilointilaskennan teoreettisia taustoja sekä 

muodostamalla yksityiskohtaiset ohjeet em. laskelmien suorittamisesta GeoCalc - 

ohjelmalla. Tavoitteen toteutumisesta voidaan sanoa, että laskelmien teoriaosa muodostui 

pitkäksi, eikä riittänyt todennäköisesti kuin laskentojen pintapuoliseen tarkasteluun. 

Toisaalta tehdyt laskentaesimerkit ovat monipuolisia ja käsittelevät melko kattavasti 

GeoCalc – ohjelmiston ehkä keskeisimpien laskentamoduulien käyttöä. Syvästabilointia 

työssä käsiteltiin vain yleisimmin käytetyn, kimmoisan pilaristabiloinnin osalta.  

 

Geotekniset laskelmat vaativat tarkasteluja useasta eri tarkastelupisteestä ja mahdollisesti 

erilaisilla pohjaveden pinnan korkeustiedoilla, kuormituksilla jne. mikä teettää lukuisia 

eri tarkasteluja laskijalla. Koska eri laskentoja voidaan GeoCalc – ohjelmassa suorittaa 

samalle laskentamallille ja samassa laskentamoduulissa saadaan muutettua laskenta-

asetuksia, auttaa ohjelma näiden lukuisten eri tarkastelujen tekemisessä ja näin ollen 

tehostaa laskijan työtä oleellisesti.  
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LIITTEET       

Liite 1. Ohjelmiston perustoiminnot 

 

Ohjelmisto avataan Windows käynnistysvalikosta, jonka jälkeen se mahdollisesti 

varmistaa käyttäjän lisenssin avaamalla alla olevan kuvan näköisen ikkunan. 

 

 

 Oppilaitoskäytössä valitaan yleensä alempi vaihtoehto. Ohjelma on voitu asentaa myös 

niin, ettei lisenssin varmistusta kysytä. Ohjelman käyttökielenä on englanti, mutta 

viemällä hiiren eri komentojen kohdalle, tulee esiin komentojen suomenkieliset selitteet.  

 

Ohjelman käynnistyessä se avaa työalueen ja Startup – ikkunan, mistä on mahdollista 

palata johonkin edellisistä laskennoista, asettaa työtila tai aloittaa kokonaan uusi laskenta. 

Kaikki toiminnot saa myöhemminkin auki ja Startup – ikkunan voi myös sulkea tekemättä 

mitään valintoja.  
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GeoCalc koostuu laskentamoduuleista, jotka toimivat yhteisen piirtoalustan päällä. 

Ohjelmassa muodostetaan ensin laskentamalli työalueelle, joko tuomalla esim. valmis 

dwg- tiedosto, tai piirtämällä malli itse. Tämän jälkeen mallille voidaan tehdä eri 

tarkasteluja laskentamoduulien avulla.  

 

Ohjelmiston perustoiminnot sijaitsevat ikkunan ylä- ja alarivistöllä. Ylärivillä löytyvät eri 

valikot toimintoineen:  

  

Työkalupaletit (engl. toolbar) ovat työalueelle asetettuja toimintokuvakkeita valikoista 

löytyville toiminnoille ja tekevät toimintojen valinnasta helpompaa ja nopeampaa. 

Työkalupaletteja voi poistaa ja lisätä näkyvistä Näytä (engl. View) -välilehdellä. Alla 

olevassa kuvassa on esimerkiksi eri piirtotyökaluja sisältävä työkalupaletti. 
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Tartuntatyökalut sijaitsevat työalueen alareunassa ja valitaan päälle/ pois päältä 

klikkaamalla. Osnap – tartunnasta avautuu tarkempi valintaikkuna, mistä voidaan 

määrittää osoittimen tartuntatapa. Tartuntatyökalupaletin edessä näkyy aina osoittimen 

sijainti koordinaatteina (järjestyksessä: x, y, z).  

 

Komentoriville kirjoitetaan esimerkiksi eri komentoihin liittyen koordinaatteja. Rivin 

edessä näkyy myös aina ohjeet, mitä kuvasta pitää esimerkiksi määrittää.  

 

 

Ohjelmistossa on laskentamoduulit stabiliteetin eli vakavuuden, painuman, stabiloinnin, 

tukiseinien ja paalujen mitoitukseen.  Eri laskentamoduulit toimivat itsenäisesti ja 

käyttävät laskentamallia pohjanaan. Laskenta suoritetaan moduuleissa etenemällä 

välilehdillä vasemmalta oikealle ja täyttämällä tarvittavia parametreja välilehtien ja 

moduulin ylävalikon toimintojen avulla.  

 

 

 

 

 



63 

 

Alla olevassa kuvassa on esimerkki stabiliteetin laskentamoduulista: 

 

Tässä työssä käsitellään vain stabiliteetti-, painuma- ja syvästabilointimoduulien käyttöä. 

Eri laskentamoduulien käyttöä käydään läpi tarkemmin tämän työn liitteiden 

laskentaesimerkeissä 2– 5.  

 

Yleisesti laskentamoduuleissa edetään oikealta vasemmalle. Tietojen täyttäminen 

aloitetaan laskennan yleisten tietojen täyttämisellä ja päättyy laskenta-sivulle, jossa 

varsinainen laskenta käynnistetään. Laskennan valmistuessa avautuvat Graph- ja Report 

– välilehdet, joista näkee laskennan tulokset graafisina käyrinä, tai kirjallisena raporttina.   
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Liite 2. Vakavuuslaskenta: Penkereen vakavuus 

2.1 Lähtötiedot 

 

Tässä laskentaesimerkissä käydään läpi vakavuuslaskennan suorittamista pehmeikölle 

rakennetulle penkereelle. Lähtötiedot on annettu alla olevassa kuvassa. Tehtävänä on 

tehdä tarkastelu  

a) Kokonaisvarmuuslukumenettelyllä 

b) Osavarmuuslukumenettelyllä  

 

Aloitetaan laskenta kokonaisvarmuuslukumenettelyllä, jotta saadaan ensimmäisenä 

varmuutta stabiliteetin suuruusluokasta pelkkien ominaisarvojen perusteella.  

 

Laskentaesimerkin lopussa tehdään johtopäätökset saaduista tarkasteluista ja käydään 

läpi tulosten tulostaminen.  

 

- Pohjavedenpinta sijaitsee savikerroksen yläpinnassa 

- Liikennekuorma 10 kN/m2 
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2.2 Käynnistäminen 

 

Käynnistetään Novapoint GeoCalc – ohjelma ja tehdään mahdollinen lisenssinvahvistus. 

Oppilaitoksissa valitaan yleensä vaihtoehto Novapoint 16 licensing. 

 

Valitaan GeoCalc Startup – ikkunasta New Calculation → Stability (suom. Uusi 

stabiliteettilaskenta). Ohjelma avaa Stability – laskentamoduulin, minkä voi pienentää 

ikkunan oikeasta yläkulmasta. Vaihtoehtoisesti Startup – ikkunan voi sulkea ja valita 

laskentamoduulin myöhemmin ylävalikosta Calculation → Stability... 

 

Aloitetaan laskenta käymällä läpi ensin piirtoasetukset, joissa määritellään koordinaatti- 

ja piirtoruudukko, sekä tartuntapisteiden ja piirtoverkon pisteiden välit.  

 

2.3 Koordinaattiruudukko 

 

Ensimmäiseksi määritellään piirtoalueelle koordinaattiruudukko valitsemalla 

Calculation → Set working area.  

 

Placement – kohdasta määritetään koordinaattiruudukon vasen alakulma. Valitaan Pick 

Point ja kirjoitetaan alkutilanteen kuvan mukaisesti -35, 85, 0 (x, y, z). Vaihtoehtoisesti 

voidaan em. koordinaatit kirjoittaa suoraan Placement → Lower left corner 

coordinates – kohtaan.  

 

Grid – kohdasta määritetään koordinaattiruudukon koko ja väri.  
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Text – kohdasta määritetään tekstin tyyli, koko ja väri.  

 

Piirrettyä koordinaattiruudukkoa voidaan tarvittaessa muokata Set working area – 

ikkunasta ja tarvittaessa poistettua painamalla Remove – painiketta.  

 

Valitaan tässä harjoituksessa yllä olevan kuvan mukaiset arvot. Kun arvot on muutettu, 

painetaan Draw ja poistutaan ikkunasta painamalla Close. Työalueelle tulisi ilmestyä alla 

olevan kuvan mukainen ruudukko.  

 

 

2.4 Piirtoasetukset 

 

Seuraavaksi muokataan käytettävien tartuntapisteiden ja piirtoverkon pisteiden välit, 

valitsemalla grafiikkaikkunan ylävalikosta Tools → Options.  
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Options – näkymässä määritellään tartuntapisteiden välit (Snap) ja piirtoverkon välit 

(Grid). Näihin kannattaa asettaa samat arvot, esim. 0,5 tai 1, riippuen millä tarkkuudella 

osoittimen tartuntavälit halutaan.  

 

Modify grid limits – kohdassa määritellään piirtoverkon koko. Piirtoverkko kannattaa 

yleensä asettaa saman kokoiseksi, kuin aiemmin määritetty koordinaattiruudukko. 

Tällöin piirtoverkon koko annetaan kirjoittamalla alapalkissa olevalle komentoriville 

ensin vasemman alakulman koordinaatit (-35, 85, 0) → Enter → Oikean yläkulman 

koordinaatit (15, 105, 0) → Enter.  

 

Vaihtoehtoisesti piirtoruudukko voidaan antaa klikkaamalla koordinaattiruudukon 

kulmia tartuntatyökalujen Osnap -komento päällä. Jotta muutokset tulevat voimaan 

painetaan näkymästä Apply ja poistutaan painamalla Ok.  

 

Näkymän ei tulisi muuttua tämän jälkeen.  

 

Äsken määritellyt tartuntavälit (Snap) ja piirtoverkon välit (Grid) saadaan voimaan 

piirtotilassa klikkaamalla tartuntatyökalujen Snap- ja Grid – toiminnot aktiivisiksi.  

 

 

 

 

 

 

Snap – ja Grid – toimintojen käyttö voi joissakin laskennan vaiheissa vaikeuttaa 

haluttujen pisteiden valintaa, koska tartunnat tehdään äsken Options – ikkunaan 

asetetuilla tarkkuuksilla.  

 

Tämän vuoksi voi tartuntatyökaluista Osnap – tartunnan käyttö olla kätevämpää. 

Kun Osnap valitaan aktiiviseksi, avaa ohjelma erillisen ikkunan, mistä voidaan 

valita halutut tartuntapisteet (esim. kohta endpoint hakee tartunnan viivojen 

päätepisteistä).  
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2.5 Laskentamallin piirtäminen 

 

Piirtoasetuksien määrittämisen jälkeen voidaan tehdä laskentamalli tarkasteltavasta 

tilanteesta. GeoCalc:ssa piirretyt laskentamallit tallennetaan erikseen omaksi 

tiedostokseen (tiedostomuodo *.vdf) ja varsinainen laskenta suoritetaan laskentamallin 

”päällä”. Samalle laskentamallille voidaan tehdä siis useampi tarkastelu, eikä sitä 

välttämättä tarvitse luoda aina erikseen.  

 

Piirretään alla olevan esimerkkikuvan mukaiset maakerrokset koordinaattipisteiden 

avulla.  

 

 

Valitaan työkalupaletista Polyline – komento →, tai valikosta Draw → Polyline.  

 

Viiva voidaan piirtää valitsemalla sijaintipisteet suoraan koordinaattiruudukosta 

osoittimella, tai kirjaamalla sijaintipisteet komentoriville esim. -35, 85 → Enter → -20, 

86 → Enter… jne. Viiva päätetään painamalla näppäimistöltä Enter tai Esc –painiketta. 

Toiminto aloitetaan uudelleen jokaisen viivan päätyttyä. 

Jos Polyline – komentoa ei löydy suoraan valintaikkunan työkalurivistä, voidaan 

Draw – toolbar asettaa näkyville valitsemalla View → Toolbars → Draw.  

 

Laskentamallin toimimisen kannalta on sen piirtämisessä tärkeää, että 

- Mallin viivat esim. maakerrosrajat ovat piirretty polyline –komennolla. 

Ohjelma ei tunnista muita viivoja. 

- Mallin viivat piirretään vasemmalta oikealle 

- Mallin viivat eivät saa mennä ristiin. Viivat voivat olla päällekkäin.  
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Maakerrosten tulisi valmiina näyttää seuraavalta:  

 

Luiskaa piirtäessä voi olla helpompaa määritellä seuraavan pisteen sijainti edelliseen 

sijaintipisteeseen nähden. Tartuntatyökaluista kannattaa ainakin Osnap → Nearest pitää 

aktiivisena. Aloitetaan valitsemalla aloituspiste komennolla Polyline → Valitse kohta 

ojan vierestä ylimmältä viivalta. Jatketaan antamalla komentoriville käsky painamalla Alt 

Gr + @ → 7.5, 5 (luiskan vaakamitta, pystymitta). Penger on 2 % sivukaltevuudella, 

joten seuraava piste merkitään alla olevan kuvan mukaisesti: 

Huomaa, että koordinaatteja syöttäessä x-, y- ja z-koordinaatit erotetaan toisistaan 

pilkulla (esim. 0, 0, 0) ja koordinaattien desimaalit pisteellä (esim. 0, 1.5, 0). 

 

Poikkileikkauksia piirtäessä ei z – koordinaatin käyttö ole kuitenkaan tarpeellista, 

miksi arvot voidaan syöttää pelkillä x- ja y – koordinaateilla.   
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Päätetään polyline – viiva piirtämällä se reilusti pitkäksi (luiskan kaltevuus on 1: 1,5) → 

Esc/ Enter, ja rajaamalla erillisellä Trim – käskyllä maanpintaan valitsemalla joko Trim 

työkalupaletista tai ylävalikosta Modify → Trim → Valitse maanpinta → Valitse 

päätettävä viiva.  

 

Mallin ollessa valmis tallennetaan se valikosta File → Save As. Tarkistetaan, että 

tiedostomuoto on vdf – muotoa. Valmiin mallin tulisi näyttää alla olevan kuvan 

mukaiselta:  

 

 

 

 

Mallin piirtämisen sijaan voidaan GeoCalc – ohjelmaan myös avata olemassa oleva 

DWG – tiedosto (eli esim. AutoCad:lla piirretty tiedosto). Tällöinkin on 

huomioitava, että laskentamalli muodostuu polyline – viivoista. Lisäksi silloin 

määritellään koordinaatiston sijainti Calculation → Set Coordinates → kirjataan 

komentoriville 0,0,0. 
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2.6 Penkereen vakavuus kokonaisvarmuusmenetelmällä 

 

Kokonaisvarmuusmenetelmällä laskiessa käytetään kuormituksen ja maaparametrien 

ominaisarvoja, jotka on annettu laskentaesimerkin alussa. 

 

Mallin piirtämisen jälkeen voidaan aloittaa varsinainen mitoittaminen. Avataan joko Start 

up – ikkunassa valittu stabiliteettimoduuli, tai valitaan moduuli piirtotilan ylävalikosta 

Calculation → Stability.  

 

Stabiliteettimoduuli koostuu välilehdistä, joihin syötetään laskennassa käytettäviä 

lähtötietoja. Tiedot täytetään käymällä välilehdet järjestyksessä läpi vasemmalta oikealle, 

kunnes päästään laskennan tuloksiin.  Laskentamoduulien eri kohdille saadaan melko 

kattavat suomenkieliset selitteet viemällä hiiri aina tarkasteltavan kohdan päälle.  

 

2.6.1 Laskennan yleiset tiedot 

 

 General – välilehdellä täytetään laskennan yleiset tiedot, kuten projektinumero, asiakas, 

laskija jne.   

 

Laskenta-arvot Piirtotilan päivitys 
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2.6.2 Piirtoasetukset 

 

View – välilehdellä muokataan näyttöasetuksia, eli sitä, miten laskenta esitetään 

grafiikkaikkunassa ja tulostuksessa. Palataan näihin asetuksiin tarkemmin tulostusta 

tarkasteltaessa.  

 

 

2.9 Laskennan poikkileikkausgeometria 

 

Geometry-välilehdellä määritellään laskennassa käytettävien maakerrosten, kallion, 

pohjaveden ja orsiveden geometria poikkileikkauksessa.  

 

Määritellään eri maakerrosten rajat valitsemalla laskentamoduulin yläpalkista Geometry 

→ Select Soil Layer Polylines → From Top to Bottom. Komento sulkee 

laskentaikkunan ja seuraavaksi laskentamallista valitaan maakerrosrajat penger mukaan 

Ohjelman käyttökieli on englanti, mutta viemällä osoittimen eri toimintojen päälle, 

saadaan niille melko kattavat suomenkieliset selitteet.  

 

Tarvittaessa voidaan Default Values – painikkeesta muokata laskennassa yleisesti 

käytettäviä tietoja, kuten veden tilavuuspainoa.  

 

More – painikkeesta voidaan laskentaan liittää muistiinpanoja, huomautuksia ym.  

Piirtotilan saa päivitettyä Update – painikkeesta missä vaiheessa laskentaa tahansa. 
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lukien järjestyksestä ylhäältä alas. Valittu viiva muuttaa värinsä keltaiseksi. Ohjelma 

muodostaa automaattisesti alimmasta valitusta viivasta kovan pohjan.  

 

 

Huomaa, että malliin piirrettyä pohjavedenpinnan rajaa ei valita tässä kohdassa! Jos 

pohjavedenpinta on kuitenkin valittu, painetaan Esc ja tehdään valinta uudestaan. Kun 

kaikki rajapinnat on valittu, painetaan Enter. Valittujen maakerrosten tulisi muuttua 

rasteroiduksi, jos View – välilehden Material – kohta on jätetty aktiiviseksi.  

 

Seuraavaksi valitaan pohjavedenpinta laskentamallista. Valinta tehdään kuten 

maakerrosrajojen valinta: Geometry → Select Ground Water Polyline. Valitaan 

laskentamallista savikerroksen yläpinta, jonka jälkeen viivan tulisi muuttua siniseksi.  

 

 

Maakerrosrajat voidaan valita myös vapaassa järjestyksessä valitsemalla 

ylävalikosta Geometry → Select Soil Layer Polylines → Free Order.. 

 

Tämän jälkeen voidaan maakerrosrajat valita vapaassa järjestyksessä.  
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2.6.3 Maakerrosten laskentaparametrit 

 

Material – välilehdellä määritellään äsken muodostettujen maakerrosten parametrit. Alla 

olevassa kuvassa on esitetty muutama keskeisistä kohdista: 

 

Määritetään järjestyksessä jokaisen maakerroksen tiedot ja lujuusparametrit, kuten yllä 

olevassa kuvassa.  

 

 

Eri kohdissa täytettäviä tietoja ovat:  

 

- Color: Laskentamallissa näkyvän rasteroinnin väri 

- Soil layer: Annetaan maakerroksen nimi 

- γ [kN/m3]: Annetaan maa-aineksen tilavuuspaino 

- γsat [kN/m3]: Tilavuuspaino pohjavedenpinnan alapuolella. Kun 

märkätilavuuspainoa ei anneta, laskee ohjelma sen itse oletuksena 

kuivatilavuuspainon ja annettujen pohjavesitietojen perusteella. 

- c [kPa]: Koheesio, kohtaan annetaan maa-aineen suljettu leikkauslujuus (su) 

tai tehokas koheesio laskettaessa c’ – φ - menetelmällä 

- φ’ [˚]: Annetaan maa-aineksen kitkakulma. 

- Material Type: Lujuuden syvyysriippuvuus, josta valitaan, ovatko maan 

lujuusparametrit vakioita (engl. Independent on depth) vai riippuvatko ne 

syvyydestä (engl. Dependent on depth).  
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2.6.4 Huokosvedenpaine 

 

Pore Pressure – välilehdellä määritellään huokosvedenpaineen laskentatapa.  

 

Valitaan kohta Ground Water aktiiviseksi ja määritetään kohta External Water → 

Ground Water. Jollei pohjavettä valita tällä välilehdellä aktiivisesti, huomioi ohjelma 

sen esimerkissä vain maakerrosten tilavuuspainoissa. 

 

 

2.6.5 Kuormitus 

 

Load – välilehdellä määriteltäisiin laskentamallissa esiintyvä laskentakuormitus, esim. 

liikennekuorma. Tässä esimerkissä tarkastellaan vain penkereen aiheuttamia kuormia.  
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2.6.6 Maanaulaus ja ankkurointi 

 

Nail - välilehdellä määriteltäisiin luiskan vakavuutta parantavat naulaukset ja 

ankkuroinnit. Jätetään maanaulaus ja ankkurointi pois tässä laskennassa.  

 

 

 

 

2.6.7 Geovahvisteet 

 

Reinforcement - välilehdellä määriteltäisiin vakavuutta parantavat geovahvisteet ja 

jätetään pois tässä esimerkissä.  

Maanaulaus lisätään valitsemalla Nail → Add Nail/ Anchor (left/ right).  Samasta 

valikosta voidaan poistaa lisätty naulaus/ ankkurointi. Seuraavaksi näytetään 

laskentamallista naulattava väli ja täytetään laskentaikkunassa kysytyt parametrit.   

Kuormitus lisätään valitsemalla Load → Add Vertical / Horizontal Load, minkä 

jälkeen kuormituksen sijainti ja suuruus osoitetaan piirtonäkymässä komentoriville 

ilmestyvien ohjeiden mukaisesti. 

Geovahviste lisätään valitsemalla Reinforcement → Add Reinforcement (Left/ 

Right). Seuraavaksi näytetään laskentamallista vahvisteen sijainti ja täytetään 

laskentaikkunassa kysytyt parametrit.  
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2.6.8 Liukupinnan asetukset 

 

Failure Surface - välilehdellä määritellään liukupintojen laskentamenetelmä.  

 

 

Esimerkissä haetaan vaarallisinta liukupintaa, jolloin valitaan kohta Optimization 

aktiiviseksi.  

 

Valitaan liukupinnan muodoksi ympyräliukupinta: Surface → Circular ja suoritetaan 

laskenta Bishopin yksinkertaistetulla menetelmällä: Method → 2D Bishop’s Simplified.  

 

 

 

Geovahvisteiden lisääminen ja poistaminen tapahtuu valitsemalla laskentaikkunan 

valikosta Reinforcement → Add Reinforcement (Lef/ Right). Seuraavaksi 

näytetään laskentamallista vahvistettava väli ja täytetään laskentaikkunassa kysytyt 

parametrit. 

GeoCalc:ssa voidaan valita useita muitakin laskentateorioita Method – kohdassa. 

Esimerkiksi sivukaltevassa maastossa vaarallisimman liukupinnan selvittämiseksi 

voidaan valita esimerkiksi Surface → Non-circular, concave ja laskentateoriaksi 

Janbun yksinkertaistettu menetelmä kohdasta Method → 2D Janbu’s Simplified. 

Tällöin laskenta suoritetaan vapaamuotoisella liukupinnalla käyttäen Janbun 

yksinkertaistettua laskentateoriaa. Laskenta kestää vähän kauemmin, kuin Bishopin 

yksinkertaistetulla menetelmällä laskettuna. 

 

Jos liukupinta halutaan määrittää itse, valitaan Single Slip Surface – kohdasta 

Circular. Tällöin Circular Method – kohdassa voidaan määrittää liukuympyrän 

säde ja pisteet missä liukupinta leikkaa maanpinnan.  
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2.6.9 Halkeamat ja päätyvastus 

 

Advanced – välilehdellä voidaan määrittää vakavuutta parantavia tai heikentäviä 

komponentteja, kuten päätyvastus tai erityisen heikko maakerros. Tässä esimerkissä ei 

huomioida tällaisia arvoja, vaan välilehti jätetään tyhjäksi.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Välilehdellä annettavia parametreja ovat:  

Tension Crack -  mahdolliset yksittäiset halkeamat tai ruhjeisuusalueet  

End Effect – päätyvastus 

Sensitivy Analysis – Sensitiivisyys, eli herkkyystarkastelu 

Soft Band Layer – Erityisen heikko ja ohut maakerros  

Sliding – Liukupinnan suunnan määritys 

Forbidden Domain – Pinta, jonka läpi vaarallinen liukupinta ei pääse kulkemaan 

(esim. tukiseinä). 
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2.6.10 Laskenta 

 

Calculate – välilehdellä määritellään laskennan asetukset ja käynnistetään laskenta.  

 

Ohjelma saadaan etsimään vaarallisin liukupinta määrittämällä sen ja maanpinnan väliset 

leikkauspisteiden rajat kohdassa Search Range for Location Critical Failure Surface.  

 

Valitaan kohdassa Divide Search Range, tarkastellaanko vakavuutta penkereen oikean 

vai vasemman puoleiselle luiskalle. Koska kova pohja ulottuu korkeammalle oikeassa 

reunassa (jolloin murtuminen tapahtuu todennäköisemmin vasemmalle) miksi valitaan 

Leftside.  

 

Samalla rivillä voidaan valita, kuinka monta vaarallista liukupintaa tulokseen kuvataan 

Parts: → Liukupintojen lkm. 

 

Asetetaan liukupinnan ja maanpinnan leikkausvälit valitsemalla laskentaikkunasta 

Define, jonka jälkeen näytetään laskentamallista ensin vasemman puolen 1. ja 2. piste ja 

tämän jälkeen oikean puolen vastaavat pisteet komentorivillä näkyvien ohjeiden 

mukaisesti.  
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Näiden jälkeen painetaan Calculate – painiketta, jolloin ohjelma suorittaa laskennan.  

 

Tuloksena ohjelma antaa Calculation Status – ruutuun heikoimman varmuuskertoimen 

(Min.FOS) ja ilmoittaa laskennassa käytettyjen lamellien lukumäärän. 

 

 

Laskennan lopuksi vaarallisimmat liukupinnat tulostuvat piirtotilaan alla olevan kuvan 

mukaisesti:  

 

 

Laskenta saadaan tallennettua valitsemalla laskentamoduulin ylävalikosta Calculation 

→ Save As. Stabiliteettilaskennat tallentuvat tiedostomuotoon ”*. gcst ”. Koska tässä 

laskentaesimerkissä tehdään useampia tarkasteluja, on jokainen tehdyistä laskennoista 

suositeltavaa tallentaa eri nimillä.  

Jos koordinaattipisteet ovat tiedossa, voidaan ne myös kirjata suoraan välilehdellä 

oleviin X1, Y1 ja X2, Y2-kenttiin.  

 

Min.FOS = Factory of safety, 

eli pienin varmuuskerroin 
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Ohjelmisto tulostaa laskennan tulokset lisäksi Graph – ja Report – välilehdille.  

 

Graph – välilehdellä näytetään laskennan perusteella tehdyt grafiikat.  

 

 

 

Report – välilehdellä näytetään laskennan tekstimuotoiset tulokset. Valittavana on 

laskennan lähtötiedosto (engl. Slope Input), lähtötietojen oikeellisuuden 

tarkisturaportti (engl. Slope Input Check) ja tulostiedosto (Slope Results).  
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2.7 Penkereen vakavuus murtorajatilassa 

 

Seuraavaksi tarkastellaan penkereen vakavuutta osavarmuuslukumenetelmällä. Tehdään 

kaksi tarkastelua, joista toisessa huomioidaan vain pysyvät kuormat ja toiseen lisätään 

myös liikennekuorma.  

 

Laskentaesimerkissä käytettävät osavarmuuslukukertoimet ovat Liikenneviraston 

ohjeesta 35/2013: Eurokoodin soveltamisohje – Geotekninen suunnittelu NCCI 7.  

 

Lasketaan lähtötietona annetuille maaparametreille mitoitusarvot: 

 

Penger:  

γ = 20 kN/ m2 / 1,0 = 20 kN/m2 

φ = tan-1(tan40˚ / 1,25) = 33,8˚  

 

Siltti:  

γ = 17 kN/ m2 / 1,0 = 17 kN/m2 

su = 30 kN/m2 / 1,4 = 21,4 kN/m2 

φ = 0˚  

 

Savi: 

γ = 15 kN/ m2 / 1,0 = 15 kN/m2 

su = 12 kN/m2 / 1,4 = 8,5 kN/m2 

φ = 0˚  

 

Siltti: 

γ = 17 kN/ m2 / 1,0 = 17 kN/m2 

su = 30 kN/m2 / 1,4 = 21,4 kN/m2 

φ = tan-1(tan28˚ / 1,25) = 23˚ (käänteistangenttina) 

 

Liikennekuorman mitoitusarvo:  

qd = 10 kN/m2 · 1,15 = 11,5 kN/m2 
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Koska laskentamalli ja sen geometria säilyvät samana, kuin kokonaisvarmuutta 

tarkasteltaessa, on helpointa avata sama laskentamalli ja stabiliteettimoduuli.  

 

2.7.1 Laskennan aloitus 

 

Jos edellinen laskentaprojekti ei ole auki, avataan se piirtoalueen ylävalikosta 

Calculation → Stability, jonka jälkeen oikea laskentamoduuli aukeaa. Valitaan 

laskentamoduulin ylävalikosta Calculation → Open.., jonka jälkeen haetaan tiedostoista 

edellinen laskentaprojekti.  

 

Projektin avaamisen jälkeen se kannattaa tallentaa uudella nimellä Calculation → Save 

As.., jottei uusi tarkastelu tallennu vanhan päälle.  

 

 

Koska laskennan geometria ja kuormitus ovat samoja, kuin 

kokonaisvarmuusmenetelmällä, ei tässä tarkastelussa tarvitse muuttaa kuin materiaalien 

laskenta-arvoja. Lisäksi lisätään liikennekuorma, mitä ei edellisessä esimerkissä tehty. 

 

2.7.2 Maakerrosten parametrit 

Siirrytään Material – välilehdelle, jossa määritellään maakerroksille uudet, 

osavarmuusluvuilla huomioidut arvot:  
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2.7.3 Laskenta 

 

Koska muut tiedot pysyvät tässä vaiheessa samoina, kuin edellisessä laskennassa, 

siirrytään suoraan Calculate – välilehdelle suorittamaan laskenta. Käynnistetään laskenta 

valitsemalla Calculate.  

 

Pienimmäksi varmuusluvuksi saadaan 0,74 < ODF = 1,0, jolloin vakavuus ei ole riittävä. 

Huomataan laskennasta, että heikoin liukupinta on rajattu kahden vahvemman 

murtopinnan väliin.  

 

 

 

2.8 Liikennekuorma 

 

Tarkastetaan liikennekuorman vaikutus penkereen stabiliteettiin. Tehdään tarkastelu 

suoraan käynnissä olevaan laskentaan siirtymällä Load – välilehdelle.  

  

Haluttaessa laskenta voidaan pyyhkiä valitsemalla Clear Now, jolloin laskennan 

tulokset poistuvat näkyvistä.  
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Lisätään kuormitus ylävalikosta Load → Add Vertical Load. Komentorivillä pyydetään 

näyttämään kuormituksen ensimmäinen sijaintipiste, jolloin osoitetaan penkereen vasenta 

yläkulmaa.  

 

Ohjelma avaa ikkunan, mihin annetaan kuormituksen suuruus.  

 

Seuraavaksi osoitetaan kuormituksen päättymispiste penkereen oikeaan yläkulmaan ja 

annetaan uudelleen kuormituksen suuruus. Tämän jälkeen kuorma piirtyy 

laskentamalliin:  

 

 

Tarvittaessa kuormituksen tietoja, esim. suuruutta pystyy muokkaamaan suoraan 

laskentamoduuliin ilmestyvältä kuormituksen tietoriviltä:  
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Kuorman lisäämisen jälkeen voidaan suorittaa laskenta siirtymällä Calculate – 

välilehdelle. Käynnistetään laskenta valitsemalla Calculate.  

 

 

 

Kuormitus laski arvon 0,69: een.  

 

2.9 Tulostus 

 

Käsitellään laskennan jälkeen tulostamista ja palataan Stability – laskentamoduulissa 

välilehdelle View. 

 

Mikäli jotain ei haluta näkyviin tulosteeseen, esim. maakerrosten rasterointeja, poistetaan 

kohdan Material edestä ruksi. Vaihtoehtoisesti rasteroinnin tyyliä voidaan muokata 

vähemmän raskaaksi, esim. viivoitukseksi. Rasteroinnin % - arvo kertoo sen 

läpinäkyvyydestä ja kannattaa tulostukseen valita lähelle 100 %: a.  
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Määritetään tulostettavan paperin koko ja mittakaava kohdan Frame pudotusvalikoista. 

Valitaan kohdan edestä rasti aktiiviseksi, jotta tulosteikkuna saadaan näkyviin 

piirtoalustalle. Määrätään sille sijainti viereisestä Location – linkistä ja annetaan 

grafiikkaikkunassa kehyksen vasen alakulma. Uusi sijainti saadaan määrättyä 

valitsemalla Location → uusi sijainti.  

 

Valitaan myös kohdat Material table ja Info table aktiivisiksi, jolloin saadaan nimiö ja 

laskennassa käytetyt maaparametrit näkyviin.  

 

Asetuksien jälkeen tulosteen tulisi näyttää samalta, kun alla:  

 

 

 

Tulostus tehdään valitsemalla piirtopöydän ylävalikosta File → Print.  
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Ohjelma avaa tulostusikkunan, mistä ensimmäisenä kannattaa valita tulostin → Select 

Printer.  

 

Valitaan esimerkiksi jokin PDF – tulostin. Kohdasta Properties tarkastetaan tulostimen 

asetukset. Päätetään valinta valitsemalla Ok.  

 

 

Tämän jälkeen voidaan asettaa loput asetukset, kuten kappaleen alussa olleessa kuvassa. 

Näistä kannattaa kiinnittää huomiota erityisesti marginaaleihin, tulostussuuntaan ja 

mittakaavaan.  
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2.10 Laskennan lopetus 

 

 

Kun molemmat laskentavaiheet on laskettu, tallennettu ja tulostettu, voidaan 

laskentamoduuli ja GeoCalc – ohjelmisto sulkea.  

 

Suljetaan Stability – laskentamoduuli Calculation → Close.  

 

Suljetaan Novapoint GeoCalc piirtotilassa ylävalikosta File → Exit.  
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Liite 3. Kaivannon vakavuus 

 

3.1 Lähtötiedot 

 

Tässä laskentaesimerkissä käydään läpi RIL 263 – 2014: Kaivanto-ohje mukaista 

putkikaivannon mitoitusta. Tehtävät tarkastelut ovat siis:  

 

1) Kaivannon vakavuus murtorajatilassa kun,  

a) pohjavedenpinta kulkee maksimissaan maan tasossa 

 b) pohjavedenpinta huomioidaan ulkoisena kuormana 

2) Kaivannon vakavuus kokonaisvarmuuslukumenetelmällä 

 

Mitoitettava tilanne on esitetty alla olevassa kuvassa:  

 

- Pohjavedenpinta on 1 metri maan pinnasta 

- Kaivannon reunalla on 200 kN:n työkone, jonka paino jakautuu 3 m x 4 m 

alueelle. Se aiheuttaa siis noin 17 kN/m2 suuruisen pintakuorman.  

- Kaivannon reunalla ei ole muita kuormia 

- Pohjamaa on homogeeninen, joten käytetään ympyränmuotoista liukupintaa ja 

Bishopin yksinkertaistettua laskentamenetelmää.  

- Liukupinnan vaikutusalueella ei ole rakenteita.  

- Huomioidaan päätyvastus, jossa liukuvan kappaleen pituutena käytetään 6 metriä. 
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3.2 Käynnistys 

 

Käynnistetään Novapoint GeoCalc – ohjelma ja tehdään mahdollinen lisenssinvahvistus. 

Oppilaitoksissa valitaan yleensä vaihtoehto Novapoint 16 licensing. 

 

Valitaan GeoCalc Startup – ikkunasta New Calculation → Stability (suom. Uusi 

stabiliteettilaskenta). Ohjelma avaa Stability – laskentamoduulin, minkä voi pienentää 

ikkunan oikeasta yläkulmasta. Vaihtoehtoisesti Startup – ikkunan voi sulkea ja valita 

laskentamoduulin myöhemmin ylävalikosta Calculation → Stability... 

 

Aloitetaan laskenta käymällä läpi ensin piirtoasetukset, joissa määritellään koordinaatti- 

ja piirtoruudukko, sekä tartuntapisteiden ja piirtoverkon pisteiden välit.  

 

3.3 Koordinaattiruudukko 

 

Ensimmäiseksi määritellään piirtoalueelle koordinaattiruudukko valitsemalla 

Calculation → Set working area.  

 

Placement – kohdasta määritetään koordinaattiruudukon vasen alakulma. Valitaan Pick 

Point ja kirjoitetaan komentoriville arvoksi 0, 0, 0 (x, y, z), koska tarkempia 

koordinaatteja ei ole annettu. Vaihtoehtoisesti voidaan em. koordinaatit kirjoittaa suoraan 

kohtaan Placement → Lower left corner coordinates. 
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Grid – kohdasta määritetään koordinaattiruudukon koko ja väri.  

 

Text – kohdasta määritetään tekstin tyyli, koko ja väri.  

 

Piirrettyä koordinaattiruudukkoa voidaan tarvittaessa muokata Set working area – 

ikkunasta ja tarvittaessa poistettua painamalla Remove – painiketta.  

 

Valitaan tässä harjoituksessa yllä olevan kuvan mukaiset arvot. Kun arvot on muutettu, 

painetaan Draw ja poistutaan ikkunasta painamalla Close. Työalueelle tulisi ilmestyä alla 

olevan kuvan mukainen ruudukko.  
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3.4 Piirtoasetukset  

 

Seuraavaksi muokataan käytettävien tartuntapisteiden ja piirtoverkon pisteiden välit, 

valitsemalla grafiikkaikkunan ylävalikosta Tools → Options.  

 

Options – näkymässä määritellään tartuntapisteiden välit (Snap) ja piirtoverkon välit 

(Grid). Näihin kannattaa asettaa samat arvot, esim. 0,5 tai 1, riippuen millä tarkkuudella 

osoittimen tartuntavälit halutaan.  

 

Modify grid limits – kohdassa määritellään piirtoverkon koko. Piirtoverkko kannattaa 

yleensä asettaa saman kokoiseksi, kuin aiemmin määritetty koordinaattiruudukko. 

Tällöin piirtoverkon koko annetaan kirjoittamalla alapalkissa olevalle komentoriville 

ensin vasemman alakulman koordinaatit (0, 0, 0) → Enter → Oikean yläkulman 

koordinaatit (40, 20, 0) → Enter.  

 

Vaihtoehtoisesti piirtoruudukko voidaan antaa klikkaamalla koordinaattiruudukon 

kulmia tartuntatyökalujen Osnap -komento päällä. Jotta muutokset tulevat voimaan 

painetaan näkymästä Apply ja poistutaan painamalla Ok.  

 

Näkymän ei tulisi muuttua tämän jälkeen.  
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3.5 Laskentamallin piirtäminen 

 

Piirtoasetuksien määrittämisen jälkeen voidaan tehdä laskentamalli tarkasteltavasta 

tilanteesta. GeoCalc:ssa piirretyt laskentamallit tallennetaan erikseen omaksi 

tiedostokseen (tiedostomuodo *.vdf) ja varsinainen laskenta suoritetaan laskentamallin 

”päällä”. Samalle laskentamallille voidaan tehdä siis useampi tarkastelu, eikä sitä 

välttämättä tarvitse luoda aina erikseen.  

 

Piirretään alla olevan esimerkkikuvan mukaiset maakerrokset koordinaattipisteiden 

avulla.  

Valitaan työkalupaletista Polyline – komento →, tai valikosta Draw → Polyline.  

 

Viiva voidaan piirtää valitsemalla sijaintipisteet suoraan koordinaattiruudukosta 

osoittimella, tai kirjaamalla sijaintipisteet komentoriville esim. 0, 0 → Enter → 40, 0 → 

Enter… jne. Viiva päätetään painamalla näppäimistöltä Enter tai Esc –painiketta. 

Toiminto aloitetaan uudelleen jokaisen viivan päätyttyä. 

Jos Polyline – komentoa ei löydy suoraan valintaikkunan työkalurivistä, voidaan 

Draw – toolbar asettaa näkyville valitsemalla View → Toolbars → Draw.  

 

Laskentamallin toimimisen kannalta on sen piirtämisessä tärkeää, että 

- Mallin viivat esim. maakerrosrajat ovat piirretty polyline –komennolla. 

Ohjelma ei tunnista muita viivoja. 

- Mallin viivat piirretään vasemmalta oikealle 

- Mallin viivat eivät saa mennä ristiin. Viivat voivat olla päällekkäin.  

 

Äsken määritellyt tartuntavälit (Snap) ja piirtoverkon välit (Grid) saadaan voimaan 

piirtotilassa klikkaamalla tartuntatyökalujen Snap- ja Grid – toiminnot aktiivisiksi.  
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Poikkileikkauksen tulisi valmiina näyttää seuraavalta:  

 

Mallin ollessa valmis tallennetaan se piirtotilan ylävalikosta File → Save As. 

Tarkistetaan, että tiedostomuoto on vdf – muotoa.  

 

 

 

 

  

Mallin piirtämisen sijaan voidaan GeoCalc – ohjelmaan myös avata olemassa oleva 

DWG – tiedosto (eli esim. AutoCad:lla piirretty tiedosto). Tällöinkin on 

huomioitava, että laskentamalli muodostuu polyline – viivoista. Lisäksi silloin 

määritellään koordinaatiston sijainti Calculation → Set Coordinates → kirjataan 

komentoriville 0,0,0. 

 

Huomaa, että koordinaatteja syöttäessä x-, y- ja z-koordinaatit erotetaan toisistaan 

pilkulla (esim. 0, 0, 0) ja koordinaattien desimaalit pisteellä (esim. 0, 0.5, 0). 
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3.6 Eurokoodien mukainen murtorajatilamitoitus 

 

Suljetun leikkauslujuuden osavarmuusluku on 1,5 (RIL – 263: Kaivanto – ohje, Taulukko 

7.2).  

𝑐𝑢;𝑑 =
10𝑘𝑁/𝑚2

1,5
= 6,7 𝑘𝑁/𝑚2 

 

Seuraamusluokka on CC2, jolloin luotettavuusluokka on RC2:  

 

𝐾𝐹𝐼 = 1,0 

 

Kuorman mitoitusarvo (RIL – 263: Kaivanto-ohje):  

 

𝑞𝑑 = 1,3 ∙ 𝐾𝐹𝐼 ∙ 𝑄𝑘 = 1,3 ∙ 1,0 ∙ 17
𝑘𝑁

𝑚

2

= 22,1𝑘𝑁/𝑚2 

 

Aloitetaan kaivannon tarkastelu Novapoint GeoCalc – ohjelmistolla. Laskentamoduuli 

valitaan piirtotilan ylävalikosta Calculation → Stability.  

 

Stabiliteettimoduuli koostuu välilehdistä, joihin syötetään laskennassa käytettäviä 

lähtötietoja. Tiedot täytetään käymällä välilehdet järjestyksessä läpi vasemmalta oikealle, 

kunnes päästään laskennan tuloksiin.  Laskentamoduulien eri kohdille saadaan melko 

kattavat suomenkieliset selitteet viemällä hiiri aina tarkasteltavan kohdan päälle.  
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3.6.1 Laskennan yleiset tiedot 

 

 General – välilehdellä täytetään laskennan yleiset tiedot, kuten projektinumero, asiakas, 

laskija jne.   

 

3.6.2 Piirtoasetukset  

 

View – välilehdellä muokataan näyttöasetuksia, eli sitä, miten laskenta esitetään 

piirtotilassa ja tulostuksessa.  

 

Ohjelman käyttökieli on englanti, mutta viemällä osoittimen eri toimintojen päälle, 

saadaan niille melko kattavat suomenkieliset selitteet.  

 

Tarvittaessa voidaan Default Values – painikkeesta muokata laskennassa yleisesti 

käytettäviä tietoja, kuten veden tilavuuspainoa.  

 

More – painikkeesta voidaan laskentaan liittää muistiinpanoja, huomautuksia ym.  

 

Piirtotilan saa päivitettyä Update – painikkeesta missä vaiheessa laskentaa tahansa. 
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3.6.3 Laskennan poikkileikkausgeometria 

 

Geometry-välilehdellä määritellään laskennassa käytettävien maakerrosten, kallion, 

pohjaveden ja orsiveden geometria poikkileikkauksessa.  

 

Määritellään eri maakerrosten rajat valitsemalla laskentamoduulin yläpalkista Geometry 

→ Select Soil Layer Polylines → From Top to Bottom. Komento sulkee 

laskentaikkunan ja seuraavaksi laskentamallista valitaan maakerrosrajat penkere mukaan 

lukien järjestyksestä ylhäältä alas. Valittu viiva muuttaa värinsä keltaiseksi. Ohjelma 

muodostaa automaattisesti alimmasta valitusta viivasta kovan pohjan.  

 

 

Kun kaikki rajapinnat on valittu, painetaan Enter. Valittujen maakerrosten tulisi muuttua 

rasteroiduksi, jos View – välilehden Material – kohta on jätetty aktiiviseksi.  

 

Seuraavaksi valitaan pohjavedenpinta: Geometry → Select Ground Water Polyline. 

Valitun viivan tulisi muuttua näkymässä siniseksi.  

Vaihtoehtoisesti maakerrosrajat voidaan valita vapaassa järjestyksessä valitsemalla 

valikosta Calculation → Select Soil Layer Polylines → Free Order... 
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3.6.4 Maakerrosten laskentaparametrit 

 

Material – välilehdellä määritellään äsken muodostettujen maakerrosten parametrit. 

Täytetään tiedot kuten alla olevassa kuvassa:  

 

 

3.6.5 Huokosvedenpaine 

 

Pore Pressure – välilehdellä määritellään huokosvedenpaineen laskentatapa.  

 

Valitaan pohjavesi aktiiviseksi. Jos pohjavedenpinta on määritelty geometriassa, muttei 

aktiivisena, ohjelma huomioi sen vain tilavuuspainon laskennassa.  
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3.6.6 Kuormitus 

 

Load – välilehdellä määritellään työkoneen aiheuttama kuormitus. Kuormitus lisätään 

valitsemalla Load → Add Vertical Load.  

 

Annetaan kuormitukselle ensimmäinen sijaintipiste klikkaamalla läheltä kaivannon 

reunaa. Ohjelma avaa Load Pressure – ikkunan, mihin kirjataan pisteessä vaikuttava 

kuormitus → Ok.  

 

Tämän jälkeen ohjelma kysyy seuraavan sijaintipisteen. Koska kuormitus lasketaan 4 

metriä leveänä, voidaan komentoriville kirjata koordinaatit ” @4,0 ”, jolloin ohjelma 

sijoittaa seuraavan pisteen 4 m vasemmalle edellisestä pisteestä.  

 

Kun halutaan tarkastella tilannetta, missä pohjavedenpinta on korkeimmillaan maan 

pinnan tasossa, valitaan External Water → Ground level (vasen kuva). Jos 

halutaan taas tarkastella tilannetta, missä pohjavedenpinta suotautuu maan läpi 

ulkoiseksi kuormaksi, valitaan External Water → Ponded Water (oikea kuva).  
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Annetaan sama kuormitus, kuin edellisessä kohdassa. Ohjelma piirtää kuormituksen 

piirtotilaan:  

 

 

 

3.6.7 Maanaulaus ja ankkurointi 

 

Nail - välilehdellä määriteltäisiin luiskan vakavuutta parantavat naulaukset ja 

ankkuroinnit. Jätetään maanaulaus ja ankkurointi pois tässä laskennassa.  

 

 

 

 

 

Maanaulaus lisätään valitsemalla Nail → Add Nail/ Anchor (left/ right).  Samasta 

valikosta voidaan poistaa lisätty naulaus/ ankkurointi. Seuraavaksi näytetään 

laskentamallista naulattava väli ja täytetään laskentaikkunassa kysytyt parametrit.   
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3.6.8 Geovahvisteet 

 

Reinforcement - välilehdellä määriteltäisiin vakavuutta parantavat geovahvisteet ja 

jätetään pois tässä esimerkissä.  

 

 

3.6.9 Liukupinnan asetukset 

 

Failure Surface - välilehdellä määritellään liukupintojen laskentamenetelmä.  

 

Esimerkissä haetaan vaarallisinta liukupintaa, jolloin valitaan kohta Optimization 

aktiiviseksi.  

 

Geovahvisteiden lisääminen ja poistaminen tapahtuu valitsemalla laskentaikkunan 

valikosta Reinforcement → Add Reinforcement (Lef/ Right). Seuraavaksi 

näytetään laskentamallista vahvistettava väli ja täytetään laskentaikkunassa kysytyt 

parametrit. 
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Valitaan liukupinnan muodoksi ympyräliukupinta: Surface → Circular ja suoritetaan 

laskenta Bishopin yksinkertaistetulla menetelmällä: Method → 2D Bishop’s Simplified.  

 

 

 

3.6.10 Halkeamat ja päätyvastus 

 

Advanced – välilehdellä huomioidaan tässä laskentaesimerkissä kaivannon päätyvastus.  

Valitaan kohta End Effect → Calculate with End Effect aktiiviseksi.   

 

 

 

 

 

 

 

GeoCalc:ssa voidaan valita useita muitakin laskentateorioita Method – kohdassa. 

Esimerkiksi sivukaltevassa maastossa vaarallisimman liukupinnan selvittämiseksi 

voidaan valita esimerkiksi Surface → Non-circular, concave ja laskentateoriaksi 

Janbun yksinkertaistettu menetelmä kohdasta Method → 2D Janbu’s Simplified. 

Tällöin laskenta suoritetaan vapaamuotoisella liukupinnalla käyttäen Janbun 

yksinkertaistettua laskentateoriaa. Laskenta kestää vähän kauemmin, kuin Bishopin 

yksinkertaistetulla menetelmällä laskettuna. 

 

Jos liukupinta halutaan määrittää itse, valitaan Single Slip Surface – kohdasta 

Circular. Tällöin Circular Method – kohdassa voidaan määrittää liukuympyrän 

säde ja pisteet missä liukupinta leikkaa maanpinnan.  
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Tämän jälkeen avautuu End Effect – ikkuna, mihin annetaan alla olevat tiedot:  

 

 

Koska saven kitkakulma (φ) on arvoltaan nolla, tulee maan lepopainekertoimeksi 1. 

Liukuvan kappaleen pituus määräytyy auki olevan kaivannon pituuden mukaan. Tässä 

esimerkissä kaivanto voi olla auki siis 6 metriä kerrallaan, jotta päätyvastus voidaan 

huomioida.  

 

3.6.11 Laskenta 

 

Calculate – välilehdellä määritellään laskennan asetukset ja käynnistetään laskenta.  

 

 

 

 

 

Ohjelma saadaan etsimään vaarallisin liukupinta määrittämällä sen ja maanpinnan väliset 

leikkauspisteiden rajat kohdassa Search Range for Location Critical Failure Surface.  

 

Vaarallisimman liukupinnan 

ja maanpinnan leikkausvälit 

Liukupintojen 

lukumäärä 

Laskenta-arvojen 

tyhjennys 

Laskenta 
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Valitaan kohdassa Divide Search Range, tarkastellaanko vakavuutta penkereen oikean 

vai vasemman puoleiselle luiskalle. Koska työkone on kaivannon oikealla puolella, 

murtuu kaivanto todennäköisesti vasemmalle. Valitaan siis Leftside.   

 

Samalla rivillä voidaan valita, kuinka moneen liukupintaan laskentaväli jaetaan Parts: → 

Liukupintojen lkm. 

 

Asetetaan liukupinnan ja maanpinnan leikkausvälit valitsemalla laskentaikkunasta 

Define, jonka jälkeen näytetään laskentamallista ensin vasemman puolen 1. ja 2. piste ja 

tämän jälkeen oikean puolen vastaavat pisteet komentorivillä näkyvien ohjeiden 

mukaisesti.  

 

 

 

Näiden jälkeen painetaan Calculate – painiketta, jolloin ohjelma suorittaa laskennan.  

 

Tuloksena ohjelma antaa Calculation Status – ruutuun heikoimman varmuuskertoimen 

(Min.FOS) ja ilmoittaa laskennassa käytettyjen lamellien lukumäärän. 

Jos koordinaattipisteet ovat tiedossa, voidaan ne myös kirjata suoraan välilehdellä 

oleviin X1, Y1 ja X2, Y2-kenttiin.  
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 Laskennan lopuksi vaarallisimmat liukupinnat tulostuvat piirtotilaan alla olevan kuvan 

mukaisesti:  

 

 

Huomataan, että pienin varmuusluku Min. FOS = 1,01, jolloin vakavuus on juuri riittävä.  

 

Laskenta saadaan tallennettua valitsemalla laskentamoduulin ylävalikosta Calculation 

→ Save As. Stabiliteettilaskennat tallentuvat tiedostomuotoon ”*. gcst ”. Koska tässä 

laskentaesimerkissä tehdään useampia tarkasteluja, on jokainen tehdyistä laskennoista 

suositeltavaa tallentaa eri nimillä.  

 

Min.FOS = Factory of safety, 

eli pienin varmuuskerroin 

Ohjelmisto tulostaa laskennan tulokset lisäksi Graph – ja Report – välilehdille, 

mistä on mahdollista tarkastella saatuja tuloksia grafiikkana ja numeerisena 

tulosteena. 
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3.7 Ei päätyvastusta 

 

Tarkastellaan päätyvastuksen vaikutusta poistamalla sen vakautta lisäävä vaikutus. 

Siirrytään Advanced – välilehdelle, missä poistetaan valinta kohdasta Calculate with 

End Effect.  

 

Suoritetaan laskenta uudelleen Calculate – välilehdellä valitsemalla Calculate.  

 

Huomataan kaivannon vakavuuden laskevan noin 25 %:lla.  
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3.8 Pohjavedenpinta ulkoisena kuormana 

 

Testataan seuraavaksi, miten pohjavesi vaikuttaa kaivannon vakavuuteen, kun sitä 

esiintyy myös ulkoisena kuormituksena.  

 

Palataan välilehdelle Pore Pressure → External Water → Ponded Water.  

 

 

 

 

Ohjelma muuttaa vedenpinnan myös kaivannon kohdalla pohjavedenpinnan tasolle.  

 

Palataan välilehdelle Calculate → Calculate, minkä jälkeen ohjelma suorittaa laskennan 

muutetuilla arvoilla. Tuloksesta nähdään ulkoisen vesikuormituksen vakavoittava 

vaikutus.  

 

 

 

Ulkoinen vedenpinta kuormana 
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3.9 Putkikaivannon vakavuus kokonaisvarmuusmenetelmällä 

 

Kokonaisvarmuuslukumenetelmällä tehtävässä tarkastelussa käytetään kuormituksien ja 

maaparametrien ominaisarvoja.  

 

Laskenta kannattaa suorittaa muokkaamalla vain edellisessä 

osavarmuuslukumenetelmällä tehtyjä laskelmia. Valitaan Stabiliteettimoduuli 

piirtoikkunan ylävalikosta Calculation → Stability.  

 

 

3.9.1 Laskennan yleiset tiedot 

 

Muutetaan yleisiä tietoja General - välilehdellä, jotta laskenta tallentuu erikseen, eikä 

korvaa aiemmin tehtyä tarkastelua. Tallennetaan Calculation → Save As... 

 

Koska laskenta suoritetaan edellisen laskennan pohjalta, ei tässä ole tarvetta muokata kuin 

materiaaliin, pohjaveteen, kuormitukseen ja päätyvastukseen liittyviä tietoja.  
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3.9.2 Maakerroksen laskentaparametrit 

 

Siirrytään Material – välilehdelle, missä muutetaan saven leikkauslujuus vastaamaan sen 

ominaisarvoa:  

 

 

3.9.3 Huokosvedenpaine 

 

Siirrytään Pore Pressure – välilehdelle, missä asetetaan pohjavedenpinta kulkemaan 

korkeintaan kaivannon pohjalla:  
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3.9.4 Kuormitus 

 

Siirrytään Load – välilehdelle, missä muutetaan kuorman suuruus suoraan kuorman 

tietoriville:  

 

 

3.9.5 Halkeamat ja päätyvastus 

 

Siirrytään välilehdelle Advanced. Huomioidaan laskennassa edelleen päätyvastus, joten 

valitaan päätyvastus uudelleen aktiiviseksi kohdasta End Effect → Calculate with End 

Effect.  

 

3.9.6 Laskenta 

 

Siirrytään välilehdelle Calculate. Koska tilanne on mitoitusparametreja lukuun ottamatta 

säilynyt samana, voidaan suoraan käynnistää laskenta → Calculate.  

 

Ohjelma näyttää piirtotilassa muodostuvat leikkauspinnat:  
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Huomataan pienimmän saadun varmuusluvun olevan F = 1,98. Tämä on riittävä varmuus, 

koska kokonaisvarmuuslukumenetelmässä rakennuskaivannolle vaadittu varmuus on F ≥ 

1,5, kun vaikutusalueella ei ole pysyviä rakenteita (RIL – 263: Kaivanto – ohje).  

 

 

3.10 Tulostus 

 

Käsitellään laskennan jälkeen tulostamista ja palataan Stability – laskentamoduulissa 

välilehdelle View.  

 

Muutetaan Material – kohdassa materiaalin rasterointi tulosteelle vähemmän raskaaksi, 

esim. ruudukoksi (engl. cross). Vaihtoehtoisesti rasteroinnin voi jättää kokonaan pois 

poistamalla rasti pois Material kohdasta.   

 

Valitaan Frame – kohta aktiiviseksi ja sen viereisistä pudotusvalikoista määritetään 

paperin kooksi ja asetteluksi A4 Landscape. Lisäksi valitaan mittakaavaksi 1:200.  

 

Määrätään paperille sijainti viereisestä Location – linkistä ja annetaan grafiikkaikkunassa 

kehyksen vasen alakulma. Uusi sijainti saadaan määrättyä valitsemalla Location → uusi 

sijainti.  

 

Valitaan myös kohdat Material table ja Info table aktiivisiksi, jolloin saadaan nimiö ja 

laskennassa käytetyt maaparametrit näkyviin.  
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Asetuksien jälkeen tulosteen tulisi näyttää samalta, kun alla:  

 

Tulostus tehdään valitsemalla piirtopöydän ylävalikosta File → Print.  

 

Ohjelma avaa tulostusikkunan, mistä ensimmäisenä kannattaa valita tulostin → Select 

Printer. Alla olevassa kuvassa on esitetty tulostusikkunan eri kohdat: 
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3.11 Laskennan lopetus 

 

Kun molemmat laskentavaiheet on laskettu, tallennettu ja tulostettu, voidaan 

laskentamoduuli ja GeoCalc – ohjelmisto sulkea.  

 

Suljetaan Stability – laskentamoduuli Calculation → Close.  

 

Suljetaan Novapoint GeoCalc piirtotilassa ylävalikosta File → Exit.  

 

 

 

 

 

 

 



115 

 

Liite 4. Penkereen painumat pehmeiköllä 

 

4.1 Lähtötiedot  

 

Tässä laskentaesimerkissä käydään painumalaskennan suorittamista pehmeikölle 

rakennetulle penkereelle. Lähtötiedot on annettu alla olevassa kuvassa. Tehtävänä on 

tehdä tarkastelu käyttörajatilassa, eli kaikki osavarmuuslukukertoimet ovat 1,0, ja 

painumaa tarkastellaan pelkästään pysyville kuormille (liikennekuormaa ei oteta 

huomioon).  

 

Laskentaesimerkin lopussa tehdään johtopäätökset saaduista tarkasteluista ja käydään 

läpi tulosten tulostaminen. 

 

 

- Pohjavesi sijaitsee savikerroksen yläpinnassa. 

- Liikennekuorman ominaisarvo 10 kN/m2 
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4.2 Käynnistys 

 

Aloitetaan tarkastelu käynnistämällä Novapoint GeoCalc – ohjelmisto ja tekemällä 

mahdollinen lisenssinvahvistus.  

 

Valitaan GeoCalc Startup – ikkunasta New Calculation → Settlement (suom. Uusi 

painumalaskenta). Ohjelma avaa Settlement – laskentamoduulin, minkä voi pienentää 

oikeasta yläkulmasta. Vaihtoehtoisesti Startup – ikkunan voi sulkea ja valita 

laskentamoduulin myöhemmin ylävalikosta Calculation → Settlement… 

 

4.3 Koordinaattiruudukko ja piirtoasetukset 

 

Laskenta aloitetaan muodostamalla laskentamalli. Mikäli sinulla on tallessa Liitteen 1 

laskentaesimerkissä ”Penkereen vakavuus pehmeiköllä” käytetty laskentamalli, voit 

suoraan avata sen ja aloittaa painumalaskennan. Tässä laskentaesimerkissä tarkastellaan 

samaa pengertä.  

 

Mikäli laskentamallia ei ole, tehdään se kuten ensimmäisessä laskentaesimerkissä 

”Penkereen vakavuus pehmeiköllä” (kts. Liite 1).  

 

Laskentamallin muodostamisen jälkeen avataan Settlement – laskentamoduuli. 

 

Laskentamoduuli koostuu välilehdistä, joihin syötetään laskennassa käytettäviä 

lähtötietoja. Tiedot täytetään käymällä välilehdet järjestyksessä läpi vasemmalta oikealle, 

kunnes päästään laskennan tuloksiin.  Laskentamoduulien eri kohdille saadaan melko 

kattavat suomenkieliset selitteet viemällä hiiri aina tarkasteltavan kohdan päälle.  

 

4.4 Poikkileikkauksen painumalaskenta käyttörajatilassa 

 

Käyttörajatilassa laskenta suoritetaan kuormituksien ja maaparametrien ominaisarvoilla.  

Suurin ero vakavuuslaskentaan on, että pengertä ei määritetä maakerrokseksi, vaan 

lisätään ulkoisena kuormituksena.   



117 

 

 

 

4.4.1 Laskennan yleiset tiedot 

 

 General – välilehdellä täytetään laskennan yleiset tiedot, kuten projektinumero, asiakas, 

laskija jne.   

 

 

 

Tallennetaan laskenta valitsemalla ylävalikosta Calculation → Save As... 

Painumalaskennat tallentuvat tiedostomuotoon ”*. gcse”.  

 

 

 

 

 

 

 

 

Tarvittaessa voidaan Default Values – painikkeesta muokata laskennassa yleisesti 

käytettäviä tietoja, kuten veden tilavuuspainoa.  

 

More – painikkeesta voidaan laskentaan liittää muistiinpanoja, huomautuksia ym.  

Piirtotilan saa päivitettyä Update – painikkeesta missä vaiheessa laskentaa tahansa. 
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4.4.2 Piirtoasetukset 

 

View – välilehdellä muokataan näyttöasetuksia, eli sitä, miten laskenta esitetään 

grafiikkaikkunassa ja tulostuksessa. Palataan näihin asetuksiin tarkemmin tulostusta 

tarkasteltaessa.  

 

 

4.4.3 Laskennan poikkileikkausgeometria 

 

Geometry-välilehdellä määritellään laskennassa käytettävien maakerrosten, kallion, 

pohjaveden ja orsiveden geometria poikkileikkauksessa.  

 

Määritellään eri maakerrosten rajat valitsemalla laskentamoduulin yläpalkista Geometry 

→ Select Soil Layer Polylines → From Top to Bottom. Komento sulkee 

laskentaikkunan ja seuraavaksi laskentamallista valitaan maakerrosrajat penkere mukaan 
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lukien järjestyksestä ylhäältä alas. Valittu viiva muuttaa värinsä keltaiseksi. Ohjelma 

muodostaa automaattisesti alimmasta valitusta viivasta kovan pohjan.  

 

Huomaa, että malliin piirrettyä pohjavedenpinnan rajaa ei valita tässä kohdassa! Jos 

pohjavedenpinta on kuitenkin valittu, painetaan Esc ja tehdään valinta uudestaan. Kun 

kaikki rajapinnat on valittu, painetaan Enter. Valittujen maakerrosten tulisi muuttua 

rasteroiduksi, jos View – välilehden Material – kohta on jätetty aktiiviseksi.  

 

 

Seuraavaksi valitaan pohjavedenpinta laskentamallista. Valinta tehdään kuten 

maakerrosrajojen valinta: Geometry → Select Ground Water Polyline. Valitaan 

laskentamallista savikerroksen yläpinta, jonka jälkeen viivan tulisi muuttua siniseksi.  
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4.4.4 Maakerrosten laskentaparametrit 

 

Material – välilehdellä määritellään äsken muodostettujen maakerrosten parametrit. 

Täytetään tiedot kuten alla olevassa kuvassa:   

 

Painumien laskentatapana käytetään siis Ohde – Janbun tangenttimoduulimenetelmä.  

 

Maaparametrit voidaan antaa suoraan välilehdillä oleville riveille, tai valitsemalla 

ylävalikosta Material → Parameters...  
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Ohjelma avaa Settlement Material parameters – ikkunan. Täytetään maakerroksien 

tiedot seuraavien kuvien mukaisesti:  

moduuliluku, jännityseksponentti, annettu konsolidaatiojännitys 

 

moduuliluku 

jännitys- 

eksponentti 

annettu  

konsolidaati

ojännitys 
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4.4.5 Kuormitus 

 

Load – välilehdellä määritellään penkereen maaperään aiheuttama kuormitus 

valitsemalla ylävalikosta Load → Add → Embankment Load..   

 

Ohjelma pyytää valitsemaan piste kerrallaan lisättävän pengerkuorman, ts. rajaamaan 

penkereen poikkileikkauksen. On tärkeää siis päättää pengerkuorman rajaus 

aloituspisteeseen, jolloin valinnasta tulee suljettu piiri.  

 

Valinnan jälkeen ohjelma avaa Value Dialog - ikkunan, mihin annetaan penkereen 

tilavuuspaino:  

 

 

Suljetaan ikkuna valitsemalla Ok.  

 

 

 

 

 

Kuorman lisäyksen jälkeen laskentamallin kuuluisi näyttää samalta, kuin alla olevassa 

kuvassa:  
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Määritetään seuraavaksi kuormahistoria valitsemalla Load → History, mistä ohjelma 

avaa Load History – ikkunan:  

 

Päätetään valinta arvojen syöttämisen jälkeen painamalla OK.  

 

 

 

4.4.6 Laskentapisteiden määrittäminen 

 

Aikaa vastaava 

kuormakerroin 

Kuormahistoria-

aika vuosina 

Rivien lisäys/ poisto 

Kuormahistoriatyyppi 

Yläreunan reunaehtotyyppi 

Alareunan reunanehtotyyppi 

Rakennusaika 

Tunnuspisteet (3D) 



125 

 

Point- välilehdellä määritetään seuraavaksi laskentapisteet, joiden kohdalla laskenta 

suoritetaan. Valitaan ylävalikosta Point → Add Pattern.  

 

Ohjelma avaa Settlement – Calculation points – ikkunan, mihin määritetään rajat, millä 

leveydellä painumalaskenta suoritetaan ja millaisella pistejaolla.  

 

Syötetään tiedot alla olevan kuvan mukaisesti, jolloin laskenta suoritetaan koko 

laskentamallin leveydellä, 1 metrin pistejaolla. Laskenta suoritetaan 97 metrin syvyyteen 

(huomaa, että puhutaan laskentamallin koordinaateista).  

 

 

Arvojen määrittämisen jälkeen suljetaan ikkuna painamalla OK.  

 

 

 

 

 

 

Tämän jälkeen näkymän tulisi Point – välilehdellä olla kuten alla:  

Yksittäisiä laskentapisteitä voidaan lisätä valitsemalla ylävalikosta Point → Add 

Points.., ja osoittamalla mallista mihin laskentapiste sijoitetaan.  
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Varmistetaan yllä olevasta näkymästä, että reunojen kuivatusehdot on määritelty vettä 

läpäiseviksi (engl. Permeable), jolloin vesi pääsee vapaasti liikkumaan.  

 

Kun kaikki arvot on syötetty, päivittää ohjelma laskentapisteet laskentamalliin.  

 

 

 

 

 

 

 

 

 

 

4.4.7 Laskenta 
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Calculate – välilehdellä määritellään laskennan asetukset ja käynnistetään laskenta.  

 

Tässä esimerkissä halutaan kokonaispainuman lisäksi aika-painuma-kuvaaja, miksi 

valitaan Primary consolidation aktiiviseksi.  

 

Määritetään pisimmäksi laskettavaksi konsolidaatioajaksi kohtaan Max time tässä 20 

vuotta.  

Näiden jälkeen painetaan Calculate – painiketta, jolloin ohjelma suorittaa laskennan.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.4.8 Tulokset 

Laskenta-ajat 
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Laskennan päätyttyä ohjelma avaa Result – välilehden, mihin on tulostunut maapohjaan 

muodostuvat painumat ja painekäyrät.  

 

Ikkunan alakulmasta pystytään säätämään eri osioiden näkyvyyttä poistamalla ruksi 

niiden edestä. Liukusäätimellä pystytään taas tarkastelemaan painekäyriä penkereen eri 

laskentapisteissä.  
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Tarkistetaan Report – välilehdeltä mihin laskentapisteeseen on aiheutunut suurimmat 

painumat valitsemalla Report Type: → Brief Calculation Report. Kokonaispainumat 

löytyvät raportin lopusta.  

 

 

Seuraavaksi katsotaan Graph – välilehdeltä aika-painuma-kuvaaja ko. pisteestä. 

Tarkastelupistettä vaihdetaan liukusäätimen avulla:  
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Laskenta saadaan tallennettua valitsemalla laskentamoduulin ylävalikosta Calculation 

→ Save. Stabiliteettilaskennat tallentuvat tiedostomuotoon ”*. gcse ”. Koska tässä 

laskentaesimerkissä tehdään useampia tarkasteluja, on jokainen tehdyistä laskennoista 

suositeltavaa tallentaa eri nimillä.  

 

4.5 Tulostus 

 

Käsitellään laskennan jälkeen tulostamista ja palataan Stability – laskentamoduulissa 

välilehdelle View.  

 

Muutetaan Material – kohdassa materiaalin rasterointi tulosteelle vähemmän raskaaksi, 

esim. ruudukoksi (engl. cross). Vaihtoehtoisesti rasteroinnin voi jättää kokonaan pois 

poistamalla rasti pois Material kohdasta.   

 

Valitaan Frame – kohta aktiiviseksi ja sen viereisistä pudotusvalikoista määritetään 

paperin kooksi ja asetteluksi A4 Landscape. Lisäksi valitaan mittakaavaksi 1:200.  

 

Määrätään paperille sijainti viereisestä Location – linkistä ja annetaan grafiikkaikkunassa 

kehyksen vasen alakulma. Uusi sijainti saadaan määrättyä valitsemalla Location → uusi 

sijainti.  
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Valitaan myös kohdat Material table ja Info table aktiivisiksi, jolloin saadaan nimiö ja 

laskennassa käytetyt maaparametrit näkyviin.  

 

Asetuksien jälkeen tulosteen tulisi näyttää samalta, kun alla:  

 

Tulostus tehdään valitsemalla piirtopöydän ylävalikosta File → Print.  

 

Ohjelma avaa tulostusikkunan, mistä ensimmäisenä kannattaa valita tulostin → Select 

Printer. Alla olevassa kuvassa on esitetty tulostusikkunan eri kohdat: 
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4.6 Laskennan lopetus 

 

Kun molemmat laskentavaiheet on laskettu, tallennettu ja tulostettu, voidaan 

laskentamoduuli ja GeoCalc – ohjelmisto sulkea.  

 

Suljetaan Stability – laskentamoduuli Calculation → Close.  

 

Suljetaan Novapoint GeoCalc piirtotilassa ylävalikosta File → Exit.  
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Liite 5. Anturan painumat 

 

5.1 Lähtötiedot 
 

Seuraavassa laskentaesimerkissä tarkastellaan seinäanturan maapohjaan aiheuttamia 

painumia. Anturan painumia tarkastellaan käyttörajatilassa huomioiden vain pysyvät 

kuormitukset.  

 

- Pintamaata poistetaan 0,3 metriä ja tilalle tulee 0,6 m paksu laaja-alainen täyttö 

- Seinäanturan ominaiskuorma 95 kN/m 

- Pohjavedenpinta sijaitsee ensimmäisen hiekkakerroksen puolessa välissä 

- Hiekkakerrosten alla on kova moreeni 

 

 

 

 

Pintamaa: 

γ = 15 kN/m3 

 

Laaja-alainen täyttö:  

γ = 20 kN/m3 

 

Hiekka1: 

γ = 17 kN/m3 

m = 50 

β = 0,5 

 

Hiekka2: 

γ = 17,5 kN/m3 

m = 150 

β = 0,5 
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5.2 Käynnistys 

 

Aloitetaan tarkastelu käynnistämällä Novapoint GeoCalc – ohjelmisto ja tekemällä 

mahdollinen lisenssinvahvistus.  

 

Valitaan GeoCalc Startup – ikkunasta New Calculation → Settlement (suom. Uusi 

painumalaskenta). Ohjelma avaa Settlement – laskentamoduulin, minkä voi pienentää 

oikeasta yläkulmasta. Vaihtoehtoisesti Startup – ikkunan voi sulkea ja valita 

laskentamoduulin myöhemmin ylävalikosta Calculation → Settlement… 

 

Aloitetaan laskenta käymällä läpi ensin piirtoasetukset, joissa määritellään koordinaatti- 

ja piirtoruudukko, sekä tartuntapisteiden ja piirtoverkon pisteiden välit.  

 

5.3 Koordinaattiruudukko 

 

Ensimmäiseksi määritellään piirtoalueelle koordinaattiruudukko valitsemalla 

Calculation → Set working area.  

 

Placement – kohdasta määritetään koordinaattiruudukon vasen alakulma. Valitaan Pick 

Point ja kirjoitetaan alkutilanteen kuvan mukaisesti 0, 0 (x, y). Vaihtoehtoisesti voidaan 

em. koordinaatit kirjoittaa suoraan ikkunassa Placement → Lower left corner 

coordinates – kohtaan.  
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Grid – kohdasta määritetään koordinaattiruudukon koko ja väri.  

 

Text – kohdasta määritetään tekstin tyyli, koko ja väri.  

 

Piirrettyä koordinaattiruudukkoa voidaan tarvittaessa muokata Set working area – 

ikkunasta ja tarvittaessa poistettua painamalla Remove – painiketta.  

 

Valitaan tässä harjoituksessa yllä olevan kuvan mukaiset arvot. Kun arvot on muutettu, 

painetaan Draw ja poistutaan ikkunasta painamalla Close. Työalueelle tulisi ilmestyä alla 

olevan kuvan mukainen ruudukko.  

 

 

5.4 Piirtoasetukset 

Seuraavaksi muokataan käytettävien tartuntapisteiden ja piirtoverkon pisteiden välit, 

valitsemalla grafiikkaikkunan ylävalikosta Tools → Options.  



136 

 

Options – näkymässä määritellään tartuntapisteiden välit (Snap) ja piirtoverkon välit 

(Grid). Näihin kannattaa asettaa samat arvot, esim. 0,5 tai 1, riippuen millä tarkkuudella 

osoittimen tartuntavälit halutaan.  

 

Modify grid limits – kohdassa määritellään piirtoverkon koko. Piirtoverkko kannattaa 

yleensä asettaa saman kokoiseksi, kuin aiemmin määritetty koordinaattiruudukko. 

Tällöin piirtoverkon koko annetaan kirjoittamalla alapalkissa olevalle komentoriville 

ensin vasemman alakulman koordinaatit (0, 0) → Enter → Oikean yläkulman 

koordinaatit (0,30) → Enter.  

 

Vaihtoehtoisesti piirtoruudukko voidaan antaa klikkaamalla koordinaattiruudukon 

kulmia tartuntatyökalujen Osnap -komento päällä. Jotta muutokset tulevat voimaan 

painetaan näkymästä Apply ja poistutaan painamalla Ok.  

 

Näkymän ei tulisi muuttua tämän jälkeen.  

 

Äsken määritellyt tartuntavälit (Snap) ja piirtoverkon välit (Grid) saadaan voimaan 

piirtotilassa klikkaamalla tartuntatyökalujen Snap- ja Grid – toiminnot aktiivisiksi.  

 

 

 

 

 

 

 

Snap – ja Grid – toimintojen käyttö voi joissakin laskennan vaiheissa vaikeuttaa 

haluttujen pisteiden valintaa, koska tartunnat tehdään äsken Options – ikkunaan 

asetetuilla tarkkuuksilla.  

 

Tämän vuoksi voi tartuntatyökaluista Osnap – tartunnan käyttö olla kätevämpää. 

Kun Osnap valitaan aktiiviseksi, avaa ohjelma erillisen ikkunan, mistä voidaan 

valita halutut tartuntapisteet (esim. kohta endpoint hakee tartunnan viivojen 

päätepisteistä).  
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5.5 Laskentamallin piirtäminen 

 

Piirtoasetuksien määrittämisen jälkeen voidaan tehdä laskentamalli tarkasteltavasta 

tilanteesta. GeoCalc:ssa piirretyt laskentamallit tallennetaan erikseen omaksi 

tiedostokseen (tiedostomuodo *.vdf) ja varsinainen laskenta suoritetaan laskentamallin 

”päällä”. Samalle laskentamallille voidaan tehdä siis useampi tarkastelu, eikä sitä 

välttämättä tarvitse luoda aina erikseen.  

 

Piirretään alla olevan esimerkkikuvan mukaiset maakerrokset koordinaattipisteiden 

avulla. Huomaa, että malliin piirretään maakerrokset vain kaivuun leikkauspintaan asti.  

 

 

Valitaan työkalupaletista Polyline – komento →, tai valikosta Draw → Polyline.  

 

Jos Polyline – komentoa ei löydy suoraan valintaikkunan työkalurivistä, voidaan 

Draw – toolbar asettaa näkyville valitsemalla View → Toolbars → Draw.  

 

Laskentamallin toimimisen kannalta on sen piirtämisessä tärkeää, että 

- Mallin viivat esim. maakerrosrajat ovat piirretty polyline –komennolla. 

Ohjelma ei tunnista muita viivoja. 

- Mallin viivat piirretään vasemmalta oikealle 

- Mallin viivat eivät saa mennä ristiin. Viivat voivat olla päällekkäin.  
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Viiva voidaan piirtää valitsemalla sijaintipisteet suoraan koordinaattiruudukosta 

osoittimella, tai kirjaamalla sijaintipisteet komentoriville esim. 0,0 → Enter → 30,0 → 

Enter… jne. Viiva päätetään painamalla näppäimistöltä Enter tai Esc –painiketta. 

Toiminto aloitetaan uudelleen jokaisen viivan päätyttyä. 

 

Maakerrosten tulisi valmiina näyttää seuraavalta:  

 

 

 

Mallin ollessa valmis tallennetaan se valikosta File → Save As. Tarkistetaan, että 

tiedostomuoto on vdf – muotoa.  

 

Mallin piirtämisen sijaan voidaan GeoCalc – ohjelmaan myös avata olemassa oleva 

DWG – tiedosto (eli esim. AutoCad:lla piirretty tiedosto). Tällöinkin on 

huomioitava, että laskentamalli muodostuu polyline – viivoista. Lisäksi silloin 

määritellään koordinaatiston sijainti Calculation → Set Coordinates → kirjataan 

komentoriville 0,0,0. 

 

Huomaa, että koordinaatteja syöttäessä x-, y- ja z-koordinaatit erotetaan toisistaan 

pilkulla (esim. 0, 0, 0) ja koordinaattien desimaalit pisteellä (esim. 0, 1.5, 0). 

 

Poikkileikkauksia piirtäessä ei z – koordinaatin käyttö ole kuitenkaan tarpeellista, 

miksi arvot voidaan syöttää pelkillä x- ja y – koordinaateilla.   

  



139 

 

5.6 Eurokoodien mukainen käyttörajatilamitoitus  

 

Laskentamallin muodostamisen jälkeen avataan Settlement – laskentamoduuli. 

 

Laskentamoduuli koostuu välilehdistä, joihin syötetään laskennassa käytettäviä 

lähtötietoja. Tiedot täytetään käymällä välilehdet järjestyksessä läpi vasemmalta oikealle, 

kunnes päästään laskennan tuloksiin.  Laskentamoduulien eri kohdille saadaan melko 

kattavat suomenkieliset selitteet viemällä hiiri aina tarkasteltavan kohdan päälle.  

 

 

5.6.1 Laskennan yleiset tiedot 

 

 General – välilehdellä täytetään laskennan yleiset tiedot, kuten projektinumero, asiakas, 

laskija jne.   

 

 

Tallennetaan laskenta valitsemalla ylävalikosta Calculation → Save As... 

Painumalaskennat tallentuvat tiedostomuotoon ”*. gcse”.  

 

 

 

Tarvittaessa voidaan Default Values – painikkeesta muokata laskennassa yleisesti 

käytettäviä tietoja, kuten veden tilavuuspainoa.  

 

More – painikkeesta voidaan laskentaan liittää muistiinpanoja, huomautuksia ym.  

Piirtotilan saa päivitettyä Update – painikkeesta missä vaiheessa laskentaa tahansa. 
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5.6.2 Piirtoasetukset 

 

View – välilehdellä muokataan näyttöasetuksia, eli sitä, miten laskenta esitetään 

grafiikkaikkunassa ja tulostuksessa. Palataan näihin asetuksiin tarkemmin tulostusta 

tarkasteltaessa.  

 

5.6.3 Laskennan poikkileikkausgeometria 

 

Geometry-välilehdellä määritellään laskennassa käytettävien maakerrosten, kallion, 

pohjaveden ja orsiveden geometria poikkileikkauksessa.  

 

Määritellään eri maakerrosten rajat valitsemalla laskentamoduulin yläpalkista Geometry 

→ Select Soil Layer Polylines → Free Order. Komento sulkee laskentaikkunan ja 

seuraavaksi laskentamallista valitaan maakerrosrajat vapaassa järjestyksessä. Valittu 

viiva muuttaa värinsä keltaiseksi. Ohjelma muodostaa automaattisesti alimmasta valitusta 

viivasta kovan pohjan.  

 

Huomaa, että malliin piirrettyä pohjavedenpinnan rajaa ei valita tässä kohdassa! Jos 

pohjavedenpinta on kuitenkin valittu, painetaan Esc ja tehdään valinta uudestaan. Kun 
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kaikki rajapinnat on valittu, painetaan Enter. Valittujen maakerrosten tulisi muuttua 

rasteroiduksi, jos View – välilehden Material – kohta on jätetty aktiiviseksi.  

Maakerrosten poistaminen ja lisääminen onnistuvat myös jälkikäteen. Jos on valittu 

esimerkiksi vahingossa pohjavedenpinta – viiva geometrian valintaa tehdessä, 

ohjelma määrittää yhden ylimääräisen maakerroksen.  

 

 

 

Poistetaan maakerros valitsemalla laskentamoduulin yläikkunasta Geometry → 

Remove → Soil layer. Minkä jälkeen näytetään poistettava rajapinta. Tässä 

tapauksessa siis pohjavedenpinta. Ohjelma poistaa valitun rajapinnan ja liittää sen 

yläpuoliseen maakerrokseen.  

 

 

 

Vastaavasti maakerroksia pystytään lisäämään jälkikäteen valitsemalla Geometry 

→ Add Soil Layer. Minkä jälkeen näytetään lisättävä rajapinta. Ohjelma lisää 

automaattisesti uuden maakerroksen valitun ja alemman maakerroksen rajapinnan 

välille.  
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Seuraavaksi valitaan pohjavedenpinta laskentamallista. Valinta tehdään kuten 

maakerrosrajojen valinta: Geometry → Select Ground Water Polyline. Valitaan 

laskentamallista savikerroksen yläpinta, jonka jälkeen viivan tulisi muuttua siniseksi.  

 

 

 

5.6.4 Maakerrosten laskentaparametrit 

 

Material – välilehdellä määritellään äsken muodostettujen maakerrosten parametrit. 

Täytetään tiedot kuten alla olevassa kuvassa:   

 

Painumien laskentatapana käytetään siis Ohde – Janbun tangenttimoduulimenetelmä.  
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Maaparametrit voidaan antaa suoraan välilehdillä oleville riveille, tai valitsemalla 

ylävalikosta Material → Parameters...  

 

Ohjelma avaa Settlement Material parameters – ikkunan. Täytetään maakerroksien 

tiedot seuraavien kuvien mukaisesti:  
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5.6.5 Kuormitus 

 

Load – välilehdellä määritellään anturan ja laaja-alaisen täytön maaperään aiheuttamat 

kuormitukset.    

 

Lisätään ensin laaja-alaisen täytön aiheuttama kuormitus valitsemalla Load → Add.. → 

Equally distributed extensive load. Tämän jälkeen komentorivillä pyydetään 

valitsemaan kuormituksen sijaintipinta. Valitaan siis maanpinta.  

 

Ohjelma avaa Value Dialog – ikkunan, mihin määritetään täytön aiheuttama kuormitus 

(20kN/m3 · 0,6 m = 12 kN/m2):  

 

 

Suljetaan ikkuna painamalla OK.  

Huomaa, että molempiin kerroksiin annetaan ylikonsolidaation vakioarvoksi 

4,5 kN/m2. Tämä johtuu poistetusta pintamaasta, jonka aiheuttama 

konsolidaatiojännitys on 15 kN/m3·0,3 m = 4,5 kN/m2 
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Tämän jälkeen laskentamallin kuuluisi näyttää alla olevan kuvan mukaiselta:  

 

 

Seuraavaksi määritetään anturan aiheuttama kuormitus valitsemalla Load → Add.. → 

Equally distributed strip load. Tämän jälkeen komentorivillä pyydetään valitsemaan 

kuormituksen vasen alakulma. Valitaan piste laskentamallin keskeltä (x – akselilta 15).  

 

 

Tämän jälkeen pyydetään antamaan kuorman sijainnin oikea kulma. Anturan leveys on 

0,6 m, joten kirjataan uudet koordinaatit (15.6,7.7).  
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Tämän jälkeen ohjelma avaa Value Dialog – ikkuna, mihin määritetään anturan 

aiheuttama kuormitus (95 kN/m / 0,6 m = 158,3 kN/m2):  

 

Suljetaan ikkuna painamalla Ok.  

 

Load – välilehdelle tulevat näkyviin jokainen lisätyistä kuormista.  

 

Kuormituksen leveyden ja sijainnin voi tarkistaa valitsemalla laskentamoduulin valikosta 

Load → Location. Ohjelma avaa Settlement Load Geometries – ikkunan välilehdellä 

aktiivisena olevasta kuormituksesta. Tästä voidaan muokata anturakuormitus 

sijaitsemaan keskelle laskentamallia kohdassa Center X:  
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Kuormituksen (eli anturan) leveyttä pystytään muuttamaan kohdassa Load width.  

 

Suljetaan ikkuna valitsemalla OK.  

 

Kuormien lisäämisen jälkeen laskentamallin tulisi näyttää samalta, kuin alla olevassa 

kuvassa:  

 

Määritetään seuraavaksi kuormahistoria valitsemalla Load → History, mistä ohjelma 

avaa Load History – ikkunan:  

 

Aikaa vastaava 

kuormakerroin 

Kuormahistoria-

aika vuosina 

Rivien lisäys/ poisto 

Kuormahistoriatyyppi 

Yläreunan reunaehtotyyppi 

Alareunan reunanehtotyyppi 

Rakennusaika 

Tunnuspisteet (3D) 
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Päätetään valinta arvojen syöttämisen jälkeen painamalla OK.  

 

5.6.6 Laskentapisteiden määrittäminen 

 

Point- välilehdellä määritetään seuraavaksi laskentapisteet, joiden kohdalla laskenta 

suoritetaan. Valitaan ylävalikosta Point → Add Pattern.  

 

Ohjelma avaa Settlement – Calculation points – ikkunan, mihin määritetään rajat, millä 

leveydellä painumalaskenta suoritetaan ja millaisella pistejaolla.  

 

Syötetään tiedot alla olevan kuvan mukaisesti, jolloin laskenta suoritetaan koko 

laskentamallin leveydellä, 1 metrin pistejaolla. Laskenta suoritetaan 8 metrin syvyyteen 

asti.  

 

 

Arvojen määrittämisen jälkeen suljetaan ikkuna painamalla OK.  

 

 

Yksittäisiä laskentapisteitä voidaan lisätä valitsemalla ylävalikosta Point → Add 

Points.., ja osoittamalla mallista mihin laskentapiste sijoitetaan.  
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Tämän jälkeen näkymän tulisi Point – välilehdellä olla kuten alla:  

 

Varmistetaan yllä olevasta näkymästä, että reunojen kuivatusehdot on määritelty vettä 

läpäiseviksi (engl. Permeable), jolloin vesi pääsee vapaasti liikkumaan.  

 

Kun kaikki arvot on syötetty, päivittää ohjelma laskentapisteet laskentamalliin.  
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5.6.7 Laskenta 

 

Calculate – välilehdellä määritellään laskennan asetukset ja käynnistetään laskenta.  

 

Tässä esimerkissä lasketaan kitkamaan kokonaispainumaa miksi valitaan Drained 

Calculation.  

 

Näiden jälkeen painetaan Calculate – painiketta, jolloin ohjelma suorittaa laskennan.  

 

5.6.8 Tulokset 

 

Laskennan päätyttyä ohjelma avaa Result – välilehden, mihin on tulostunut maapohjaan 

muodostuvat painumat ja painekäyrät.  

 

Laskettaessa painumia koheesiomaalajeille valitaan Primary consolidation, jolloin 

saadaan myös aika-painuma-kuvaaja.  
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Ikkunan alakulmasta pystytään säätämään eri osioiden näkyvyyttä poistamalla ruksi 

niiden edestä. Liukusäätimellä pystytään taas tarkastelemaan painekäyriä penkereen eri 

laskentapisteissä.  

 

Tarkistetaan Report – välilehdeltä mihin laskentapisteeseen on aiheutunut suurimmat 

painumat valitsemalla Report Type: → Brief Calculation Report. Kokonaispainumat 

löytyvät W – sarakkeelta.  

 

 

Laskenta saadaan tallennettua valitsemalla laskentamoduulin ylävalikosta Calculation 

→ Save. Stabiliteettilaskennat tallentuvat tiedostomuotoon ”*. gcse ”. Koska tässä 

laskentaesimerkissä tehdään useampia tarkasteluja, on jokainen tehdyistä laskennoista 

suositeltavaa tallentaa eri nimillä.  

 

 

 

 

 

 

 

 



152 

 

5.6.9 Tulostus 

 

Käsitellään laskennan jälkeen tulostamista ja palataan Stability – laskentamoduulissa 

välilehdelle View.  

 

Muutetaan Material – kohdassa materiaalin rasterointi tulosteelle vähemmän raskaaksi, 

esim. ruudukoksi (engl. cross). Vaihtoehtoisesti rasteroinnin voi jättää kokonaan pois 

poistamalla rasti pois Material kohdasta.   

 

Valitaan Frame – kohta aktiiviseksi ja sen viereisistä pudotusvalikoista määritetään 

paperin kooksi ja asetteluksi A4 Landscape. Lisäksi valitaan mittakaavaksi 1:200.  

 

Määrätään paperille sijainti viereisestä Location – linkistä ja annetaan grafiikkaikkunassa 

kehyksen vasen alakulma. Uusi sijainti saadaan määrättyä valitsemalla Location → uusi 

sijainti.  

 

Valitaan myös kohdat Material table ja Info table aktiivisiksi, jolloin saadaan nimiö ja 

laskennassa käytetyt maaparametrit näkyviin.  

 

Koska materiaalien parametritaulukko on melko pitkä, menee se hieman päällekkäin 

nimiön kanssa. Taulukkoa saa siirrettyä valitsemalla Move – komento joko 

työkalupaletista, tai piirtoalustan valikosta Modify → Move.  
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Asetuksien jälkeen tulosteen tulisi näyttää samalta, kun alla:  

 

 

Tulostus tehdään valitsemalla piirtopöydän ylävalikosta File → Print.  

 

Ohjelma avaa tulostusikkunan, mistä ensimmäisenä kannattaa valita tulostin → Select 

Printer. Alla olevassa kuvassa on esitetty tulostusikkunan eri kohdat: 
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4.7 Laskennan lopetus 

 

Kun molemmat laskentavaiheet on laskettu, tallennettu ja tulostettu, voidaan 

laskentamoduuli ja GeoCalc – ohjelmisto sulkea.  

 

Suljetaan Stability – laskentamoduuli Calculation → Close.  

 

Suljetaan Novapoint GeoCalc piirtotilassa ylävalikosta File → Exit.  
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Liite 6. Pilaristabilointi 

 

 

5.1 Lähtötiedot 

 

Tässä laskentaesimerkissä testataan Novapoint GeoCalcin käyttöä pilaristabiloinnin 

mitoituksessa. Mitoitetaan pilaristabilointi alla kuvatussa tilanteessa:  

 

 

 

 

 

 

 

 

 

- Vastapenkereille ei ole tilaa 

- Sideaine on kalkkisementtiä (kalkkia 50 %) 

- Pilarin leikkauslujuus on τ = 100 kN/m2 

- Pilarin muodonmuutosmoduulina käytetään 150 kertaista leikkauslujuuden arvoa  

150τ = E 

- Pilarin ja maan vedenjohtavuus on100 % 

 

 

 

 

 

 

 

Pehmeä savi: 

Normaalikonsolidoitunut 

su = 9 kN/m2 

γ = 5 kN/m3 

M = 550 

Kuivakuori: 

Ylikonsolidoitunut 

su = 25 kN/m2 

γ = 18 kN/m3 

m1 = 20 

β1 = 0,5  

m2 = 50 

β2 = 0  

 

Penger: 

γ = 20 kN/m3 
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5.2 Käynnistys 

 

Käynnistetään Novapoint GeoCalc – ohjelma ja tehdään mahdollinen lisenssinvahvistus. 

Oppilaitoksissa valitaan yleensä vaihtoehto Novapoint 16 licensing. 

 

Valitaan GeoCalc Startup – ikkunasta New Calculation → Stability (suom. Uusi 

stabiliteettilaskenta). Ohjelma avaa Stability – laskentamoduulin, minkä voi pienentää 

ikkunan oikeasta yläkulmasta. Vaihtoehtoisesti Startup – ikkunan voi sulkea ja valita 

laskentamoduulin myöhemmin ylävalikosta Calculation → Deep Stabilization... 

 

Aloitetaan laskenta käymällä läpi ensin piirtoasetukset, joissa määritellään koordinaatti- 

ja piirtoruudukko, sekä tartuntapisteiden ja piirtoverkon pisteiden välit.  

 

5.3 Koordinaattiruudukko 

 

Ensimmäiseksi määritellään piirtoalueelle koordinaattiruudukko valitsemalla 

Calculation → Set working area.  

 

Placement – kohdasta määritetään koordinaattiruudukon vasen alakulma. Valitaan Pick 

Point ja kirjoitetaan komentoriville arvoksi 0, 0, 0 (x, y, z), koska tarkempia 

koordinaatteja ei ole annettu. Vaihtoehtoisesti voidaan em. koordinaatit kirjoittaa suoraan 

kohtaan Placement → Lower left corner coordinates. 
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Grid – kohdasta määritetään koordinaattiruudukon koko ja väri.  

 

Text – kohdasta määritetään tekstin tyyli, koko ja väri.  

 

Piirrettyä koordinaattiruudukkoa voidaan tarvittaessa muokata Set working area – 

ikkunasta ja tarvittaessa poistettua painamalla Remove – painiketta.  

 

Valitaan tässä harjoituksessa yllä olevan kuvan mukaiset arvot. Kun arvot on muutettu, 

painetaan Draw ja poistutaan ikkunasta painamalla Close. Työalueelle tulisi ilmestyä alla 

olevan kuvan mukainen ruudukko.  

 

 

 

5.4 Piirtoasetukset  

 

Seuraavaksi muokataan käytettävien tartuntapisteiden ja piirtoverkon pisteiden välit, 

valitsemalla grafiikkaikkunan ylävalikosta Tools → Options.  
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Options – näkymässä määritellään tartuntapisteiden välit (Snap) ja piirtoverkon välit 

(Grid). Näihin kannattaa asettaa samat arvot, esim. 0,5 tai 1, riippuen millä tarkkuudella 

osoittimen tartuntavälit halutaan.  

 

Modify grid limits – kohdassa määritellään piirtoverkon koko. Piirtoverkko kannattaa 

yleensä asettaa saman kokoiseksi, kuin aiemmin määritetty koordinaattiruudukko. 

Tällöin piirtoverkon koko annetaan kirjoittamalla alapalkissa olevalle komentoriville 

ensin vasemman alakulman koordinaatit (0, 0, 0) → Enter → Oikean yläkulman 

koordinaatit (40, 20, 0) → Enter.  

 

Vaihtoehtoisesti piirtoruudukko voidaan antaa klikkaamalla koordinaattiruudukon 

kulmia tartuntatyökalujen Osnap -komento päällä. Jotta muutokset tulevat voimaan 

painetaan näkymästä Apply ja poistutaan painamalla Ok.  

 

Näkymän ei tulisi muuttua tämän jälkeen.  

 

 

5.5 Laskentamallin piirtäminen 

 

Piirtoasetuksien määrittämisen jälkeen voidaan tehdä laskentamalli tarkasteltavasta 

tilanteesta. GeoCalc:ssa piirretyt laskentamallit tallennetaan erikseen omaksi 

tiedostokseen (tiedostomuodo *.vdf) ja varsinainen laskenta suoritetaan laskentamallin 

”päällä”. Samalle laskentamallille voidaan tehdä siis useampi tarkastelu, eikä sitä 

välttämättä tarvitse luoda aina erikseen.  

Laskentamallin toimimisen kannalta on sen piirtämisessä tärkeää, että 

- Mallin viivat esim. maakerrosrajat ovat piirretty polyline –komennolla. 

Ohjelma ei tunnista muita viivoja. 

- Mallin viivat piirretään vasemmalta oikealle 

- Mallin viivat eivät saa mennä ristiin. Viivat voivat olla päällekkäin.  

 

Äsken määritellyt tartuntavälit (Snap) ja piirtoverkon välit (Grid) saadaan voimaan 

piirtotilassa klikkaamalla tartuntatyökalujen Snap- ja Grid – toiminnot aktiivisiksi.  
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Piirretään alla olevan esimerkkikuvan mukaiset maakerrokset koordinaattipisteiden 

avulla.  

 

Valitaan työkalupaletista Polyline – komento →, tai valikosta Draw → Polyline.  

 

Viiva voidaan piirtää valitsemalla sijaintipisteet suoraan koordinaattiruudukosta 

osoittimella, tai kirjaamalla sijaintipisteet komentoriville esim. 0, 0 → Enter → 50, 0 → 

Enter… jne. Viiva päätetään painamalla näppäimistöltä Enter tai Esc –painiketta. 

Toiminto aloitetaan uudelleen jokaisen viivan päätyttyä. 

  

 

Poikkileikkauksen tulisi valmiina näyttää seuraavalta:  

Jos Polyline – komentoa ei löydy suoraan valintaikkunan työkalurivistä, voidaan 

Draw – toolbar asettaa näkyville valitsemalla View → Toolbars → Draw.  

 

Huomaa, että koordinaatteja syöttäessä x-, y- ja z-koordinaatit erotetaan toisistaan 

pilkulla (esim. 0, 0, 0) ja koordinaattien desimaalit pisteellä (esim. 0, 0.5, 0). 
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Mallin ollessa valmis tallennetaan se piirtotilan ylävalikosta File → Save As. 

Tarkistetaan, että tiedostomuoto on vdf – muotoa.  

 

 

 

5.6 Pilaristabiloinnin mitoitus Liikenneviraston ohjeen mukaisesti 

 

Tässä laskentaesimerkissä kokeillaan pilaristabiloinnin mitoittamista Novapoint GeoCalc 

– ohjelmistolla Liikenneviraston ohjeen 11/2010 Syvästabiloinnin suunnitteluohje 

mukaisesti.  

 

Mallin piirtämisen jälkeen voidaan aloittaa varsinainen mitoittaminen. Avataan joko 

Startup – ikkunassa valittu stabiliteettimoduuli, tai valitaan moduuli piirtotilan 

ylävalikosta Calculation → Deep Stabilization.  

 

Stabiliteettimoduuli koostuu välilehdistä, joihin syötetään laskennassa käytettäviä 

lähtötietoja. Tiedot täytetään käymällä välilehdet järjestyksessä läpi vasemmalta oikealle, 

kunnes päästään laskennan tuloksiin.  Laskentamoduulien eri kohdille saadaan melko 

kattavat suomenkieliset selitteet viemällä hiiri aina tarkasteltavan kohdan päälle.  

 

 

 

 

 

 

 

 

 

 

Mallin piirtämisen sijaan voidaan GeoCalc – ohjelmaan myös avata olemassa oleva 

DWG – tiedosto (eli esim. AutoCad:lla piirretty tiedosto). Tällöinkin on 

huomioitava, että laskentamalli muodostuu polyline – viivoista. Lisäksi silloin 

määritellään koordinaatiston sijainti Calculation → Set Coordinates → kirjataan 

komentoriville 0,0,0. 
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5.6.1 Laskennan yleiset tiedot 

 

 General – välilehdellä täytetään laskennan yleiset tiedot, kuten projektinumero, asiakas, 

laskija jne.   

 

 

 

5.6.2 Piirtoasetukset 

 

View – välilehdellä muokataan näyttöasetuksia, eli sitä, miten laskenta esitetään 

grafiikkaikkunassa ja tulostuksessa. Palataan näihin asetuksiin tarkemmin tulostusta 

tarkasteltaessa.  

 

Ohjelman käyttökieli on englanti, mutta viemällä osoittimen eri toimintojen päälle, 

saadaan niille melko kattavat suomenkieliset selitteet.  

 

More – painikkeesta voidaan laskentaan liittää muistiinpanoja, huomautuksia ym.  

Piirtotilan saa päivitettyä Update – painikkeesta missä vaiheessa laskentaa tahansa. 
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5.6.3 Laskennan poikkileikkausgeometria 

 

Geometry-välilehdellä määritellään laskennassa käytettävien maakerrosten, kallion, 

pohjaveden ja orsiveden geometria poikkileikkauksessa.  

 

Määritellään eri maakerrosten rajat valitsemalla laskentamoduulin yläpalkista Geometry 

→ Select Soil Layer Polylines → From Top to Bottom. Komento sulkee 

laskentaikkunan ja seuraavaksi laskentamallista valitaan maakerrosrajat penkere mukaan 

lukien järjestyksestä ylhäältä alas. Valittu viiva muuttaa värinsä keltaiseksi. Ohjelma 

muodostaa automaattisesti alimmasta valitusta viivasta kovan pohjan.  

 

 

Maakerrosrajat voidaan valita myös vapaassa järjestyksessä valitsemalla 

ylävalikosta Geometry → Select Soil Layer Polylines → Free Order.. 

 

Tämän jälkeen voidaan maakerrosrajat valita vapaassa järjestyksessä.  
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Huomaa, että malliin piirrettyä pohjavedenpinnan rajaa ei valita tässä kohdassa! Jos 

pohjavedenpinta on kuitenkin valittu, painetaan Esc ja tehdään valinta uudestaan. Kun 

kaikki rajapinnat on valittu, painetaan Enter. Valittujen maakerrosten tulisi muuttua 

rasteroiduksi, jos View – välilehden Material – kohta on jätetty aktiiviseksi.  

 

5.6.4 Materiaaliparametrit 

 

Siirrytään Material – välilehdelle täyttämään maakerrosten parametrit. Kaikki parametrit 

täytetään suoraan välilehdelle, kuten alla olevissa kuvissa:  
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5.6.5 Pilarit 

 

Siirrytään Columns – välilehdelle määrittämään tehtävän pilaristabiloinnin sijainti, 

syvyys ja pilareiden mitat:  

 

 

Pilareiden sijainti määritetään joko kirjaamalla suoraan kohtaan Stabilization column 

zones tunnetut X – koordinaatit. Vaihtoehtoisesti voidaan sijainti määrittää valitsemalla 

Define, jonka jälkeen näytetään ensin stabiloitavan osan alkamispiste ja sitten loppupiste. 

 

Sijoitetaan stabilointi penkereen kohdalle valitsemalla ensin sen luiskan vasen 

alkamiskohta ja sitten oikea päättymiskohta. 
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Tämän jälkeen laskentamallin tulisi näyttää samalta, kun alla olevassa kuvassa:  

 

 

Ohjelma saattaa lisätä samalla automaattisesti nauhakuorman pilaroitavalle kohdalle. 

Tämä kuitenkin muokataa Load – välilehdellä vastaamaan oikeaa tilannetta.   

  

5.6.6 Kuormitus 

 

Load – välilehdellä muokataan kuormitusta vastaamaan penkereen maapohjaan 

aiheuttamaa kuormitusta. Koska penkereen tilavuuspaino on 20 kN/m3 ja korkeus 2,5 

metriä, on sen aiheuttama kuormitus enintään 50 kN/m2.  

 

Määritetään penkereen aiheuttama kuormitus:  
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5.6.7 Laskenta 

 

Siirrytään Calculate – välilehdelle suorittamaan laskenta.  

 

 

Valitaan kohta Variate → Variate c/c-span aktiiviseksi.  

 

Käynnistetään laskenta valitsemalla Calculate.  

 

 

5.6.8 Tulokset  

 

Ohjelma avaa automaattisesti laskennan päätyttyä Result – lehden, missä se näyttää 

laskemansa tuloksen lähtöarvona annettuna keskeltä – keskelle – mittana.  
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Huomataan, että ohjelma on muuttanut pilarien värin punaiseksi ja ilmoittaa pilareiden 

myötäävän, ts. pilareiden tiheyttä täytyy suurentaa. Vaihtoehtoisesti voidaan kasvattaa 

pilareiden lujuutta.  

 

 Ikkunan alareunasta löytyy kohdasta c/c span alasvetovalikko, mistä voidaan tarkastella 

tuloksia muille keskeltä – keskelle – mitoille. Valitaan esimerkiksi astetta pienempi k – k 

– mitta 0,8 m.  

 

Huomataan, että pilarit ovat pysyneet kimmoisina, jolloin mitoitus toimii tällä k/k-

mitalla. Vertaillaan tarkemmin muita tuloksia Graph, Report ja Variates välilehdillä.  

 

Graph – välilehdellä on pilarin jännityskuvaaja (engl. column stress), painuma (engl. 

settlement), kokoonpuristumakuvaaja (engl. Relative deformation), sekä maaperän 

jännityskuvaaja (engl. soil stress).  

 

Alla olevassa kuvassa näkyvät Graph – välilehdessä näkyville saatavat kuvaajat:  
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Vertaillaan ensin 0,9 metrin ja 0,8 metrin keskeltä – keskelle – mitoilla olevia pilarin 

jännityskuvaajia. Tummansininen viiva kuvaa pilarin jännitystä ja vaaleansininen 

penkereen ja liikennekuorman aiheuttamaa jännitystä. Ensimmäisestä kuvaajasta 

huomataan, että kuormitus ylittää pilarin jännityksen, jolloin pilari myötää, eikä mitoitus 

toimi.  

Kun taas 0,8 metrin k/k-mitalla olevassa tarkastelussa kuormituksen jännityskuvaaja ei 

kohtaa pilarin jännityskuvaajaa, jolloin mitoitus on riittävä.  

Pilarin jännityskuvaaja Pilarin taipumakuvaaja 

Painuma Maan painumakuvaaja Näkyvät kuvaajat k/k– mitta 

ja kuorma 

 

Liukusäädin 



169 

 

 

Painuma- eli Settlement-kuvaajasta nähdään stabiloidulle rakenteelle tulevat painumat, 

mutta siirtymällä Report – välilehdelle, nähdään sieltä suoraan tarkka, numeerinen 

vastaus kokonaispainumalle:   

 

Erona Result – ja Graph – välilehtiin, ei tässä pystytä muuttamaan tehtävää 

tarkastelua suoraan välilehdellä pudotusvalikon avulla, vaan tarkastelu täytyy käydä 

muuttamassa Result – välilehdellä.  
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Viimeisellä Variate – välilehdellä nähdään kaikkien ohjelman laskemien stabilointien 

painumat k/k-mitan ja kuormituksen mukaan.   
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5.6.9 Tulostus 

 

Tulosten tulostamista varten palataan Result – välilehdelle, missä valitaan k/k-mitaksi 

0,8 m ja kuormaksi Load – kohtaan arvo 60. Painetaan kohtaa Draw, jolloin tulos piirtyy 

laskentamalliin.  

 

 

 

Oletusasetuksilla voi loppupainuman suuruutta kuvastava käyrä sekoittua 

koordinaattiruudukkoon. Korjataan asia muuttamalla koordinaatiston väriä menemällä 

grafiikkaikkunassa välilehdelle Calculation → Set Working Area. 

 

 

Muutetaan tekstin ja ruudukon väri esimerkiksi harmaaksi.  
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Palataan Deep Stabilization – laskentamoduuliin ja asetetaan View – välilehdellä 

piirtoasetukset:  

 

 

Material – kohdasta pystytään muokkaamaan maakerrosten näkyvyyttä tulostuksessa.  

 

Valitaan Frame – kohta aktiiviseksi ja sen viereisistä pudotusvalikoista määritetään 

paperin kooksi ja asetteluksi A3 Landscape. Lisäksi valitaan mittakaavaksi 1:200.  

 

Määrätään paperille sijainti viereisestä Location – linkistä ja annetaan grafiikkaikkunassa 

kehyksen vasen alakulma. Uusi sijainti saadaan määrättyä valitsemalla Location → uusi 

sijainti.  

 

Valitaan myös muut oikean puolen sarakkeen kohdat aktiivisiksi, jolloin saadaan 

näkyviin kaikki laskennassa käytetyt tiedot, kuten pilarien mitat, materiaalitaulukko, 

laskentatulokset, nimiö jne.  

 

 

 

 

 

 

 

Result – välilehdellä laskentamalliin piirretty painumakaavio saattaa kadota 

näkyvistä säätäessä piirtoasetuksia View – välilehdellä. Tällöin palataan 

laskentamoduulissa takaisin Result – välilehdelle ja piirretään tulos laskentamalliin 

uudelleen valitsemalla Draw. 
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Asetuksien jälkeen tulosteen tulisi näyttää samalta, kun alla olevassa kuvassa.  

 

 

Tulostus tehdään valitsemalla piirtopöydän ylävalikosta File → Print.  

 

Ohjelma avaa tulostusikkunan, mistä ensimmäisenä kannattaa valita tulostin → Select 

Printer. Alla olevassa kuvassa on esitetty tulostusikkunan eri kohdat: 
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5.7 Laskennan lopetus 

 

Kun molemmat laskentavaiheet on laskettu, tallennettu ja tulostettu, voidaan 

laskentamoduuli ja GeoCalc – ohjelmisto sulkea.  

 

Suljetaan Stability – laskentamoduuli Calculation → Close.  

 

 

 

Suljetaan Novapoint GeoCalc piirtotilassa ylävalikosta File → Exit.  

 

 

 

 

 

 

 

 

 


